# Content

1 Getting Started ................................................................. 6
1.1 About SAP Jam Collaboration ........................................ 6
1.2 About this user guide .................................................... 6
1.3 Other documentation ..................................................... 7
1.4 SAP Jam Collaboration editions ...................................... 7
1.5 Personal data and privacy ............................................. 8
1.6 System requirements .................................................... 9
1.7 SuccessFactors session expiration ................................... 11
1.8 Quick tour ................................................................. 11
1.9 Feature tours ............................................................. 11
1.10 Company and area branding ....................................... 13
1.11 Accessibility support .................................................. 14
1.12 About the menu bars ................................................... 16
1.13 Search bar and results ................................................ 18
1.14 Actions and menus in single item view ......................... 23
1.15 Upload a personal profile photo .................................... 24
1.16 Edit profile information ............................................. 24
1.17 Gamification with Badgeville ...................................... 26
1.18 Manage your account .................................................. 27
   E-mail settings .......................................................... 28
   Feed settings ........................................................... 30
   Activate mobile access ............................................... 31
   External user account deletion .................................... 31
1.19 First time login wizard ............................................... 32
1.20 About colleagues’ profile pages .................................... 32
1.21 About groups .......................................................... 34

2 Feeds ................................................................................. 37
2.1 About feeds ............................................................... 37
   Home feed ............................................................... 38
   Group feed .............................................................. 41
   Profile wall ............................................................... 43
   @mentions and @@notify .............................................. 44
   Paste images ............................................................ 45
   Reply to a feed post .................................................... 46
   Share a feed update .................................................... 47
   Add a task to a feed item ............................................ 48
<table>
<thead>
<tr>
<th>Feature</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mute feed activity</td>
<td>49</td>
</tr>
<tr>
<td>Bookmark a feed item</td>
<td>50</td>
</tr>
<tr>
<td>Download content from a feed item</td>
<td>51</td>
</tr>
<tr>
<td>Mark as inappropriate</td>
<td>51</td>
</tr>
<tr>
<td>Delete a feed item</td>
<td>51</td>
</tr>
<tr>
<td>Send feed post from e-mail</td>
<td>52</td>
</tr>
<tr>
<td>Questions, ideas, and discussions</td>
<td>53</td>
</tr>
<tr>
<td>Feed previews</td>
<td>53</td>
</tr>
</tbody>
</table>

### 3 Notifications and Messages  

#### 3.1 About notifications  

#### 3.2 Notifications tile  

#### 3.3 Browser notifications  

#### 3.4 Online presence  

#### 3.5 Messages  

##### 3.5.1 Group level messages  

### 4 Content  

#### 4.1 About content  

##### 4.1.1 Content templates  

##### 4.1.2 Create a content item within a group  

##### 4.1.3 Related content  

##### 4.1.4 Add and delete your content items from your profile wall  

##### 4.1.5 Decision-making tools  

##### 4.1.6 Links  

##### 4.1.7 Planning tools  

##### 4.1.8 Audio and video management  

##### 4.1.9 Blog posts  

##### 4.1.10 Wiki pages  

##### 4.1.11 Images for blog posts, knowledge base articles, and wiki pages  

##### 4.1.12 Rich text editor  

##### 4.1.13 Thumbnail images for wikis and blogs  

##### 4.1.14 Edit wiki pages and blog posts  

##### 4.1.15 Knowledge base articles  

##### 4.1.16 Manage content  

##### 4.1.17 Content approval and workflow  

##### 4.1.18 Embedded fonts support  

### 5 Tasks, Events, and Calendars  

#### 5.1 About calendars  

#### 5.2 Tasks  

#### 5.3 Events  

SAP Jam Collaboration User Guide 1902  

Content  

PUBLIC  

3
1 Getting Started

1.1 About SAP Jam Collaboration

SAP Jam Collaboration is a social collaboration and decision-making solution that brings together people, processes, information, and applications to enable better problem-solving and decision-making. With SAP Jam, enterprises can use social networking to allow their employees and partners to collaborate on projects, learn, and innovate together. Access to experts and knowledge is made easier and is also cost-effective by reducing costs associated with communication and travel.

SAP Jam is designed to drive results by structuring conversations and enabling people to make informed decisions and solve business-critical problems. SAP Jam provides several features to help employees quickly connect with one another, create and share critical information, such as:

- activity feeds with user status updates
- blogs and wikis with updated dynamic rich text editors
- content mirroring, sharing, and versioning
- event creation with invitations to current and pending members
- forum participation and moderation for problem solving and discussion
- groups for public, private, or external members
- integrations with Microsoft® Skype for Business®, Microsoft® Sharepoint®, OpenText Content Server, and more
- multiple language support, including right to left languages (for example, Arabic, Hebrew)
- page designing for groups with easy to use widgets
- polls and decision making tools
- screen reader accessibility support
- screen recordable or ready to upload and share videos
- task assignments
- time away alerts and notifications.

1.2 About this user guide

This user guide is intended for SAP Jam users who have the following roles:

- **Group administrators**: Users who create groups and manage group participants. A separate guide for procedures on all group administrator tasks is available on the SAP Jam help portal.
- **Page designers**: Users who create the layout and organization for group pages or custom home pages.
- **Group members**: Users who work with content independently or collaborate within a group using any of a variety of SAP Jam features.

Company, area and support administrators can also use this guide to learn more about what SAP Jam has to offer, feature-wise.
1.3 Other documentation

For integrated desktop features requiring some configuration and step by step instructions for setup and use, SAP provides the following documentation conveniently available on the SAP Jam Collaboration help portal. To enable any client applications, please submit a request to the SAP Jam Support team.

SAP Jam Collaboration integrated desktop feature guides

<table>
<thead>
<tr>
<th>I want to learn more about...</th>
<th>Please see...</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>the desktop client for file synchronization</td>
<td>File Sync Client Reference Guide</td>
<td>Procedures on how you can synchronize selected content from SAP Jam to your local file system, and from your local file system back to SAP Jam.</td>
</tr>
<tr>
<td>edit and synchronize my changes from my desktop applications directly into SAP Jam</td>
<td>SAP Jam Application Launcher for Microsoft® Windows® Reference Guide</td>
<td>System requirements and procedures for installation and use of the SAP Jam application launcher.</td>
</tr>
<tr>
<td>using enterprise social networks such as IBM Connections and Yammer while working with SAP Jam</td>
<td>SAP Jam Activity Hub for Microsoft® Windows® Reference Guide</td>
<td>Procedures for setup and steps on how to view third party collaborative tool feeds in one location without having to log in to view multiple applications at once.</td>
</tr>
<tr>
<td>working with the SAP Jam feed in Microsoft Office applications</td>
<td>SAP Jam for Microsoft Office integration Reference Guide</td>
<td>System requirements and procedures for installation and use of the SAP Jam ribbon in applications such as Microsoft Excel and Word.</td>
</tr>
<tr>
<td>publishing content of Microsoft Office Outlook e-mail back to SAP Jam groups</td>
<td>SAP Jam add-in for Microsoft® Office Outlook® Administration Guide and Release Notes</td>
<td>System requirements and procedures for installation and use of the SAP Jam plug-in to enable the SAP Jam ribbon in Outlook.</td>
</tr>
</tbody>
</table>

1.4 SAP Jam Collaboration editions

Depending on your edition of SAP Jam, different features are available.

This document describes all features available in SAP Jam, regardless of the edition where the features are contained. For more information on what features are enabled in your edition of SAP Jam, read the service specifications.
1.5 Personal data and privacy

To comply with EU General Data Protection Regulation (GDPR) requirements that goes into effect on May 25, 2018, SAP Jam Collaboration provides the following functionalities to help adhere to data privacy standards.

Consent and personal data collection: Company Terms of Service and Group Terms of Use

As a user, you may be required to accept a company’s custom Terms of Service and custom external Terms of Service before you are permitted to access SAP Jam Collaboration. When you accept the custom Terms of Service, the acceptance details - including the time stamp of when you accepted the terms, and the version of the accepted Terms of Service - are logged in a compliance report. Company administrators can view and specify the date range for the "Terms of Service" report.

Before you join a group, you may be required to accept the group’s Terms of Use in order to participate in their specific workflows and information sharing. When you accept a group’s Terms of Use, the acceptance details - including the time stamp of when you accepted the terms, and the version of the accepted Terms of Use - are logged in a compliance report. Group administrators can view and specify the date range for the "Terms of Use" report.

External or restricted access user profile

Until you, as an external or restricted access user, have accepted a group invite and the group’s Terms of Use, your profile will not be visible to or accessible by non-administrator group members. Only group administrators can have profile access and engage an external or restricted access user in group activities before you have officially joined the group.

Logged changes for personal data

Any profile changes made by you as a user within SAP Jam Collaboration are logged within its product audit logs. Data changes to the core profile data that is synchronized into SAP Jam Collaboration from SAP SuccessFactors platform or SAP Cloud Platform Identity Provisioning Service are logged by those systems respectively.
Personal data erasure: Alumni profile page access

When you leave the company, in the SAP Jam Admin console > Product Setup > Features page, the company administrator has two options to restrict viewing access to your information, now as an alumni:

- **Show profile pages for alumni:** If deselected to not show profile pages, this option allows the administrator to block access to, and the visibility of, your alumni profile page. Your profile contributions (for example, wiki pages, photos, any content you have created and uploaded to your profile, or content that you are tagged in) are then no longer available for others to reference.

- **Clear profile info for alumni:** If selected, this option allows the administrator to remove your avatar images, office location information, and personal contact information from SAP Jam, although your manager and job title information is retained. Your profile contributions for example, wiki pages, photos, or any content you have created and uploaded to your profile) are still available for others to reference.

When either option is enabled, your alumni personal information is removed from SAP Jam's underlying database tables. All posts, uploads and activity performed by you is now attributed to the text string, ‘Alumni’ or its corresponding localized strings in languages other than English.

Personal data erasure: External user account deletion

As an external user, when you are finished using SAP Jam and no longer require your account, from your Account Settings you can click **Delete My Account** which permanently removes your User ID and prevents reactivation of your account. For any work associated with your ID (for example, comments, content items), your name will be replaced with the label “Alumni”.

As an external user, if you choose not to accept the custom Terms of Service, you can click **Delete My Account** on the Terms of Service dialog to log out and disable your account. This account cannot be recovered.

Profile data disclosure

Under Account Settings > Profile Data Disclosure, you can view a list of your personal data stored in SAP Jam. Disclosure details satisfy the compliance requirements for national and regional data privacy standards. Personal data from SuccessFactors Platform or SCIM (for example, e-mail addresses, phone numbers, location addresses) can also display on this page.

1.6 System requirements

SAP Jam is an internet-based offering that requires a connection to the Internet and a supported Web browser.

The following are required to work with the latest SAP Jam release:
### Client Software Requirements

<table>
<thead>
<tr>
<th>Desktop Web browser and version</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft Internet Explorer 11</td>
<td>Support for IE 8, 9, and 10 was dropped as of March 4, 2016; Microsoft ended support for Internet Explorer 9 and 10 on January 12, 2016.</td>
</tr>
</tbody>
</table>

**i Note**

To support the display of fonts and icons with Internet Explorer, go to Tools > Internet Options and select the Security tab. Select Custom level for the internet zone. Under the Downloads section, ensure Font Download is set to Enable.

<table>
<thead>
<tr>
<th>Microsoft Edge</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Apple Safari 9 and 10</td>
<td></td>
</tr>
<tr>
<td>Mozilla FireFox</td>
<td>Current version and the version prior to it</td>
</tr>
<tr>
<td>Google Chrome</td>
<td>Current version and the version prior to it</td>
</tr>
<tr>
<td>Adobe Flash plug-in</td>
<td>Required for non-WebRTC webcam and screen recordings. Currently, SAP Jam supports Adobe Flash Player 10.0 or higher.</td>
</tr>
</tbody>
</table>

**i Note**

Adobe plans to end support for Flash Player in 2020.

| Java Runtime Environment (JRE) 1.7.0_51 or higher | Required for recording videos on browsers that aren’t supported with WebRTC technology (for example, Internet Explorer). |

### Client Configuration Requirements

<table>
<thead>
<tr>
<th>Browser configuration</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Network bandwidth</td>
<td>Recommended connection speed is 300-400Kbit/s. SAP Jam is designed for speed and responsiveness with minimal use of large graphic files.</td>
</tr>
</tbody>
</table>

SAP Jam is a Web 2.0 application and uses caching heavily for static content. We recommend that companies do not clear their cache as this will significantly impact performance. The minimum recommended cache size is 250 MB. Newer Web pages must be enabled.

<table>
<thead>
<tr>
<th>HTTP 1.1</th>
<th>Enable</th>
</tr>
</thead>
<tbody>
<tr>
<td>JavaScript</td>
<td>Enable</td>
</tr>
<tr>
<td>Cookies</td>
<td>Enable Web browser session cookies (non-persistent) for authentication purposes</td>
</tr>
<tr>
<td>Pop-up windows</td>
<td>The browser must allow pop-up windows from SAP Jam domains. These are used to display some types of content.</td>
</tr>
</tbody>
</table>
1.7 SuccessFactors session expiration

SuccessFactors sessions time out after 30 minutes. An expiration notice can help you save your work before the time out occurs.

Before the expiration, you are prompted to log out or continue your session edit or upload. If the SuccessFactors session has expired, a session expired notice displays and you will need to log in again in order to use SAP Jam.

1.8 Quick tour

The Quick Tour for new SAP Jam users presents the most commonly used features that you as an SAP Jam user can work with to effectively participate as soon as possible.

Features include navigation, connections with other company users, joining and creating new groups, group navigation, and options to customize your profile, create a group, download the mobile app (if enabled by your company administrator), or go directly to the home page. If the tour is dismissed when first used, it can be accessed at a later time by clicking the Help icon above the global menu bar.

Quick Tour access

**i Note**

When using the SuccessFactors shared header, the Quick Tour option may appear under your name drop-down menu.

1.9 Feature tours

To help you understand various capabilities in SAP Jam without having to search for it in the help portal, you can conveniently access in application help presented as feature tours when visiting specific pages. You have the option to enable and disable feature tours throughout SAP Jam as needed.

A feature tour includes concise help text that can be dismissed at any time. It also contains links back to specific help topics in the SAP Jam Collaboration User or Group Administration guides. The following is a list of SAP Jam capabilities where you may see the help appear in a pop up dialog:
Feature Tours list for non group administrators

<table>
<thead>
<tr>
<th>Feature Tour</th>
<th>Help text summary</th>
</tr>
</thead>
<tbody>
<tr>
<td>Learn about groups</td>
<td>Take this guided tour to learn more about groups. If you leave the tour but want to try it later, you can always access it from “?” icon on the top right corner.</td>
</tr>
<tr>
<td>Real-time messaging</td>
<td>Create and participate in real-time message threads with other group members using Messages.</td>
</tr>
<tr>
<td>Upload content</td>
<td>From the Content section, create or upload engaging content such as documents, images, and multimedia that provides useful information to group members.</td>
</tr>
<tr>
<td>Invite members</td>
<td>Click + Invite to expand your group by sending individual invites, importing a CSV list of people, or using member lists. Select people who can share their expertise and contribute towards group goals.</td>
</tr>
<tr>
<td>Engage and stay informed</td>
<td>Provide regular status posts through Feed Updates to keep your group informed. Use @mention to get someone’s attention, @memberlist to inform a set of members, or @@notify to quickly broadcast to all members.</td>
</tr>
<tr>
<td>Table of contents generator</td>
<td>Format your heading text with heading styles 1 through 6. On the rich text editor toolbar, click the Table of Contents button to automatically insert a table with hyperlinked headings. If you change the heading text, click Update below the table to regenerate it.</td>
</tr>
<tr>
<td>Custom video thumbnail</td>
<td>From Video Manager, choose Thumbnails to upload your own video thumbnail image. Custom thumbnails can improve discoverability of your videos and increase number of views.</td>
</tr>
<tr>
<td>Knowledge base</td>
<td>Print a Knowledge Base Article: Click Print to generate a printer-friendly version of the knowledge base article. Move or Copy a Knowledge Base Article: Click More and then Move or Copy a knowledge base article within the same group or to another group.</td>
</tr>
<tr>
<td>Paste and upload images in forums</td>
<td>Copy and paste images directly into the rich text editor to create compelling content.</td>
</tr>
</tbody>
</table>

In addition to the tours listed previously, group administrators will also see the following feature tours:

Feature tours for group administrators

<table>
<thead>
<tr>
<th>Feature tour</th>
<th>Help text summary</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design group overview</td>
<td>In the Overview section, you can add, edit, and rearrange multiple overview pages where you can highlight important group content. List the group’s goals, welcome all members, promote important discussions, and feature specific topics.</td>
</tr>
<tr>
<td>Rotating banner for overview pages</td>
<td>Click Add Widget, then select the Rotating Banner widget to display up to 10 rotating images that can highlight important announcements, topics, and events</td>
</tr>
<tr>
<td>Monitor activity</td>
<td>After members begin participating and interacting in the group, use Dashboard to measure engagement such as the Collaboration score, activity trends, and leaderboards. Keep on top of the overall group participation levels.</td>
</tr>
</tbody>
</table>

Language support

SAP Enable Now is the tool used to provide the feature tours pop-up help. Currently, the following languages are supported:
1.10 Company and area branding

Company and area administrators can customize their respective home pages with branding to help users visually identify the space they are working with.

If company branding has not yet been configured or applied, then SAP Jam branding displays. If area branding has not yet been configured or applied, but company branding has been configured and applied, then company branding displays.

The following table lists the branding that a user will see depending on their company and area assignments, and which page they are viewing.

<table>
<thead>
<tr>
<th>Branding</th>
<th>Viewing company home page</th>
<th>Viewing area home page</th>
<th>Viewing all other pages (for example, profiles, group lists, search results, etc.)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Company only assignment</td>
<td>Company branding</td>
<td>not applicable</td>
<td>Company branding</td>
</tr>
<tr>
<td>Single specific area assignment</td>
<td>Company branding</td>
<td>Area branding</td>
<td>Area branding</td>
</tr>
<tr>
<td>Multiple areas assignment</td>
<td>Company branding</td>
<td>Company branding</td>
<td>Company branding</td>
</tr>
</tbody>
</table>
Examples

**Company only assignment**: A new hire may not yet be assigned to any specific areas, but they are set up as company users. When they view the company home page, browse for groups, and search for content, they will see company branding.

**Single area assignment**: When the employee joins a Sales department, they are added to the Sales area. When they view the Sales area home page, participate in Sales or non-Sales groups, or search for content, they will see Sales branding.

**Multiple areas assignment**: When the employee expands their role to work for the Service department, they are additionally added to the Service area. When they open the Sales home page or participate in Sales groups, they will see the Sales branding. If they open the Service home page or participate in Service groups, they will see the Service branding. All other pages in SAP Jam will display company branding.

1.11 Accessibility support

Government and public agencies that require adherence to Web Content Accessibility Guidelines (WCAG) can ensure that their employees with disabilities have a productive experience with SAP Jam.

The following list describes some of the frequently used SAP Jam features or elements of the SAP Jam Web experience, enhanced for accessibility support.

**Supported features and functions**

<table>
<thead>
<tr>
<th>Feature or function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alert messages</td>
<td>When an alert message appears for the purposes of prompting you to enter information or correct the information you just entered, the screen reader will read the message prompt.</td>
</tr>
<tr>
<td>Alt tags and keyboard entries</td>
<td>Screen readers can read the alt tags now added to pages (for example, home feed, group feed), buttons, links, menus, navigation regions, light boxes, and field entry elements. It also announces keyboard entries as they are performed in SAP Jam (for example, tab, shift tab, enter). Page headings, column headings, button names, and links are read by the screen reader.</td>
</tr>
<tr>
<td>Calendars with events</td>
<td>The cog icon on the calendar can be accessed by the keyboard, allowing it to be read by screen readers. Day cells on the calendar date picker are read as the full date.</td>
</tr>
<tr>
<td>Color contrast</td>
<td>Page elements display as expected in supported high contrast mode.</td>
</tr>
<tr>
<td>Content rating</td>
<td>The screen reader provides a detailed explanation of what appears in the ratings section for a content item.</td>
</tr>
<tr>
<td>Content widget focus</td>
<td>When tabbing through a content widget, elements of the content widget that are in focus display within a four-sided visible indicator.</td>
</tr>
<tr>
<td>Descriptive browser page titles</td>
<td>The titles that display on browser page tabs are more detailed. The screen reader can provide a bit more information to the user about the page they’re on.</td>
</tr>
<tr>
<td>Feature or function</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Edit button in single item view</td>
<td>The edit action for a document is correctly identified by screen readers.</td>
</tr>
<tr>
<td>Feeds: Personal feed and company feed tabs</td>
<td>Personal Feed and Company Feed tabs are identified by the screen reader as tabs on the home page tabstrip. The content of feed posts and names of members who like a post are read.</td>
</tr>
<tr>
<td>Groups page and group overview pages</td>
<td>Page elements are correctly identified by screen readers when tabbing through the left side navigation of the Groups page. Page tabs names are correctly read by screen readers when tabbing through the group overview pages. On the Groups page, from the table of listed groups, the menu items in the More menu dropdown for each row are read as expected when you select the drop-down.</td>
</tr>
<tr>
<td>Home page and heading structure</td>
<td>Standard heading elements in HTML are used for the titles of the Feed, Recently Visited Groups, and Recently Viewed Content sections to facilitate screen reader navigation.</td>
</tr>
<tr>
<td>HTML header elements</td>
<td>On the group content page, the metadata details, tags, content rating, related content, and comments sections are recognized as headers. On the company home page and group overview page, widgets are recognized as headers. On the group feed updates page, the Feed section and Common Actions section are recognized as headers.</td>
</tr>
<tr>
<td>Image tool tips</td>
<td>All icons and images in SAP Jam now have tool tips that appear when you hover the cursor over them. Tool tips are also read out by the screen reader.</td>
</tr>
</tbody>
</table>
| Item count                          | The item count for a menu’s listed items are read for the following on Microsoft Internet Explorer 11:  
  - Company home page: global search, group menu  
  - Company home page and group overview page: show more menu  
  - All sort and filter menus for these pages: My Groups, Content, Members, Forums, Knowledge Base Articles, Recommendations, Subgroups, Tasks, Dashboard, Reports, Business Records, and Notifications  
  - Action menu for these pages: Content, Knowledge Base Articles and Templates, My Groups  
  - Group Overview page: More tabs menu |
<p>| Keyboard controls                   | A tab sequence supports keyboard tab actions to navigate through menus, jump to page (for example, F6/Shift +F6), buttons, links, text boxes and other fields with the option or requirement for data entry or data selection. For polls, where “Allow users to add their own options” has been enabled, the keyboard control also moves to the option to “Add your own answer” at the end of the list. Dropdown menus for Languages (formerly Manage Translations) and Knowledge Base article dialogs can be activated with keyboard controls. |</p>
<table>
<thead>
<tr>
<th>Feature or function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Page element focus</td>
<td>A visual indicator displays when the cursor focus is placed on page elements (for example, buttons, text boxes, checkboxes).</td>
</tr>
<tr>
<td>Processing action</td>
<td>When you are waiting for an action to complete and there is a visual representation of the processing, the screen reader will explain that the action is in progress.</td>
</tr>
<tr>
<td>Profile pages</td>
<td>Keyboard support for all page elements using Tab and enter, arrow, or escape keys. All page elements are correctly identified with labels. All table cells are identified in the order of value, title, row, and column.</td>
</tr>
<tr>
<td>Rich text editor</td>
<td><img src="iNote.png" alt="Note" /> Use Tab + the &quot;R&quot; key to navigate through a large region, and then use the Tab key to tab into individual fields. To access the toolbar in rich text editors that appear with features such as wiki pages and blog posts, use Alt + F10. To return to the text editor, press Esc.</td>
</tr>
<tr>
<td>Success and error messages</td>
<td>When an action is successful, the screen reader can now read a success message for confirmation. When an action results in an error, the screen reader can read the error message. To re-read the messages, press Ctrl + Shift + M.</td>
</tr>
<tr>
<td>Tab chain</td>
<td>You can use the keyboard controls to reset the tab focus for a given element. For example, you can use Ctrl + L to change the location focus or Alt + D to move to the search box.</td>
</tr>
<tr>
<td>Tables</td>
<td>When you tab to a table cell, the screen reader reads its location and content by the row number, column title, and column number.</td>
</tr>
<tr>
<td>Upload message</td>
<td>When uploading files, the uploading process is read by screen readers.</td>
</tr>
<tr>
<td>Videos and playlists</td>
<td>Page elements are correctly identified by screen readers when tabbing to the buttons used for navigating videos and video playlists.</td>
</tr>
<tr>
<td>Widgets</td>
<td>Improvements have been made to the Content widget to ensure that there is accurate focus on the content item titles for correct announcement by screen readers. Elements in the Recommended Content widget such as widget title and title of content items are read correctly. List items are detected by keyboard.</td>
</tr>
</tbody>
</table>

### 1.12 About the menu bars

Menu bars and icons display throughout Jam to help you find information, customize your experience, and work with various features.

The image below shows the areas of the page that contain frequently accessed menus and icons.
Top right icons

The top right icons do the following:

- **Avatar**: Returns you to your Profile page.
- **Clipboard**: Displays all the tasks assigned to you.
- **Bell notification**: Displays a list of notifications. A number beside the icon indicates how many new, unread notifications you have. If @@notify is enabled and sent via a group, you will not receive a notification unless you are following the group.
- **Message**: Displays message threads [page 63] with colleagues. As with feed posts, compliance monitoring configured in the SAP Jam Admin console also applies to messages.
- **Cog**: Displays a dropdown menu of account settings, admin or contact admin details, colleague invite function, custom help, and logout.
- **Help**: If your organization has enabled a custom online help resource, you will be able to access it here.

**Note**

For SuccessFactors enabled theming, the number of unread notifications from the bell, clipboard, and envelope icons are not supported in the shared header.

Banner menu bar

The menu bar appears as a banner below the company logo, search, and top right icons. When you scroll down, this menu bar disappears to give you maximum viewing space for your feed, but reappears when you scroll back to the top. The menu bar can include the following:

- **Home**: Returns you to the home page which lists your feed updates.
- **Groups**: A dropdown menu that allows you to select a group, view all groups, or create a new group.
- **Business Records**: Lists all applications with business records.
- **Knowledge Base**: Allows you to view a list of and search for knowledge base articles in public groups or private groups that you are a member of.
- **Recommendations**: View a list of content that is most viewed, featured, highest rated, or most liked. You can also see a list of suggested groups or people in your company to connect with.
- **Bookmarks**: Lists all the activities you have bookmarked.
- **Calendar**: Lists your upcoming tasks and past and incoming events in a calendar display.
1.13 Search bar and results

At the top of every page, there is a filtered search tool available to you for browsing SAP Jam. A drop-down filter beside the text box helps you refine which areas of SAP Jam to search through.

Search bar and filters

When searching from a Group page, you can choose to search the group you’re in (that is, "This Group" filter). Or you can search by any of the other filters (for example, All, Content, Events, Forums, Groups, Knowledge Base, Messages, People, Tasks, and Tags). You can search other groups that you are a member of, as well as public groups and sub groups.

Note

If SuccessFactors Theming is enabled, the drop-down filter for the search bar is not available.

When using the quick search feature above the global menu bar, the filter is automatically set to your current context when viewing the following: a specific group’s content or content folder, forums or forum topic, events, tasks, or knowledge base articles.
Search bar filters while participating in a group

Search for other users

You can search for other users by entering their location and phone number.

Keyboard shortcuts

You can use keyboard shortcut commands to change the drop-down filter. For example, in the search text box, type:

- **a**: or **all**: to change the filter to All.
- **e**: or **events**: to change the filter to Events.
- **g**: or **groups**: to change the filter to Groups.
- **k**: or **knowledge base**: to change filter to Knowledge Base.
- **m**: or **messages**: to change filter to Messages.
- **p**: or **people**: to change the filter to People.
- **t**: or **tasks**: to change the filter to Tasks.
- **tags**: to change the filter to Tags.

Keyboard shortcuts must be typed in lower case and followed by a colon. You don’t need to press enter after typing the colon. The filter will automatically change, and the text in the search text box is cleared. You can then enter your search criteria, select one of the results from the drop down list (for example, up to a maximum of 10 possible matches as you type), or press Enter to view the full search results page. The category that is highlighted on the left side will match the filter your selected or entered via the keyboard shortcut.

Entering search criteria

When you enter keywords for a full text search, if there are matching entries containing those keywords, the search text box will immediately display a dropdown list of up to 10 possible matches to choose from. When searching under the "All" category, dropdown suggestions are organized so that groups names appear at the top of the list. You can also click the magnifying glass icon at the end of the text box to view the complete list of
search results. If the content you are searching for is larger than 50 MB, the file is not indexed and will not be returned in any search results.

In the search dropdown, search suggestions display from all the categories as you type your search criteria. To search for exact keywords or phrases, you must enclose your search criteria in double quotations.

After you enter your search criteria, you can press Enter on your tablet or keyboard to invoke the search.

**i Note**

The search bars that appear in other sections like Content and Forums allow you to filter content by Title or Tags within those specific sections only.

To search by tags, enter a hashtag (#) before your search criteria to refine the list of possible matches. On the search results page, the Keyword field is automatically filled in with the search criteria that you entered in the Search field. The hashtags are listed below the Tag field.

**Search results**

After you enter your search criteria and click Search, by default the results would include those found in a wildcard search. When you perform a search, you can refine your search terms without having to re-enter the entire phrase.

If the search returns several results, they are presented on multiple pages.

Results can be sorted by relevance and date. Search terms are highlighted in the search results for all content types. An item's original author name, along with any subsequent editor or contributor's names will appear along with the search result item.

Enter more or different keywords, author names, group names, and hashtags to further narrow the results.
When searching for items in a main group, below the Group filter, you can choose the *Include subgroups* option to also search all sub groups belonging to the main group.

You can also use the left side Category navigation menu to search results under People (Active Users or Alumni), Groups, Content, Forums, Comments, Tasks, Events, Business Records, Knowledge Base, and Messages.

When searching within Content folders, the search results will include the name of the folder that was searched at the top of the page. It also includes the name of the folder below the Group category. You can click the X beside the folder to broaden the search to other group folders.

**Categorized search results**

When entering quick search criteria in the global search bar, the top results are organized into categories (for example: Content, People, Forums), with a maximum of three results per category, and up to a maximum of 10 results overall. You can click *View all (by category)* to see the results for a specific category or *View all* at the bottom of the dropdown to see a list of all the returned results.

**Multiple keywords**

When you enter multiple keywords in a Search field, the search results return only the matches that contain all of the keyword criteria. Keywords can include:

- underscore characters
- words split into subwords by intra-word delimiters, case transitions, letter-number transitions, removal of trailing ‘s’ for each subword, and removal of leading and trailing intra-word delimiters on each subword
• diacritic spelling

Multiple tags

You can specify more than one tag in the search filter for search results.

Custom date range

Refine your search criteria using a custom date range

Indexing

When content such as Microsoft Word documents or PDFs are added to SAP Jam, they are automatically indexed. You can easily find them when using the search bar. If the content is tagged, you can further refine your search by entering the specific tag value.
1.14 Actions and menus in single item view

As of the May 2018 release, a new actions toolbar appears above documents, wiki pages, blog posts, videos, images, links, multimedia playlists, audio files, zip files, knowledge base articles, tasks, and events in single item view. As a result, information that was hard to find becomes more transparent. This toolbar replaces the individual action buttons that displayed in previous releases.

Key metadata and widgets from the right side panel, as well as actions from the More menu, display in a more discoverable way. On the right side of the toolbar, can see and access the following metadata and actions:

- Number of Comments - you can also view and enter comments and tasks
- Number of likes - appears in metadata beside the views count
- Bookmark and unbookmark
- Version history
- Tags - appears below the content
- Mirrors
- Go to Document
- More dropdown menu (depending on the content type, your permissions, or whether you have document ownership, can include Edit, Copy, Move, Mirror, Delete, Permissions, Publish Settings, Tag a person, Manage Translations, Feature or Unfeature, Follow, Mute, and Mark as Inappropriate actions)
- Information icon to display the metadata section to the right of the document.

At the bottom of a single item view, you can add tags and provide a rating for the content. For videos, the embed code is also available at the bottom.

Other metadata such as the content author, when the document was created or last updated, and number of views also display above the new actions toolbar. Metadata such as number of likes, views, and comments is updated in real-time.
1.15  Upload a personal profile photo

Profile photos make it easier for colleagues to identify your participation in SAP Jam. For example, when a comment is made, others can quickly identify who participated when they see the avatar beside the comment. This saves time when following discussions in Groups that have many participants and extensive input.

### Note
- If SAP Jam is integrated with SuccessFactors, the photo you upload to SAP Jam is replaced when a new photo is uploaded into your SuccessFactors profile.
- If you cannot upload a profile photo, it means that your company administrator has disabled the profile photo upload capability. The administrator can enable and disable photos at any time to comply with your company policies.

1. Click the **Profile** tab.
2. Click the camera (edit) icon in the photo frame.
3. Click **Upload a Photo** to find the photo in your local directory.
4. Select the photo you want to upload, and click **Open**.

#### Note
- The file should be smaller than 5 MB and in one of the following formats: JPEG, GIF, PNG.

5. Adjust the rotation, zoom, and placement of the photo in the frame and then click **Save changes**.
- Images large enough to fit the dimensions of 285 pixels by 285 pixels will span the entire column width to the left of the profile details. If the image is less than 285px x 285px then the dimensions are preserved and cropped to display within a white bordered square.

#### Note
- You can rotate and control cropping of the profile photo after you have uploaded it.

1.16  Edit profile information

Your profile contains information that you want to share with your colleagues, or to help your colleagues identify you. For example, if you are new to a company and want to learn who’s who, you can click a profile to learn names, job titles, and contact details. Once your account is set up, you can edit your profile information.

### Note
- Some fields described below may not be available or set to read-only permissions by your SAP Jam administrator.

**To edit your profile**

1. Click your profile photo from the icon toolbar. You can update the following information:
   - **Expertise**: Select or enter skills and areas of expertise that you want to advertise and list on your personal profile page.
2. Click *Edit Details* below the Expertise section. You can update the following information:
   - **Basic Profile Information**: First Name, Last Name, Nickname, Job Title, Start Date, and Job Description.
     - Basic profile information example
     - **Contact Information**: Email address, Phone, and IM.
     - **Org Chart**: Manager, Direct Reports, and Assistants.
     - **Office Information**: Primary Office, Site, Building, Floor, and Notes.

3. Click *Save changes* to apply your updates.

**Achievements**

If enabled by your company administrator, you may be able send standard or custom kudos to other users. When you click Achievements on the left side navigation, you can view any kudos that you have received from your colleagues. You can choose to show or hide each kudo on the Achievements section of your profile.
1.17 Gamification with Badgeville

To encourage and reward your participation with colleagues in SAP Jam Collaboration, you can earn points and achieve status levels that are visible to other users on your profile and the hover card that appears when someone hovers over your hyperlinked name.

Rewards (previously referred to as "badges") and missions, defined by your Badgeville or SAP Jam company administrator, also display on your profile. Rewards are earned when you perform specific actions. Missions are a grouping of achievements that can signify specific areas of expertise.

You can click on Learn about Points and Levels and View all Rewards and Missions to view a list of all the rewards you can earn when you participate and complete actions and view the progress of reward achievement within each mission. The steps required to achieve each goal are also listed.

When you earn a new status level, reward, or complete a mission, you’ll receive a bell and email notification to alert you on your latest accomplishment.

Badgeville leaderboards

You can view your achievement level, leaderboard rank (by total number of points), and progress towards rewards and mission completion.
The Rewards section displays progress towards "stand-alone" rewards. These are rewards that are not defined as part of any mission. Only simple rewards are supported (a reward containing single behavior criterion).

The Missions section displays progress towards all available missions. A mission can have multiple rewards. It can be filtered to show all its contained rewards, those in progress, or those completed.

1.18 Manage your account

Account settings allow you to control features specific to your experience in SAP Jam.

From the top menu bar, on the far right side is a gear icon. When you click it, a dropdown menu appears.

![Gear icon and drop-down menu]

Click **Account Settings** to access any of the following:

- **Change Password**: Reset your password as per your company's password policy requirements.
- **Email**: Indicate high, medium, and low priority for a variety of e-mails; specify the options for daily email digests; select the frequency of group notifications.
- **Feed Settings**: Create a custom feed by selecting what type of status, content, and other activity updates you want to see.
- **Integrations**: Set up integrations with other sites (for example, Personal Blog RSS).
- **Applications**: Lists any authorized applications that have access to your account.
- **Profile Data Disclosure**: View a list of your personal data stored in SAP Jam. Disclosure details satisfy the compliance requirements for national and regional data privacy standards. Personal data from SuccessFactors Platform or SCIM (for example, e-mail addresses, phone numbers, location addresses) can also display on this page.
- **Feature Tours**: To help you understand various capabilities in SAP Jam without having to search for it in the help portal, you can conveniently access in application help presented as feature tours when visiting specific pages.
- **Terms of Service**: Review the terms you agreed to when accessing SAP Jam for the first time.
- **Language**: Select your preferred language. All pages in SAP Jam will reflect your language preference. This does not apply to text written by other users, unless they have been written in your preferred language.
- **Mobile Setup**: Add your mobile device so that you can access the Jam mobile app.
- **Time Zone & Calendar Settings**: Set your time zone preference and the first day of the week for your personal calendar.
- **Away Alerts**: Let other SAP Jam users know when you are away by enabling your time off alerts.
- **Trash**: Contains items which you previously deleted, which can be restored.
1.18.1 E-mail settings

From the Settings icon at the top of the page, choose Account Settings from the dropdown menu, and select Email to display the Email Settings page. There, you can control when and how often you receive update e-mails from SAP Jam, and even choose not to receive any e-mails. On the Notifications tab, you can select which e-mail notification you want to receive based on activities that involve you, or your need for daily summary emails. On the Groups Notification tab, set the email frequency for all groups you belong to. To select all the events for each category, you can click the select all checkbox beside each heading.

Notifications tab

- **Activities that involve you:** Choose the events for which you wish to receive e-mails.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>@@notify</td>
<td>When people you follow or fellow group members use @@notify to send a broadcast notification.</td>
</tr>
<tr>
<td>@mention and @@memberlist</td>
<td>When another user @mentions you, or @@mentions a member list that you belong to.</td>
</tr>
<tr>
<td><strong>Edits to a wiki page I last edited</strong></td>
<td>When another user edits a wiki page that you last edited.</td>
</tr>
<tr>
<td><strong>Edits to any poll I voted in</strong></td>
<td>When the poll creator or group administrator edits a question or answers any poll you voted in.</td>
</tr>
<tr>
<td><strong>Edits to any wiki page I edited</strong></td>
<td>When another user edits a wiki page you created.</td>
</tr>
<tr>
<td><strong>Edits to my wiki page</strong></td>
<td>When another user edits a wiki page you created.</td>
</tr>
<tr>
<td>External Applications</td>
<td>When the records integrated with an external system for your group are created, modified, or deleted.</td>
</tr>
<tr>
<td><strong>Feed Comments and Likes</strong></td>
<td>When another user comments on or likes your feed post.</td>
</tr>
<tr>
<td>Forums</td>
<td>Updates to a topic you are subscribed to.</td>
</tr>
<tr>
<td>Messages</td>
<td>The first time someone messages you in a personal message, or when a user @mentions, @@notifies, or @@mentions the member list you belong to.</td>
</tr>
<tr>
<td>Notifications</td>
<td>New notifications for you or involving you. This setting controls approximately a dozen different e-mails notifications. Examples are you have a new follower, and you’ve been @mentioned from a content item.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>Tags in Photos</td>
<td>When another user tags you in a photo.</td>
</tr>
<tr>
<td>Tags in Video</td>
<td>When another user tags you in a video.</td>
</tr>
<tr>
<td>Tasks</td>
<td>Updates of existing tasks or assignment of new tasks.</td>
</tr>
<tr>
<td>Wall posts</td>
<td>Includes comments, likes, and replies.</td>
</tr>
</tbody>
</table>

**Has begun deprecation as of the August 2017 release.

- **Daily Summary Emails:** By default, daily e-mails are not enabled; you will need to select the ones you wish to receive in a daily summary:

  **Note**
  The Active Tasks Reminder notification will begin deprecation as of the August 2017 release and will no longer be sent in an upcoming product release.

### Daily Emails

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clicks on my content</td>
<td>Another user has clicked a content item that I have posted.</td>
</tr>
<tr>
<td>Reminder for bell notifications</td>
<td>Bell notifications that have not been dismissed.</td>
</tr>
<tr>
<td>Results for tracked terms</td>
<td>A list of new results for saved search terms.</td>
</tr>
<tr>
<td>Yesterday's headlines</td>
<td>Includes up to 20 feed events (for example, from my follows feed, others' most recent status posts, new images/documents, etc.)</td>
</tr>
<tr>
<td>Yesterday's top 5 links</td>
<td>Includes up to five most visited links in the application.</td>
</tr>
</tbody>
</table>

**Note**
Daily e-mails are sent only if 1) the company administrator enables security and user settings that allows e-mail notifications to be sent 2) they also enable a "Send daily alert emails" option 3) you have chosen at least one of the daily e-mail options and saved your preferences and 4) there is content to display for at least one of the selected options.

### Group Notifications tab

- **Group Notifications:** When you first join a group, you can select your e-mail notification preferences before you accept the group’s terms of use. After you join, you can change how often you receive notifications for each of the groups in which you are a member. On the Group Notifications tab, set the email frequency for group notifications by selecting an option from the dropdown menu and then click the *Save Changes* button.
**Note**

If the group administrator changes the e-mail notification setting on behalf of the group, all members will receive a bell notification about the new setting. You will have an opportunity to accept or reject the change as per your preferences. From the navigation menu of a group page, you can also change your e-mail notification settings.

"Immediate" e-mails are sent at an interval of once every 10 minutes with a composition of related activities. You can reply to e-mail notifications sent by SAP Jam to add commentary back to the SAP Jam feed. Moreover, you can attach documents to your e-mail reply and the attachments will be uploaded to SAP Jam. When you click an item summary in the Activity Feed, the focus will move to the item further down the page. You can click a "Top" hyperlink to bring you back to the top of the page.

**Email consolidation**

When there is a pause or end to a discussion for a feed item, a single e-mail is sent with a consolidation of comments since the last e-mail update on that item. The subject line of the e-mail indicates the number of people who are commenting in the conversation. The e-mail begins with a summary line and a link to the feed item. An e-mail is no longer sent for each feed comment.

**Other e-mail notifications**

You will receive other e-mail notifications from SAP Jam when you:

1. click **Forgot Password** on the login page.
2. need to confirm your e-mail address for security reasons.

**Post an update to SAP Jam via your e-mail**

When viewing your e-mail notifications, you can respond directly from the e-mail, which will display in SAP Jam. On the Collaboration tab, you can accept the default e-mail address that’s used for posting updates to SAP Jam, or you can click **Reset Email Address** to provide another e-mail address.

**1.18.2 Feed settings**

Your home feed is made up of events from the people and groups you are following. It’s an accumulation of all the content that you have access to in both private and public groups. You can customize your feed to only display updates relevant to you by choosing a feed filter.

A number count appears within the browser tab to alert you of the number of new feed updates as you work in other browsers.
When you make changes to your feed settings, all future events in your feed will be affected.

If you have never set these settings, then by default you will receive all activity types in your feed. As of the November 2017 release, to help reduce the busyness of a feed, agenda, poll, ranking, and pro/con table feed items will no longer display by default.

If you want to turn these feed items on again, please select them under Account Settings → Feed Settings.

If you previously selected or unselected your preferred activity types under your Account Settings, then your feed settings will remain as is. For example, if you selected the "Agendas" activity type prior to this release, then agenda items will continue to display in your feed by default.

### 1.18.3 Activate mobile access

You can activate your new SAP Jam mobile app from your mobile device or Web application. If the mobile app is not already installed on your iPhone or iPad, you can search for and download the SAP Jam mobile app from the iTunes® app store (http://appstore.com/sapjam)

Please refer to the [SAP Jam Mobile App User Guide](#) for instructions on how to activate and use the app on your mobile device.

### 1.18.4 External user account deletion

As an external user, when you are finished using SAP Jam and no longer require your account, from your Account Settings you can click Delete My Account which permanently removes your User ID and prevents
reactivation of your account. For any work associated with your ID (e.g., comments, content items), your name will be replaced with the label “Alumni”.

**Custom terms of service**

If you choose not to accept the custom Terms of Service, on the Terms of Service dialog you can click *Delete My Account* to log out and disable your account. This account cannot be recovered.

### 1.19 First time login wizard

When you first log in, if enabled by your company administrator, you will see a minimum of two tabs that provide some recommendations to help you get started:

- **Connect with People**: Displays a list of people who report to the same manager, follow the same people and groups as you do, have the same or similar job title, are in the same department, and are in the same country. You can choose to follow or unfollow them from this tab. If you follow them, their shared content will appear on your Home Page feed.
- **Join Groups**: Displays the groups you’ve already joined, recommendations to join others based on groups that have names similar to your job title, and are most followed by the people you follow.

Click *Finish* once you’re done with the recommendations to begin using SAP Jam.

### 1.20 About colleagues’ profile pages

Your colleagues’ profile pages can contain information on how they can be contacted, what their job title is, and their recent activity in SAP Jam.

On your colleague’s profile wall, you can:

- Choose *Follow* to receive feed updates on your colleague’s activities.
- Choose to *Unfollow* your colleague if you no longer want to see their updates in your feed.
- Choose *Send a Message* to send a private message to your colleague. This activity will not appear on any wall feeds.
- Choose *Show Additional Info* to display more details about their job, ways to contact them, and their office location.
- Post a message on their wall which is also visible to other people visiting their profile page.
From the **Actions** drop-down menu, you can:

- **Send a Kudo**: Recognize a colleague by selecting a kudo that acknowledges their work (for example, teamwork, thank you).
- **Review Usage**: If content administration is enabled, you can audit usage or view abuse reports on a selected colleague.
- **Endorse Expertise**: Enter an area of expertise in which your colleague excels. The endorsement remains hidden until your colleague chooses to show it on their profile.

**Note**

External users cannot endorse expertise, nor view group members or other SAP Jam users’ expertise tags.

From the left side navigation menu, you can click through content posted by your colleague to public groups or on their profile wall.

**Alumni profiles**

When an SAP Jam user leaves your organization, the company administrator may change their status from "Active" to "Alumni". Without further configuration, the alumni profile will still show the user name, avatar, contact information, and profile contributions for example, wiki pages, photos, or any content they have created and uploaded to their profile.

The following information will be removed from their profile if the administrator chooses to show the alumni profile page but clear personal data:
• Personal and contact details entered by the user.
• Personal and contact details synchronized from the SuccessFactors platform.
• Profile images (avatars).

Alumni cannot be followed using the hovercard or from the Alumni’s profile page. Navigation links to their profile overview page, achievements, social graph, and groups will remain on their profile.

If the SAP Jam administrator disables the alumni’s profile page, a “requested profile is no longer available” message displays when you try to view their profile. Please refer to **Personal data and privacy [page 8]** for more details.

**Achievements**

When you click **Achievements** on the left side navigation, you can view a user’s earned badges, kudos, and leaderboard.

**Badgeville leaderboards**

If Badgeville gamification integration is configured for your company, when you view the hover card for another company user, you can see their achievement level with number of points earned in brackets, and their number of completed missions.

**1.21 About groups**

Groups are created in SAP Jam by group administrators to bring together people, data, best practices, and opportunities to work on and resolve business problems. They include a membership of users who can upload, create, or reference material specific to a department, project, or team. Members can participate in forum topics such as questions, ideas, and discussions with a select number or all members in a group. If enabled by a company administrator, you may be able to create your own groups.

If you can create groups, you can choose from the following group types:

• **Public Groups:** Any of your company colleagues can join, view, and contribute content.

• **Private Internal Groups:** Members must receive and accept an invitation to join before they can post group items. This group can only be edited by SAP Jam administrators and group administrators. The group name, members, content, and description are not visible to anyone who has not been invited to join the group.

• **Private External Groups:** Members can collaborate with members of different companies in a private, invitation only space. This group can only be edited by SAP Jam administrators and group administrators.
Group administrator privileges

You can send a request to a current group administrator to obtain admin privileges for your group.

To request group administrator permissions for your group
1. Go to your group overview page.
2. Go to My Group Settings from the sidebar or header navigation, under the More dropdown.
3. From the dropdown menu, choose Request Group Admin Privileges. The page will refresh and you will see a “Your request to the group administrator was sent for review” message. Once the group administrator accepts your request, when you go to the Overview page, you will have access to the editable view of the group pages. Please refer to the SAP Jam Group Administration Guide for more details.

Stop following or leave a group

You may find that a particular group and/or their feed updates are not relevant to your work. If you no longer wish to be a part of or participate with a group, you can leave the group. But if you are not allowed to leave the group, you can choose to stop following it. This will prevent their feed updates from appearing on your home page.

To stop following or leave a group
1. Go to your group overview page.
2. Go to My Group Settings.
3. From the drop-down menu, choose Stop Following This Group or Leave Group.

Subgroups

When you click a URL to join a public subgroup, if not already a member of the public main group, you are prompted to read and accept the Group Terms of Use for the main group and its subgroup. When you select the “I understand the Terms Of Use” checkbox for both subgroup and main group and click Accept, you can then view both groups. On the group overview page, you can click Join Group to become a member. If you only accept the terms of use for the parent group, you won’t be able to access the subgroup. You must join the main group first before you can join the subgroup.

To join a private subgroup, first accept the terms of use for the public main group before accessing the private subgroup and submitting a request to join.

On the Subgroups page, if you click Join Group, a message asks if you want to join the selected subgroup and the main group if you are not yet a member. You’ll become a member of both groups after you click OK.

Pin groups to favorites

On the My Groups page, you can click a pin icon on the top right side of the group tile to save up to 10 of your most frequently accessed groups to a bar that appears at the top of the page. You can also pin or unpin a group
via the group page avatar. If you attempt to pin more than 10 groups, an alert message indicates that you have already reached the maximum allowable groups to pin. Favorites can be removed by clicking the blue pin icon on the group tile. Or, on the favorites bar, click Edit and then the x on the group you want to unpin.

The Groups drop-down menu currently lists up to 10 groups. If you have 10 pinned favorites, then those groups will be listed under Favorites. If you have less than 10 pinned groups, the balance of the list will display any recently viewed groups under Recently Visited.
2 Feeds

2.1 About feeds

SAP Jam makes it easy for you to keep current with a collection of posts called feeds. Feeds display a constant update of activity shared by you, your groups, and your colleagues. You have access to three types of feeds:

- **Home**: Posts by all the groups you belong to, updates that you have posted, and any post mentioning your name.
- **Group**: Posts by group members only.
- **Company**: Public, company-wide status updates. Private group postings are not included here.

A post can contain different types of content (for example, documents, blogs), videos, photos, forum topics, and general status updates. Other group members, co-workers, public member lists, or specific business records (for example, learning items) can be @mentioned, or hashtags can be included to help others find your post. As users interact with a post, the most recent activity is displayed at the top of the feed.

Sort feed item comments and replies

For each feed item, under the **Sort by most recent comments & replies** dropdown, you can choose one of the following options to display comments and replies:

- **Most recent comments**: Show the most recent comments at the end of the thread.
- **Most recent comments & replies**: Show the most recent comments, and comments with new replies, at the end of the thread.

Content items

Clicking on links to content in the feed allows you to quickly preview that content in a “lightbox”. A lightbox is a type of dialog box that overlays on top of the existing page. This allows you to quickly preview the content associated with the event in the feed to see the full context of the update. After you close it, you are returned to the same position in the feed without requiring the feed page to reload. This allows you to get to content with fewer clicks and generally speeds up user interaction with SAP Jam by requiring fewer page loads. Viewing content from the lightbox has also been enabled from group overview pages, allowing users to preview content immediately upon entering the group without having to navigate into the group structure.
2.1.1 Home feed

You can control what you see in your feed updates by using the feed filters that display on your wall. By default, you will see a summary of all status updates posted by people you follow or in groups where you are a member. If you wish to refine your feed, you can use any of the following filters:

- **All**: Lists all feed updates without filter.
- **Unread**: Lists the feed updates that you have not viewed on your wall. Items in this view are marked as read even if you don't click the item or scroll by it.
- **@[Your Name]**: List the feed updates that specifically mention you.
- **Replies**: Lists all the feed updates that have replies to your posts and comments.
- **Show More**: Allows you to create, edit, and save custom feeds where you can filter by specific members and groups. You can also delete the custom filters that you create.

<table>
<thead>
<tr>
<th>All</th>
<th>Unread</th>
<th>@Your Name</th>
<th>Replies</th>
<th>Show More</th>
</tr>
</thead>
</table>

Create custom filters

For SAP Jam instances integrated with other applications, where events in those applications appear in SAP Jam feeds, you can filter those updates from your Home feed.

To create a custom filter for your Home feed

1. Click the **Show More** drop-down menu above the feed activity.
2. Choose **Manage Filters**. The Manage Filters pop-up displays.
3. Click **Create a New Filter**. The Create a New Filter pop-up displays.
4. In the Filter Name text box, enter a name for your custom filter.
5. In the Filter Type drop-down menu, select Member filter to create a filter based on specific colleagues, or Group filter if you want to create a feed based on one or more groups.
Member filter example

6. Click Submit to save your new filter. When you return to the Show More menu on your Home feed, the named filter will now appear in the list.
### Edit and delete filters

You can always edit your filter at anytime. For example, if you created a member filter with a particular employee who no longer provides relevant information, you can remove them from your filter. Or, if you find that a filter is no longer useful, you can delete it from your members list.

**To edit or delete a filter**

1. Go to the Show More drop-down menu and choose Manage Filters. The Manage Filters pop-up displays.
2. Click the pencil icon to edit and the x icon to delete the filter. When you have more than one filter, you can drag and drop the filter names into the order they should appear in the drop-down menu.

#### Manage Filters

You can also control the types of content that displays in your feed. For example, if you are interested in discussions and comments, but don't want updates from your Personal Blog RSS, you can enable and disable your feed selection.

**To edit your feed settings**

1. Go to the Show More drop-down menu and choose Edit Feed Settings. Or, from the Common Actions tile, click Feed Settings. The Feeds Settings page displays.
2. Select the type of updates you wish to see in your Home feed. You can also uncheck the items that you don't want to see. You can change your selection at any time.
3. Click Save Changes.

2.1.2 Group feed

Your group feed displays a summary of the latest activities within your private and public groups. Group feeds can include recently uploaded or edited documents, discussions, or group-related questions.

To make a comment, you can reply directly to status updates from your Home feed, or go to the group feed and post your reply there.
If you don’t want to receive a group’s feed events in your Home feed, you can choose ‘Stop following this group’ from the group’s settings. This allows you to receive notifications and @mentions from the group while their group feed events are hidden from your Home feed.

To use the group feed post box to share an update with all group members

1. Go to the Feed Updates section of your group.
2. In the post box below the group header, enter your update. You can use the following actions with your post:
○ **Mention someone**: @ notifies a user that you specify by name or e-mail address. One click will insert one "@" symbol; enter the name of the person after that symbol.

○ **Mention business record**: @ mentions a business record like an opportunity or learning item for easy access to that record.

○ **Tag**: Click the hashtag icon to insert a "#" symbol; enter a tag.

○ **Add a photo**: Click the camera icon to upload or drag and drop an image.

○ **Add a video**: Click the video recorder icon to upload or record a video. You can also type the URL or copy and paste a hyperlink to a video.

○ **Add a document**: Click the document icon to attach or drag and drop a document.

○ **Ask a question**: Click the question icon to post a question immediately to the group feed.

○ **Add an idea**: Click the light bulb icon to post an idea immediately to the group feed.

○ **Add a discussion**: Click the Conversation icon to post a discussion topic immediately to the group feed.

![Post box with actions](image)

3. Click **Submit** to post your update to the group. Your update will also appear on your profile wall and home feed.

## 2.1.3 Profile wall

Your Profile wall displays activities and updates that directly affect you. For example, you will see all status updates and content posted by you or directly addressed to you (@mentions). You can also see updates on changes to your profile information. Everything you post to your Profile page is visible to everyone inside your company, but not to external guests. You can post personal status updates, videos, files, or other content to your Profile page to let everyone know what you are working on.

To post your update from your profile wall, enter your message in the post box and click **Submit**.

### i Note

You can use @ mentions to notify specific users, add hashtags, add a photo, video, or document to your post.

### i Note

You can use @@mention to include a public member list on the home feed, company feed, profile wall, content item feed, and business record wall. When you enter "@@" and type the first few letters of the member list, the full name of the member list will auto-complete with a list of matching member lists by name. Only members of that member list will receive a bell notification for that feed item. Members of that member list can click the @ [First name Last name] that appears above their home feed to view the feed item that @mentions their member list.
When someone views your profile wall, they will see the feed activity updates of your shared groups.

### 2.1.4 @mentions and @@notify

The @ syntax when used in feeds allows you to get the attention of one, some, or all members of a group or organization. Care must be taken when you use this syntax so as not to include those whose participation or awareness is not required.

@@notify

@@notify is similar in function to "reply to all"; it either alerts all members of a group when mentioned on a group feed, or all colleagues in an organization when used on a company home page feed. Your group administrator may choose to turn this feature off in order to prevent any potential "reply to all" fatigue or misuse. Only use @@notify if it is absolutely critical to send your update to everyone. Please check with your group, group administrator, and organization for any rules on when to use this syntax.

@@mention a member list

You can @@mention a public member list on the home feed, company feed, profile wall, content item feed, and business record wall. Only administrators have access to private distribution lists and can therefore @@mention private list.

<table>
<thead>
<tr>
<th>i Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unlike with &quot;@@notify&quot;, the group administrator will not have the option to disable the use of @@mentions for distribution lists.</td>
</tr>
</tbody>
</table>

When you enter "@@" and type the first few letters of the member list, the full name of the member list will auto-complete with a list of matching member lists by name.
How to use @@mention for member lists and all members

When the member list is @@mentioned, members of that member list can click the @[First name Last name] that appears above their home feed to view the feed item that @mentions their member list.

The number of @mentions is listed on the side panel when you @@mention a member list on a content item. For example, if there are 20 members in a member list that has been @@mentioned on a document, then the number of @mentions for that document is 20.

@mention an individual

When you want to mention one or a few people outside of a member list, use @ and then type the first few letters of the person’s name until a matching name appears. You can click to select the name.

2.1.5 Paste images

On a group feed item, you can upload images to a content folder by pasting an image in the post box for the feed update or a reply box for content items or forum topics. On a home feed update, pasted images are uploaded to your profile content.
When you paste an image, you are immediately prompted to save the image to a group folder using the Choose a folder to upload to dialog. After you select a folder, an “Uploading in progress” message briefly displays in the post box. The image then displays in single item view.

**i Note**

Pasting of images in post boxes is not supported with Microsoft Internet Explorer 11.

2.1.6 Reply to a feed post

For new posts or updates on a home page, group feed, content item feed activity section, or business record feed activity section, you can enter a reply.

You can also like the post, share it, create an associated task, bookmark, delete, or mark it as inappropriate to bring to the attention of an administrator.

When you reply to a post, you can notify people, tag it, include images, videos, and add attachments.

**To reply to a feed post directly on the feed**

1. On the Feed Updates page, click **Reply** below the post.
2. Enter your comments. You can also @mention another person, enter a hashtag, attach an existing content item or upload a new document, video, or audio file to provide additional information. When a member clicks on the attachment from the reply, it opens in a dialog box.

**i Note**

For right side pane comments on content items that display in a dialog box, when you click **Reply** to a comment, you can also attach existing content or upload a new file.

3. Click **Reply** to post the update with attachment if any, to the wall. If you are commenting on someone else’s reply to a feed item, click **Post**.

**i Note**

When you click **Reply** to a second level reply, the person who entered the second level reply is automatically at-mentioned at the beginning of your reply.

**To reply to a feed post directly within a feed widget**

1. On the Overview or group page that has the feed widget, go to the feed item you want to reply to.
2. Click **Reply**. The feed item expands to display a text box for comments.
3. Enter your comments and then click **Reply**. If you are commenting on someone else’s reply to a feed item, click **Post**. The feed widget shows the update when the group page is refreshed.

**i Note**

You cannot post top level comments in the feed widget if the group is set to view only.

**To reply to a feed post from your e-mail notification from SAP Jam**

1. Go to the e-mail with the feed post you want to reply to.
2. Click Reply. The feed item expands to display a text box for comments.
3. Click Reply and enter your comments.

When working with feeds on mobile devices, the narrow width of the browser screen will move the Attach Existing File, Upload New File, Add a Tag, and Mention Someone actions to a drop-down menu on the lower left side of the post box.

### 2.1.7 Share a feed update

The Share link that appears below the content of a feed update allows you to share that update with groups or other colleagues. For example, you may want to share important information from one group feed to another. You can also add your own comments to the post, @mention colleagues, and #tag it.

**To share a feed update**

1. Below the feed update, click Share.
2. From the Share with drop-down menu, choose the intended audience. You can choose to share with everyone in the company or everyone in your group. You can enter the name of the group in a text box beside the Share with drop-down menu.
3. (Optional) In the post box, enter some comments to introduce your shared post, provide #tag words, and @mention others to draw their attention.

**i Note**

If a hashtag filter is included with the feed on a group page, then the new post only displays if it includes the hashtag. If the hashtag is missing from the post, a confirmation message appears. You can click Cancel to amend the post, or Proceed to post to the group wall without a hashtag, and without including it in the feed widget.
Share an Update

4. Click Share. A confirmation message displays to indicate that you have successfully shared the update.

**Note**

In previous releases, the Share action allowed you to share a feed item via e-mail. However as of the November 2014 release, sharing no longer occurs via e-mail. This way, users can instantly view shares within SAP Jam without needing to check their e-mail.

### 2.1.8 Add a task to a feed item

In a group feed, a feed item may appear where a collaborative task is required as a result. You can easily create a task for another member or yourself based on that particular feed item.

To create a task based on a feed item

1. Go to the feed item and choose Task from the drop-down menu.
2. The Add Task dialog displays below that feed item. You can enter the following:
   - **Task Title**: Enter a brief summary of what the task is about.
   - **Task Description**: Enter more details about the task.
   - **Add assignees**: Click the Add People icon in the Add more field and select group members from the dialog box.
   - **Due Date**: This is an optional field for you to select a due date from the calendar.
   - **Reminder**: This is an optional field for you to select a daily, weekly, or monthly reminder.
   - **Priority**: Choose from low, medium, or high.

3. Click OK when finished. A message displays below the feed item to indicate that a task was assigned. Another feed item is added, displaying task details only.

### 2.1.9 Mute feed activity

On the Home or group feed, you can now mute feed activity for a single feed item so that you no longer see future updates for that specific thread (for example, replies to a comment). Corresponding e-mail and bell notifications are also muted.

Your home feed may become busy with items or updates that are not relevant or of interest to you. The mute feature allows you to refine your home feed by turning off those threads.

#### To mute feed activity for a specific item

1. Go to the feed activity you want to mute, click the drop-down that appears on the top right corner, and then select **Mute**.
2. The message prompt “Are you sure you would like to mute this thread?” appears. When you click OK, the feed item immediately disappears from the feed.
To mute activity from a single item view

1. Go to the single item view for the feed item and choose More > Mute.
2. The message prompt “Are you sure you would like to mute this thread?” appears. When you click OK, the feed item immediately disappears.

### 2.1.10  Bookmark a feed item

When you bookmark a feed item, it allows you to go to the Bookmarks section in SAP Jam when you want to quickly refer to that item without searching through your feed activity. The most recent feed items display at the top of your Bookmarks list.

#### To bookmark a feed item

1. Go to the feed item you want to bookmark and from the drop-down menu on the right, choose Bookmark.

2. On the global navigation bar at the top of the page, click Bookmarks. The item you just bookmarked will appear in the order of most recent to older feed activity.

If you want to remove an item from your bookmark list, on the Bookmarks page, go to the drop-down menu for the bookmarked item and choose Unbookmark.
2.1.11 Download content from a feed item

A feed item may contain a link to a content item that you wish to download.

To download a content item from a feed item

1. Go to the feed item and from the right side drop-down menu, choose Download.
2. Your internet browser window will prompt you to open or save the content item.

2.1.12 Mark as inappropriate

Sometimes users may post items to group feeds which may not contain appropriate content. When you see inappropriate content display in the feed activity, you can report the issue to the company administrator, provided that they have enabled content administration.

Mark a feed item as inappropriate

When you mark an item as inappropriate, any related feed posts are also marked as inappropriate and subject to administrator review. As you try to access a content item marked as inappropriate, or its related feed post, a "This has been marked as inappropriate" message displays.

To mark a feed item as inappropriate

1. Go to the feed item with the questionable content.
2. From the right side drop-down menu, choose Mark as inappropriate.
3. In the Mark as inappropriate light box that appears, indicate whether the content is "Spam or misleading content" or "Abusive content" and then optionally enter some more details about item that would assist the company administrator in understanding the issue.
4. Click Submit. A message displays on the feed to indicate that the item was marked as inappropriate. This message is visible to all group members, including the user who posted the inappropriate item. The content of the feed item itself does not display. The company administrator will receive a notification indicating that there is content to review.

2.1.13 Delete a feed item

When you delete a feed item, the activity will no longer display on the group feed or profile wall. However, any content that was associated with that feed item will remain unless you go to the Content section and delete it there.

To delete a feed item and then the associated content item
1. Go to the feed item and from the right side drop-down menu, choose **Delete**.
2. A confirmation message appears. Click **Delete** to remove the item from the group feed or profile wall.
3. Go to the Content section and locate the associated content item.
4. Choose **More > Delete selected items**.
5. A confirmation message appears. Click **Delete** to remove the content item.

### 2.1.14 Send feed post from e-mail

If you use SAP Jam while away from the office and/or not connected to the web application via your computer, you can still post updates to the group feed with your mobile device.

**To send a status update to the group feed via e-mail**

1. Go to the group overview page and click the Settings drop-down menu.
2. Choose **Send Status Via Email**. SAP Jam will attempt to open your e-mail client and set your e-mail address as an automatically generated one that is specific to you and the group.

3. Enter your status update and then send the e-mail. The group feed will be updated with your e-mailed post.
2.1.15 Questions, ideas, and discussions

If forums are enabled for your group, on a group feed you can ask a question, add an idea, or start a discussion.

The rich text editor that appears for the post box will display bold, italic, and underline actions only to accommodate the screen size. There is also a menu for actions such as Attach Existing File, Upload New File, Add a Tag, and Mention Someone.

![Rich text editor and actions menu]

2.1.16 Feed previews

Feed previews allow you to take a look at content without leaving the page for the actual feed update.

When posting URL links in a feed update, the metadata (e.g., hyperlink, content title, author name) for the URL can be edited.

In feed posts containing links to multimedia content on select third-party sites (YouTube, TED, Vimeo, and SlideShare), SAP Jam users can click the link preview thumbnail to view that content in an embedded player without leaving SAP Jam.

![Click the thumbnail to expand]
Expanded video within feed example
3 Notifications and Messages

3.1 About notifications

SAP Jam can bring your attention to content updates, posts, or replies to posts in a few ways: bell notifications, mobile "push" notifications, email digests, browser notifications, and SuccessFactors notifications.

### Notification types

<table>
<thead>
<tr>
<th>Type of notification</th>
<th>Purpose</th>
<th>Set up steps</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bell</td>
<td>To notify you of important updates, invitations, and approval requests.</td>
<td>No setup steps required.</td>
<td>• your name is @mentioned&lt;br&gt;• your comment receives likes&lt;br&gt;• you are invited to a group</td>
</tr>
<tr>
<td>Mobile push</td>
<td>To notify you, as a mobile user of SAP Jam, of the most critical updates (as in, a subset of bell notifications).</td>
<td>Push notifications must be enabled for the SAP Jam app on your device.</td>
<td>• you received a feed item reply&lt;br&gt;• your name is @mentioned&lt;br&gt;• you received a kudo&lt;br&gt;• you are invited to a group&lt;br&gt;• you are assigned a task&lt;br&gt;• you received a personal or group message, or were added to a message thread</td>
</tr>
<tr>
<td>E-mail</td>
<td>To notify you via email of important and periodic updates.</td>
<td>Under Account Settings &gt; Email select which notifications you’d like to receive, and select the frequency of email notifications for each group you belong to.</td>
<td>• High or medium priority notifications&lt;br&gt;• Immediate, daily, or weekly group email digests</td>
</tr>
<tr>
<td>Type of notification</td>
<td>Purpose</td>
<td>Set up steps</td>
<td>Examples</td>
</tr>
<tr>
<td>----------------------</td>
<td>---------</td>
<td>--------------</td>
<td>----------</td>
</tr>
</tbody>
</table>
| **Browser**          | To notify you, as a web application user of SAP Jam, of a subset of bell notifications. | See the Browser notifications [page 60] topic. | ● your name is @mentioned  
● your comment receives likes  
● you are invited to a group |
| **SuccessFactors**   | To notify you, as a SuccessFactors user, of important updates. Also includes SAP Jam updates. | See the Notifications topic in your SuccessFactors Event Center Guide. | ● Your direct report requires approval for a vacation request. |

**@mention**

When the notify features are used by your colleagues, you will see a list of notices under the bell notification icon on your top right SAP Jam toolbar. Email notifications are managed under Account Settings > Email.

The @mention feature lets you notify specific users in SAP Jam. You can @mention a user by typing the '@' sign and then selecting your colleague’s name from the drop-down list. When you type the first few characters of the person’s name (for example, “type-ahead”), a list of matching names will display if they exist. Depending on the context in which you use the @mention feature, the list of user names will be based on:

- **@mention within a group**: the list of possible user names will be restricted to the members of that group.
- **@mention outside a group**: the list will include all users in your instance of SAP Jam.

**@@notify**

The @@notify feature lets you notify multiple SAP Jam users at the same time. How many people will be notified is indicated in brackets, so you are aware of how many people will receive your notification. Depending on the context in which you use the @@notify feature, the list of user names will be based on:

- **@@notify within a group**: notifies all members of that group about your content or activity; use this feature sparingly in groups with large member lists.
- **@@notify outside of a group**: on your profile wall, using @@notify will notify all users in SAP Jam who follow you.

In both cases, consider the number of people you may be notifying before you use the feature.

Personal notifications ensures you can find all actionable SAP Jam events that require your attention. This includes:

- @mentions
- replies to your comments
- user comments on or replies to a content item that you post
- likes for your posts
- answers to your questions
- feedback on your ideas
- kudos you’ve received
- user posts on your profile wall
- user edits a post that you have already liked or replied to
- user tags your name to an image

and so on. The notifications alert in the SAP Jam header displays the number of notifications you have. When you click the bell icon, a drop-down of those notifications displays, allowing you to view all, or view or dismiss individual items.

Bell and email notifications are sent to content contributors for the following activities:
- Reply is made on a mirrored copy of your content, provided you have access to the group that it was mirrored to.
- Reply is made in response to your content update.
- Reply is made to any version of your content. If someone else besides yourself uploaded a new version of your content, they will also receive the notification.
- A comment is made on a highlighted area of your content.

Bell and email notifications are sent:
- to you when someone replies to a comment you’ve made on a content item.
- to wiki page content authors and editors of that wiki page when someone comments on it.
- to blog post content authors and designated authors of that blog post when someone comments on it.
For group administrators, where moderated participation has been enabled, notifications also alert you of new content that has been uploaded and is awaiting your review and approval.

For company administrators, notifications alert you to content that has been marked as inappropriate and requires your review.

### 3.2 Notifications tile

On your Home feed, a notifications tile appears to the right of your activity feed to inform you of important updates. Notifications are organized by category and lists the number of unread notices beside each category.

<table>
<thead>
<tr>
<th>i Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Notifications Summary tile does not display as expected on the Microsoft Internet Explorer v8 browser.</td>
</tr>
</tbody>
</table>

The summary displays the number of outstanding items by category:

- Social updates (e.g., mentions, replies, and likes)
- Invitations (e.g., group and event invitations)
- Requests (e.g., examples are requests to join a group, requests to approve content)
- Tasks (e.g., examples are tasks assigned, tasks reminders)
- Informational updates (e.g., examples are you being featured in a group, group access granted)
As you view and/or dismiss notifications, the count that appears beside the notification category will decrease.

Each notification displays a different icon to visually indicate a category type. For example, a different icon displays whenever you are @mentioned or @@notified, received a reply to a comment or content item, received a like on your post, accepted in your request to join a group, or endorsed for your skills by another user.

To view notifications for a select category

1. Go to the Notifications Summary tile.
2. Click the View all link below the description of the category.
3. Click View to view the notification.
4. To remove the notification from the list, click Dismiss. If you want to remove all notifications from the list, click Dismiss all near the top of the list.

To view all notifications for every category

1. Go to the Notifications Summary tile.
2. Click the View all notifications link at the bottom of all the categories. Notifications are listed in the order of most recent notice activity at the top of the list. As you scroll down the browser page, the list will display the next most recent notifications.
3. Notifications are listed by category when you click the Show all drop down menu. You can click on individual notifications to view and dismiss them. You can also click **Dismiss all** near the top of the list to remove all notifications from the lists for each category.

When you click **Notification Settings**, the Email Settings [page 28] page displays; here, you can set your email notification preferences.

### 3.3 Browser notifications

Pop-up browser notifications display alerts on your desktop whether you are working within an SAP Jam browser or not. You can easily turn these notifications on or off through your avatar above the global menu bar.

> **Enable or disable browser notifications**

SAP Jam gives you an initial prompt for browser notifications at the top of your browser. You can choose to enable notifications now, choose a setting at a later time, or choose not to receive browser notifications from SAP Jam.

> **Browser notifications keep you up to date**

**Note**

Browser notifications can be enabled or disabled as needed for each browser that you use. For example, if you use Google Chrome and Mozilla Firefox interchangeably as your browsers, you can enable browser notifications on one but not the other, enable them both, or disable them both to suit your preference.

If you choose to receive notifications, you will be prompted with another dialog to **Allow** for your current browser. Once you click Allow, as notifications occur, you will see pop-ups appear on your desktop.

> **Allow notifications**

You can click on them to view the notification or click the X to dismiss the pop-up.
You can change your mind later and choose not to receive browser notifications. Click your avatar and move the toggle to disable browser notifications.

### 3.4 Online presence

Knowing the online presence of a group member or colleague can help you decide when to engage with them. Online statuses display on profile pages, hover cards, and messages. When you set your status to appear online, you are letting your colleagues know that you are available to collaborate.

#### Set your online presence

From your avatar above the global menu bar, you can now set your presence to one of the following:

- **Online**: Indicates to other colleagues that you are available.
- **Appear Offline**: Indicates to other colleagues that you are not currently online or available.

**Note**

After a period of inactivity, the visual indicator will display an offline icon. When you resume activity, the presence status changes to reflect your preferred presence indicator.

The green presence indicator appears to the bottom right of a user’s avatar whenever the user is online. If the user is offline or their status is unknown, on feeds, the indicator does not display. Elsewhere, the offline and unknown indicator displays without a color.
Online indicator in feed item

i Note
The presence indicator is not applicable to external users. Members cannot see each other’s presence status.

When you view a hover card for another SAP Jam user, you will see a visual indicator that identifies if they are online or not.

In addition to Messages, the online presence indicator also displays wherever profile avatars appear (e.g., group member lists, feed items, tasks, event guest and members to invite lists), except on group overview pages.

i Note
On hover cards, the previous away indicator that appeared when a user sets their away alert has been replaced with the presence indicator. The away message still appears.

Browser notifications and online presence

When your presence is set to Online and you have browser notifications enabled, if you have a browser tab open other than the one displaying SAP Jam, you will see a pop-up notification to alert you to a new message in SAP Jam. When your presence is set to Online and you have notifications disabled, if you are viewing a browser tab other than the one displaying SAP Jam, your presence appears as offline.
3.5 Messages

Messages for SAP Jam Collaboration provide a quick and convenient way to converse with others within your company or with colleagues who do not have company provisioned emails. New messages appear in real-time and can include your colleagues, up to a maximum of thirty individual participants.

About Messages

When Messages are enabled by your company administrator in the SAP Jam Admin console, a new messages icon displays above the global menu bar. This icon replaces the previous envelope icon that was used to access the Private Messaging feature.

**i Note**

As of the August 2017 release, the feature formerly referred to as “Private Messages” was enhanced for multiple recipient participation (up to 30 people) including those who do not have company provisioned emails. If “Private Messages” was disabled prior to the August 2017 release, it will remain disabled for Messages. If it was enabled, any private messages that were not deleted will still be available for viewing within Messages.

There are two distinct Message sections on the left side messages navigation panel: one for access to personal messages, and below it, group specific messages. Whenever you open the Messages view, you are prompted to choose a message thread from the Messages navigation panel. From the groups section, the groups display in order of most recent message thread activity. Please see Group level messages [page 70] for details specific to working with group messages.

Compose a new message for one-to-one and multiple person conversations

To compose a new message

1. When you want to create a new message and invite one or more colleagues to participate, from the left side pane you can click Personal Messages and then click the New Message icon.
2. As you type the first few letters of a participant’s name, a list of suggested matching recipients will appear, if available.
3. Click Create Message.
4. Your message can include text, links, and images.

**i Note**

- Within a thread, you can insert a png, gif, tiff, or jpeg image or photo (of a size up to a maximum of 5 MB) from your local drive or browser.
- Images can be copied and pasted into a message thread, or uploaded.
- Only one image can be inserted at a time. When you click the image, a larger version of the image displays in a new desktop browser tab. You can delete your image from a message thread by clicking the dropdown to the right of your message and selecting the Delete icon.
You can type a subject name (optional) for the message, using up to a maximum of 50 characters.

When entering a hyperlink, it displays with a preview below it. If you enter multiple hyperlinks, only the first hyperlink will have a preview box.

5. Click the Send icon. After you’ve sent a message, you can click the Edit icon beside the text of the message to make and save your changes. Other participants will see the updated timestamp on your message.

When a thread participant is typing a message, you will see an indicator that shows that they are in the midst of composing their message.

You can @mention another participant in your thread. Enter the first few letters and then view a list of possible matching names to choose from. Right-to-left languages are also supported. As the participant, when you are @mentioned in a message, you will receive an email notification and bell notification indicating that you were mentioned in a message thread.

Information and settings for message thread

You can easily access and use the following actions for a message thread via the Info icon. You can also click the message thread header to view the Information panel on the right.

- rename the subject line
- mute a message thread
- view any images or media and links separate from the message
- view a list of thread participants
- remove or add more participants
- leave a message thread

Document uploads

When entering messages, you can upload and attach content items such as documents and video files directly from your local drive. A preview is also embedded in the message with the document icon and content name. You can hover over the document to access the options to download and copy the document. When you click on the uploaded document, it opens in a new browser tab within SAP Jam.

Delete an individual message within a thread

On your individual message within a message thread, you can delete it by clicking the dropdown to the far right of your reply and click the Delete icon.
Email notifications

Under your Accounts Settings >> Email >> High Priority Emails, you can choose to receive an email notification whenever you are invited to a message thread.

Emoji and message reactions

When entering a message, you can select emojis from an emoji picker at the bottom of the window. Emojis display the same style on all operating systems and internet browsers.

You can also display up to six reactions to convey further information about the message. When you add a reaction for a message thread, the reaction highlights to indicate that you have reacted. When you click your reaction or someone else’s, a dialog displays to show a list of who reacted along with their reactions. You can view a list of who reacted to a message. Your reaction is shown at the top of the list, followed by the most recent reactions of others.

Keyboard shortcuts

You can use the following keyboard shortcuts when entering messages:

- Esc: clear text and close dialogs.
- Up arrow: edit the most recent message.
- Page up/Page down: switch between threads.
- End: Go to the end of conversation.

Leave a multiple participant message thread

You can leave a multiple participant message thread by clicking the Thread Info icon on the top right pane and choosing Leave Message Thread. You’ll be prompted to confirm whether you want to leave the message before you are officially removed. Once you’ve left a message, it no longer appears in your message viewer. For participants that are still engaged in the message thread, they will see a notification stating that you have left the message.

Message formatting

As you compose a message, you can format the text using the markdown tips in an organized Formatting Reference with headings, syntax, and examples at the bottom right corner of the message pane.
Markdown help as organized formatting reference

Example: List reference
Media and documents

On the right side panel, from the Media and Documents tab, you can view a list of items at a glance and choose to download, copy, go to the message where the media or document file is attached, or delete the file.

When you access media and documents from the content item, the message thread opens to the exact location of the media and links from where it was shared.

Message replies and threads

Each reply within a message thread cannot exceed 5000 characters.

In your message viewer, each reply in a thread will show a time stamp below the reply, along with the name and avatar of all other participants.

When you participate in or view a message thread, the blue circle that displays the number of unread messages within a thread no longer displays. As participation occurs within a message thread, individual and system messages are kept within the thread. Any current or future participant can view previous messages within the thread for reference or context.

The first few words of the latest message of a message thread appears on the left side of the Messages window to help keep you up to date with the most recent activity in a message.

The time stamp that appears in a message is based on the time zone setting that’s configured under your time and calendar settings in SAP Jam.
Mute a thread

To minimize the attention of messages that are not relevant or of interest to you, you can mute the message thread by clicking the Mute toggle in the Thread Info settings. You can click the same toggle to unmute a thread when you are ready to read or participate with the message thread again. Muting a thread hides the updating of the unread messages count, and stops sending email, browser and mobile notifications about the thread.

Remove a participant

From the Thread Info view, any participant in a group thread can remove another participant from the thread. From the Participants list, click the X beside the name of the person to remove. The removed participant will see a system message indicating that they have been removed from the thread. They will no longer be able to view the thread from the thread list.

Send a message from a hover card

From an SAP Jam user’s hover card, you can start a message thread with them by choosing Actions ➤ Send a Message. If you already have a one to one message thread in progress with the same user, the message viewer will open an existing message with your thread history rather than start a new, blank message thread.

Share a message

When you hover over an individual message, you can click the Share icon to share the message to the company or a group as a feed post.

Share a feed item to a message

You can share a feed item in a message to your company, your group, or a group message. When sharing a feed item as a message with groups, you’ll need to enter the name of an existing message thread. The Message Thread type ahead feature can help you refine a list of message thread names.

System messages

Whenever you start a new message thread, invite a participant to a message thread, leave a message thread, and rename a message thread, an entry displays in the thread to inform all participants of these changes.
You can click a system message to view the full list of participants who were added to or removed from a message thread.

**Search messages**

(Appplies to SAP Jam Collaboration web application only) You can search for specific text in messages where you are still a participant by using the Search field above the global menu bar in SAP Jam. The search filter now includes "Messages" to help you refine what is being searched.

**i Note**

If you leave a group message thread, you can no longer access or search for that thread.

When you click a matching search result, the link opens at the position of the matching text in your message thread.

On the Search results page, if there is a matching result, the name of the message appears as a clickable hyperlink.

**Search by name or subject**

From the left side pane in Messages, you can search for a specific message by entering a participant name or subject.

**Unread messages**

The number of unread messages that you have displays beside the messages icon above the global menu bar.

**i Note**

If a thread is muted but contains unread messages, the unread thread badge does not display.
Unread threads

For unmuted threads or threads you have subscribed to, if you have unread messages you will see an indicator with the number of unread messages beside the personal messages or group names in the messages navigation. A left side vertical bar also displays. Once you view the unread thread, the indicator count clears.

Note
If a thread is muted but contains unread messages, the unread thread badge does not display.

3.5.1 Group level messages

Group administrators can enable or disable a group level Messages feature for your group. When enabled, group members can access group messages from the group navigation (sidebar or header).

Group message participation

Message participants are implicitly added or removed based on group membership. For example, if a new member joins the group, they automatically become a participant in their group’s existing and new messages. Individual members cannot be removed as participants from group messages.

Note
If the group is public, you can @mention anyone in the company in a message thread.

You can also notify many people at once by using member lists. Use the syntax "@@[name of member list]" in the message thread.

Participation level and upload policy

If your group administrator has set your group’s collaboration level to “Full”, you can do the following:

- view existing message threads
- create, edit, and delete messages

Note
You can keep your group more organized and focused on relevant conversations by deleting group message threads. Deletion includes the conversation history for all participants. Deleted message threads are removed from the group message thread list and moved to the group trash. From there, they can be purged or restored, the same as with other group content.

- use reaction emojis
- create a message thread
• edit the subject of an existing message thread
• upload attachments

If your group administrator has set your group’s collaboration level to "Limited", you can do the following:

• view existing message threads
• create, edit and delete, message
• use reaction emojis

<table>
<thead>
<tr>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group administrators are the only members who can create message threads for a group with a Limited collaboration level.</td>
</tr>
</tbody>
</table>

If your group administrator has set your group’s upload policy to "All Group Members", you and your fellow group members can post images to a group message thread.

**Subject**

When creating a new message thread, a subject is required. The subject displays in the header for the message thread.

**Muted threads by default**

By default, new message threads are always muted for everyone in a group, except for the thread creator. However, when you create a group message thread, you can use @@notify to make all group members aware of your new thread. An information message also displays near the bottom of the message panel about using "@@notify" and allows you the convenience of click to insert. When the group member views the new thread for the first time, they will see a message prompting them to unmute the thread if they want to receive further notifications.

You can also notify many people at once by using member lists. Use the syntax "@@[name of member list]" in the message thread.

The volume of your message notifications may increase as you participate in more groups. The mute toggle that displays on the information panel helps you control that volume. As a group member, when you create a new message thread, you can mute or unmute notifications for that thread. By default, notifications are not muted.

**Group settings**

From the top left of the Messages navigation, you can access the group settings console where you can manage mute settings for all threads, and configure or view group settings for the following:

• Follow this group
- Group access information
- Send feed status via email
- Request group admin privileges (only displays for non-group admins)
- Leave group

**Group settings for group and thread muting**

**Navigate back to group**

The group avatar and name, along with hyperlink to the default group landing page display at the top of the left panel.
Example of group message with group name and avatar

Notification for subscriptions

You can receive desktop notifications for group message threads you are subscribed to.

Search for messages

You can search through all group messages for a single group using the search bar on the global menu navigation. When you change the messages navigation to viewing group threads, *This Group’s Messages* automatically displays as the filter. You can use the This Group and This Group’s Messages filter to refine your search. When you click the message from the search results page, it opens the message within the Messages pane.
Delete message thread

A group administrator or group member belonging to a group with Full collaboration level permissions can keep a group more organized and focused on relevant conversations by deleting group message threads. Deletion includes the conversation history for all participants. Deleted message threads are removed from the group message thread list and moved to the group trash. From there, they can be purged or restored, the same as with other group content.

To delete a message thread, go to the thread, click the information icon and click Delete Message Thread.
4  Content

4.1  About content

Content items are blog posts, decision tools, links, planning tools, videos, wiki pages, images, documents (PowerPoint, Word, Excel), polls, and any other file that you upload to SAP Jam.

Generally, group members provide their feedback on the information that content items contain, and use this information to collaborate and make decisions. Creating and sharing content collaboratively within an integrated environment has a great potential for improving the way your team works.

You can create content items in two areas depending on the intended audience for your content:

- **SAP Jam group**: Content placed here is available to all group members, or a subset of group members if specifically placed in a private folder. The title, contributor, type, and last modified information has been reorganized into clickable columns on the left side of the table.

  ![Content Table]

  A new column has been added to show the number of replies

- **Your profile page**: Content can be viewed by everyone in your organization.

To access content within a group, navigate to the group where the content resides and click **Content** in the left navigation bar. You are directed to an overview of all content items that have been created in the group. You can also access content from group pages within content widgets, or by searching for specific content within a group or anywhere else within SAP Jam. When you click on the item, the hyperlink will open within a single item
To access content within a person’s profile page, navigate to the person’s profile page and select a content category in the left navigation bar. You will see all content items of the selected category that this person has created.

### Accepted File Formats

Please see the [Upload supported audio and video files](page 94) topic for a complete list of supported formats.

The following file formats for images and audio can be uploaded to SAP Jam:

<table>
<thead>
<tr>
<th>Accepted Audio Formats for Podcasts (Audio-only)</th>
<th>Accepted Audio Formats for Videos</th>
<th>Accepted Image Formats</th>
</tr>
</thead>
<tbody>
<tr>
<td>AAC (MPEG-4 audio)</td>
<td>AAC (MPEG-4 audio)</td>
<td>BMP</td>
</tr>
<tr>
<td>FLAC</td>
<td>MP3</td>
<td>GIF</td>
</tr>
<tr>
<td>MP3</td>
<td>MPEG 1 Layer II</td>
<td>JPG</td>
</tr>
<tr>
<td>OGG</td>
<td>PCM</td>
<td>JPEG</td>
</tr>
<tr>
<td>WAV</td>
<td>WAV</td>
<td>PNG</td>
</tr>
<tr>
<td>WMA</td>
<td>Windows Media Audio 8 and 9</td>
<td>WBMP</td>
</tr>
</tbody>
</table>

While audio formats for podcasts are recognized in SAP Jam as audio files, they cannot be played within SAP Jam. The file must be downloaded and played within a media player.

**Note**

Audio files protected with Digital Right Management encryption, such as protected AAC audio files (*.m4p) purchased via iTunes MP4 Baseline as audio container, are not supported.

Other file types for content upload can include (but are not limited to) spreadsheets, PDFs, slides, and documents. Some content may provide a preview.

The following Microsoft Office files can be opened and directly edited in SAP Jam. Previews are also available:

- *.ppt, *.pptx: PowerPoint presentation
- *.pptm: PowerPoint macro-enabled presentation
- *.potx: PowerPoint template
- *.potm: PowerPoint macro-enabled template
- *.ppsx: PowerPoint slideshow
- *.ppsm: PowerPoint macro-enabled slideshow
- *.xl6, *.xlsx: Excel workbook
- *.xlsxm: Excel macro-enabled workbook; same asxlsx but may contain macros and scripts
- *.xl8: Excel template
- *.xltm: Excel macro-enabled template; same as xltx but may contain macros and scripts
* .doc, * .docx: Word document
* .docm: Word macro-enabled document; same as docx, but may contain macros and scripts
* .dotx: Word template
* .dotm: Word macro-enabled template; same as dotx, but may contain macros and scripts

**Note**
SAP Jam uses an industry-leading virus scanner which checks content as it’s uploaded; if a virus is detected, the content cannot be downloaded or accessed by others.

**PDF inline viewer**

If enabled by your company administrator, you can download, view, and print an inline PDF. If features (such as Print) are not enabled with inline viewing, PDFs can be downloaded with the option Open or Save in a PDF viewer.

**Note**
- Larger PDF files may take some time to display.
- Annotation for the PDF is unavailable when viewing the inline version of a PDF.

Any links in the PDF are clickable.

### 4.1.1 Content templates

Your company administrator can create as many wiki page and blog post templates as necessary for use across your organization. These templates can be optionally standardized with your organization's branding, trademark details, disclaimers, or any content that assists with the consistency and desired uniformity to help users recognize what they are looking at.

**Working with blog post and wiki page templates**

When you create a blog or wiki, you now have the option to select from a list of blog post or wiki page templates that help you save time while allowing you to take advantage of a design that is easy to work with. Once you create a blog post or wiki page using a template, you can customize it as you need to by removing or editing sections.

**To create a blog post or wiki page using a content template**

1. Follow the steps to first create a new blog post or wiki page.
2. Below the breadcrumb link to where your blog post or wiki page will be saved, click the dropdown menu that says "No Template". If the company administrator has enabled pre-designed templates, you will see one or more selections in this drop-down to choose from.
3. Select a template. The content area of your wiki page or blog post will update to display this template.
4. Complete and modify the content area as required.

### 4.1.2 Create a content item within a group

When you create content within the context of a group, you are creating a resource that can be shared, viewed, or updated amongst members.

1. Go to the group where you want to create a content item and click **Content** from the navigation menu. You will be directed to an overview of all content items that have been created in the group.
2. Click **Create** and select the type of content from the menu. You can create the following types of content items:
   - Blog post
   - Decision making tools: Decision, Poll, Pro/Con table, and Ranking
   - Link
   - Planning tools: Agenda, Task, and Timeline.
   - Video
   - Wiki page
   - Folder
   - Private folder

You can upload the following content items:
   - Documents (as in, Microsoft Excel spreadsheet, Microsoft Word document, PDFs, text file, zip file, and image upload sizes greater than 10MB)

     **Note**
     You can now preview Microsoft Excel documents that are less than 3 MB. Due to content complexity, some files that are less than 3MB may not be available for preview.
   - Presentations
   - Videos

     **Note**
     Not all content types are available in all editions of SAP Jam. Contact your company administrator to learn more about your company’s SAP Jam edition.

### 4.1.3 Related content

Related content is based on items you liked, commented on, followed, bookmarked, or where you were at-mentioned on. To help you discover more content related to an item you are currently viewing, a carousel of up to 9 related content items can display at the bottom of the single item view. The content metadata (for example, number of likes, views, comments, content author name, and when it was last posted) also displays.
4.1.4 Add and delete your content items from your profile wall

If you are not part of a group or wish to share content with your followers or other users of SAP Jam in your organization, you can post content items to your profile page.

**Note**
Content from groups is not shown on your profile.

Add content to your profile wall

When you add content to your profile wall, you are adding content that can be shared with anyone in your organization.

1. Click your profile photo avatar or name at the top of the page or beside the search bar to go to your profile wall.
2. From the Add Content menu on the left side navigation, select the type of content that you want to create:
   - Blog Posts
   - Documents
   - Images
   - Links
   - Videos
   - Wikis

**Note**
Not all content types are available in all editions of SAP Jam. Contact your company administrator to learn more about which edition of SAP Jam your company is using.

Delete content from your profile wall

To delete content from your profile wall

1. Below the Add Content menu on the left side navigation, click the category for the item you wish to delete.
2. For Images and Videos, click View all.
3. Click the Trash bin icon beside the item you want to delete.
4. A confirmation message appears. If you want to continue with the deletion, click Delete. The item you deleted now appears in the list view with a strikethrough over the name, posted, and contributor information. When you refresh the page, the item will be removed.

**Note**
If a Links section appears, it is because you created links prior to the November 2014 release using the Links feature. Any links listed in this section cannot be deleted.
4.1.5 Decision-making tools

Decision-making tools help direct the discussion in a group.

Generally, group members add their input to decision making tools and make decisions analyzing the record of this information. For example, you can use a Pro/Con Table to create a set of options and gather positive and negative opinions about each option. Then, group members can use the record to help them decide which option to select.

The following decision making tools are available:

<table>
<thead>
<tr>
<th>Decision-making tool</th>
<th>Description</th>
<th>Examples of when to use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Decision</td>
<td>Describes what decision needs to be made. Once it’s been decided, you can record and lock your decision, and select group members to sign off on it. You can always re-open and change the decision.</td>
<td>Committee members within a finance group need to make some important budget decisions. Within a private folder, the chief financial officer wants a decision to be made on how to allocate the surplus budget at year end. The Vice President of Finance proposes that they devote the surplus to a professional development and training account. His colleagues on the executive committee, if they agree, can sign off on the decision.</td>
</tr>
<tr>
<td>Poll</td>
<td>Allows you to ask a multiple choice question. When you create a poll, you define the question and the possible answers. The poll appears on the group feed of the group where you created it. As people respond to the poll, results are shown graphically as colored bars.</td>
<td>The IT department of a university would like to poll all other departments on what types of printers they would prefer in their work areas. One of the desktop support analysts creates the poll, listing three printers that he thinks will be suitable for everyone’s needs. He chooses to allow responders to add their own ideas, and make the results of the poll anonymous to ensure there is no favouritism.</td>
</tr>
<tr>
<td>Pro/Con Table</td>
<td>Allows you to create topics and have your team members provide pros and cons for each topic, along with the reasons behind each pro and con. If your view is set to Summary, the Pro/Con Table will only display the total pros and cons. If your view is set to Full Text, the reasons behind each pro and con will display.</td>
<td>The HR manager for a small construction management company is researching new performance approval programs. She’s been asked to create a pro/con table to be reviewed by the president and various VPs. Everyone can add a pro and con for each program she lists. If there is no conclusive outcome, they can use the pro/con table as a reference for an upcoming teleconference discussion.</td>
</tr>
</tbody>
</table>
| Ranking              | Contains a question and a list of valid responses. In a Ranking tool, you would go through the following stages:  
  - **Build**: The question is entered, and the items to be ranked are added to the tool.  
  - **Rank**: Each team member ranks the responses and submits their own ranked list.  
  - **Freeze**: The rankings are tallied and the results are presented. | The executive staff of a luxury hotel chain are asked to choose their preferred location for a company team building event. An administrative manager has chosen five central locations and placed them in no particular order. She’s asked all executive staff to rank their preferences before she presents the results. |
| Comparison Table     | Allows you to create two or three columns with a list of options for comparison purposes. | The sales manager for a luxury auto dealership wants to prepare staff with a list of options for comparable... |
### Decision-making tool

<table>
<thead>
<tr>
<th>Description</th>
<th>Examples of when to use</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>vehicle models provided by their top two competitors. Each row contains a particular feature from their published vehicle specifications while the columns show their latest luxury model versus the other two. Staff can then familiarize themselves with the benefits of their model against other brands, and use that information when selling to customers.</td>
</tr>
</tbody>
</table>

To see all the decision making tools in a group, click **Content** from the navigation menu, choose **Create** on the menu bar above the content list, and then select **Decision-Making Tools**.

### 4.1.5.1 Decision

**To create, finalize, and sign-off on a decision**

1. From the Content section, click the **Create** drop-down menu and select **Decision-Making Tools Decision**.
2. In the New Decision dialog box, enter a Title for your decision. The Title can be a concise summary of what group members need to decide upon.
3. Click **Create**.

4. In the "We need to decide" text box, enter a description of what needs to be decided and why.

5. Click **Save**. The description displays in the text box and a **We decided...** button displays. When you hover over the description, an Edit icon displays, allowing you to edit the text whenever you need to.

6. Once a decision is made, click **We decided...** and add a description for the decision that was made.

7. Click **Save**. The description displays in the text box and a **Sign-off** button displays. When you hover over the description, an Edit icon displays, allowing you to edit the text whenever you need to.

8. To begin the sign-off process for the decision, click **Sign-off**. This allows group members to click a "**Click here to sign-off**" hyperlink.

When you sign off, your user name displays below the "We agree with this decision" heading. If you change your mind, you can click the Remove icon that appears beside your name to remove your name from the agree list.

If no one signs off, and/or the decision has changed, you can click **Re-open Decision** to change the decision entered under "We decided...".

### 4.1.5.2 Poll

**To create a poll**

1. From the Content section, click the **Create** drop-down menu and select **Decision-Making Tools** > **Poll**.

2. In the Create a Poll dialog box, enter the following:
   - **Poll Question**: Enter your poll question.
   - **Options**: Enter the options for your poll. Initially, three text fields display for you to enter your options, but more are automatically added as you click and type into the last Option field.
   - **End Date**: (Optional) Click the pop-up calendar to choose an end date for the poll. Group members will not be allowed to vote in the poll after the end date passes.
   - **Allow users to add their own options**: Enable this if you want to allow group members to add their own options to the poll.
   - **Allow users to select multiple options**: Enable this if you want to allow group members to select more than one option.
   - **Anonymous Poll**: This is selected by default; group members can vote in the poll without revealing their names. Members will only see the total number of responses and the percentage allocation to each option.
   - **Public Poll (Vote response will be shown)**: Select this if you want group members to see who voted for which option in the poll. In the single item view, members can click a **Show Breakdown** link to view this detail.

3. Click **Create Poll** to post the poll to the group feed. If you need to edit the end date for the poll, return to the Content section, click on the poll, and then click **Edit** at the bottom of the options list.

To vote in a poll, you can select your option(s) and then click **Vote Now** on the poll item. If you change your mind, on the poll item, you can also click **Change Your Vote**.

To view the results of a public poll, click **View Results**.
Edits to a poll

After a poll has been created, a group administrator or poll creator can edit a poll question and its answers.

Note
To help prevent any manipulation in meaning of the question or answers, options cannot be added or removed when editing polls.

Edit Poll

Poll Question: How often do you connect with your Dyanso Product training alumni group?

Options:
- Daily
- Weekly
- Monthly
- Never

Start Date: 01/10/2016
End Date: 01/22/2016

- Allow users to add their own options
- Allow users to select multiple options
- Anonymous Poll

Public Poll (Vote response will be shown)

Save changes  Cancel

Edit a poll

Once a poll has been edited, a notification is sent to all the current voters, indicating that the poll has changed and when.
4.1.5.3 Pro con table

To create a pro/con table

1. From the Content section, click the Create drop-down menu and select *Decision-Making Tools* > *Pro/Con Table*.
2. In the New Pro/Con Table dialog box, enter a Title for your table. The Title can be a concise summary of what the issue or topic is about.
3. A single item view of the pro/con table displays. In the "Input topics here and press (enter)" text field, enter the issue or item that requires consideration for pro or con and then click *Add topic*.
4. In the table cell for the Pro column, hover your cursor and you will see "Click to add a Pro opinion". When you click inside the cell, you can enter your pro in the Create new Pro Opinion light box. To enter more pros, click again inside the table cell.
5. Repeat the previous step for cons, only within the Create new Con Opinion dialog box.
6. To edit or delete any of the opinions, hover your cursor over the opinion and click to open it in the dialog box.

4.1.5.4 Ranking

To create a new ranking

1. From the Content section, click the Create drop-down menu and select *Decision-Making Tools* > *Ranking*.
2. In the New Ranking dialog box, enter a Title for your table. The Title can be a concise topic or question to summarize what is being ranked.
3. In the single item view for the ranking, the Build tab displays. Enter the question in the first line and then click the checkmark icon to save it.
4. Below the question, enter the items you want to rank. Click *Add* to enter each item. You must enter a minimum of two items.
5. To rank the items, click *Start Ranking*. Drag and drop the items to re-order them, with 1 as the highest ranking.
### 4.1.5.5 Comparison table

**To create a comparison table**

1. From the Content section, click the *Create* drop-down menu and select *Decision-Making Tools > Comparison Table*.
2. In the Comparison Table dialog box, enter a Title for your table. The Title can be a concise summary of what is being compared.
3. A single item view of the comparison table displays. Click each column header to edit the title and enter the name of what you want to compare.
4. To enter a specific option for comparison, click *Add topic*. This will add a new row to the table.
5. In each table cell, enter information about the option as it relates to the particular column.

### 4.1.6 Links

Links can be URLs to other websites, documents or other elements within a document. Links to most SAP Jam items open in a light box when you browse a link via the feed or overview page. Exceptions include questions, discussions, ideas, tasks, events, polls, videos, and business tools. As with other content types in Jam, you can organize, view, edit, delete, rename, and restore links.

**Create a link**

**To create a link within the content repository**

1. Select your group and then click *Content*.
2. Below the group name, click the *Create* drop-down menu.
3. Click *Link*.
4. In the Add Link window, enter the URL to the link. If the URL is valid and contains metadata for a single thumbnail or multiple thumbnail previewer, title, and description, that information will display when shared in a group feed. Metadata information also accompanies links for SAP Jam items such as wikis, blogs, and documents. All http URLs are converted to a readable hyperlinked title, where possible.
5. Click *Submit* to post the link as a document on the feed.
6. If you forget or choose not to enter a title, the URL will display in full within the feed. You can change the title by clicking the link from the feed and then clicking the title bar where the URL appears. Enter the title here.

**i Note**

The Links section on the left side panel only appears as a view only library for groups, profiles, and companies created in Jam prior to the 1411 release. You can no longer add or delete links from this section. Those actions can only be performed within the Content section.

**i Note**

The option to post a link as an External Document has been removed.
Edit a link

To edit a link

1. Under Content, browse to the location where you saved the link and click the name of the link. The link opens in a light box.
2. To change the title of the content item which displays in the Content repository, click the title box and edit. Click anywhere outside the title to save your changes.
3. Click Edit from the list of actions below the name of the link.
4. To change the title of the link which displays in the feed, click the title text box and make your changes.
5. To edit the description, enter your changes in the description text box, below the title text box.
6. To edit the URL, enter your changes in the URL text box below the description.
7. When you are done, click Post to re-post your updated link.
8. You can hide or show a thumbnail image with the link by selecting or clearing a preview checkbox.

Go directly to the link

To go to the link without having to click through the link’s content item page

1. In the Content repository, browse for your link.
2. Below the link title, click Go To Link. The link will open within the same open browser instance; if you close the window, you’ll also be closing the browser instance for SAP Jam.

<table>
<thead>
<tr>
<th>Title</th>
<th>Contributor</th>
<th>Last Modified</th>
</tr>
</thead>
<tbody>
<tr>
<td>Go to Market Brainstorming Session</td>
<td>Perry Johnson</td>
<td>3 days ago</td>
</tr>
<tr>
<td>Industry standard for product management and marketing</td>
<td></td>
<td>3 days ago</td>
</tr>
</tbody>
</table>

Go To Link

Note

External links or external pages accessed via the Content section or a feed will open in a new browser window.

Featured links (group administrator function)

To feature a link

1. In the Content repository, browse for your link.
2. Click the content item title to go to the light box view.
3. From the More drop-down menu, click Feature. Where content is enabled on group overview pages, the link will appear as featured content.
4.1.7 Planning tools

Planning tools help you plan and coordinate projects with team members.

The following planning tools are available:

<table>
<thead>
<tr>
<th>Planning Tool</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agenda</td>
<td>Create a list of agenda topics with an optional start date and time. The agenda organizer and any collaborators can add topics to be discussed at the meeting, and set time duration for each topic. Agendas can be attached to events.</td>
</tr>
<tr>
<td>Task</td>
<td>Keeps track of your work. You can also assign tasks to other users to coordinate team collaboration. Tasks can either be personal tasks or tasks associated with a project.</td>
</tr>
<tr>
<td>Timeline</td>
<td>Use to plan major milestones by weeks or months in advance, and display them as a concise list or a timeline.</td>
</tr>
</tbody>
</table>

To see all the planning tools in a group, click Content from the navigation menu, select the Create dropdown menu, and then select Planning Tools.

To create an agenda

1. From the Content section, click the Create drop-down menu and select Planning Tools > Agenda.
2. In the New Agenda light box, enter a title. The Title can indicate what the agenda is for (e.g., meeting, planning session). Click Create.
3. A single item view of the agenda displays. Beside date and time, click the not set link to select the start date and time (optional) and then click OK.
4. Click Add New Agenda Topic. Complete the following fields:
   - Topic: Enter an agenda topic. This field is required.
   - Topic Presenter: Enter the group member’s name.
   - Topic Duration: Enter the amount of time required for the topic. Time increments are pre-set.
   - Details: Describe what the topic is about or add important points here.
5. Click Add to add the new topic to the agenda.
6. Repeat the previous steps by clicking Add New Agenda Topic to add more topics.
7. To edit any topic, click on the topic. If you want to delete a topic, click the Trash icon.
8. If you want to re-arrange the order of the agenda, click, drag, and drop the topics in the preferred order. Whenever you make a change to the agenda, a feed item is also created for the change. To help track changes on agenda items, feed entries include topic title, topic details, duration and presenter information. Topic titles are also clickable hyperlinks that return you to the exact row in the full agenda.

To create a task

1. From the Content section, click the Create dropdown menu and select Planning Tools > Task.
2. The Add Task page displays. In the + field, enter a name for the task.
3. A single item view of the agenda displays. Click Setup the Agenda to enter the start date and time and then click Add.
4. In the Add Assignee section, by default, your name is already added. You can click the x beside your name to remove it if the task does not apply to you. Otherwise, click Add Assignee to assign the task to other group members.
5. Enter a description for the task.
6. Click the Date field to specify a due date.
7. Choose a priority (i.e., Low, Medium, or High).
8. If you need to attach an existing content item or upload one from your local drive, click Attach More Content.
9. You can click Add Tags to tag the task and make it easier for others to find when they perform a search.
10. Click Invite Follower if you want to include group members without assigning the task to them.
11. Click Add Task. Group members will receive a notification via their Task icon on the global menu bar.

If you need to edit the task, from the navigation menu, click Tasks. You can search for your task by task name.

For more information on group tasks, see the Tasks [page 159] topic.

To create a timeline

1. From the Content section, click the Create drop-down menu and select Planning Tools > Timeline.
2. In the New Timeline light box, enter a title. The Title can provide the name of the project that the timeline is for. Click Create.
3. The timeline displays with today’s date. Click Add New Event to add an event to the timeline.
4. In the Add New Event light box, enter the following:
   ○ Title: Enter a name for the timeline event.
   ○ Description: Enter a description of the event.
   ○ Date: Choose a date from the pop-up calendar.
5. Repeat the previous steps until you have added all the events to the timeline.

If you need to edit a timeline event, hover your cursor over the event and click the Edit icon. To delete an event, hover over the event and click the Delete icon.

4.1.8 Audio and video management

Videos can be used to demonstrate ideas, concepts, instructions, and other important messages. In SAP Jam, you can create videos using a built-in video recording tool, or upload a video from another resource. You can also upload supported audio files or videos that only have audio.

As your video is added in SAP Jam, you can select a specific thumbnail for it to help others identify it visually amongst other content items. If the video is part of a series that you’d like to present, you can add the video to a playlist. Closed caption accessibility support is available in case you need to include a video text track (*.vtt) file.
4.1.8.1 Record a video by webcam or screen (non-WebRTC technology)

In SAP Jam, you can create videos using SAP Jam’s built-in screen capture tool or your computer’s webcam. With video, you can narrate a power point presentation, introduce a process, or record a conversation. The instructions for this topic are applicable to the Microsoft Internet browsers only. If you’re using Google Chrome or Mozilla Firefox, and your company administrator has enabled the WebRTC technology for webcam and screen recording option, please see the topic “Record a video (with WebRTC technology).”

**i Note**

For the Java Runtime Environment (JRE) version required to record a video, see System requirements [page 9].

To create a video with screen capture

1. Click the *Add a Video/Audio* icon on the post bar.
2. Choose *Click here to record a video*.

3. You’re immediately prompted to select one of the following:
   - *Click here to record a screen capture*: Take a video capture of what’s on your computer or device.
   - *Click here to record from a webcam*: Record a video using your computer’s webcam.

**i Note**

If your Java version is previous to the minimum requirements stated in the System requirements section of this user guide, you will need to update it before you continue.

4. Click *Run* when asked to run the Java Check Applet in order to use the recording feature.
5. If you choose the screen capture method, you can do the following:
   - When presented with the square recording frame, on the video navigation bar at the bottom, click the screen window drop-down menu to choose the area you wish to record. If you select “Manual”, you can click and drag the diagonal arrows on the bottom right corner to resize the window. Press *Enter* to save your size preference or *Esc* to cancel.
   - You can click and drag the recording frame to the area of the screen you want to record.
   - If you wish to record sound, make a selection from the device drop-down menu.
6. If you chose the webcam method, you can do the following:
   ○ When the system accesses your webcam, it will prompt you to set the Adobe Flash Player settings. You can click on each icon or accept the defaults and click Close.
   ○ To enable the system to begin using your webcam and microphone, click Allow.

7. You can follow these general instructions for both methods of recording:
   ○ When you are ready to record, or to continue recording after you’ve paused it, click the red dot icon.
   ○ When you want to pause the recording, click the double bar icon. On the left side of the navigation bar, below the length of recording the word “Paused” will display to confirm that the recording has paused.
   ○ Click the black square icon to stop recording.
   ○ Click the play icon to preview the recording.
   ○ Click Done if you are finished with the recording.
   ○ Click Record Again if you want to re-record the video.

8. Click Preview if you want to see what the video will look like before you post it.
9. Click Discard and Record Again if you’ve made an error and want to re-record.
10. Click Submit to post the video to your wall or group feed. Depending on the size of your video, the upload may need to time to process.
11. To change the title of your video, click the title and provide a name.
12. You can click Add Description to provide some context about your video.
Best practices

- Keep your videos short. Break longer videos into smaller sessions.
- Videos are more effective when they are shorter in duration and focus on a single topic.
- If possible, use a headset while recording to make sure your audio is clear.

4.1.8.2 Record a video by webcam or screen (with WebRTC technology)

WebRTC technology for webcam and screen recording allows you to work with videos in Mozilla Firefox and Google Chrome. When this option is enabled by your company administrator, it produces a compatibility checklist for audio and browser extension requirements.

i Note

Audio support for screen recordings on Google Chrome is currently unavailable.

To create a video with screen capture

1. Click the Add a Video/Audio icon on the post bar.
2. Choose Click here to record a video.
3. Choose Click here to record a screen capture.
4. If you see an ! icon, you will need to review compatibility requirements for your browser.

5. Click Get Browser Extension if the hyperlink appears.
6. Steps for Google Chrome:
   ○ On the Add Screen Recording for SAP Jam prompt, click Add extension to add the extension for screen recording.
   ○ On the Share your screen dialog box, you can select what you want to share from Your Entire Screen or any of the open applications on your desktop in the Application Window tab. Click Share to begin the immediate recording of your screen.
7. Steps for Mozilla Firefox:
   ○ Click Allow on the dialog box prompt.
   ○ Click Install to install the screen recorder add-on. A message will display to confirm successful installation before closing on its own. Click the Add a Video/Audio icon again.
   ○ A dialog box prompts you to choose which window and microphone to share. Click Share Selected Items to begin the immediate recording of your screen.

8. When you are ready to end the recording, click Stop Recording.

9. The Choose a folder to upload to dialog box displays. Navigate to the preferred folder where you want to save the recording and then click Select Folder. If you don’t want to save the recording and post it to the group, click Cancel.

10. After you’ve entered the text to introduce the screen recording you want to share in your group, click Share.

11. The shared recording immediately appears in a single item view. Here, you can change the video title to something more meaningful. The feed update where you shared the recording will update instantly with the new name.

### To create a video with the webcam

1. Click the Add a Video/Audio icon on the post bar.
2. Choose Click here to record a video.
3. Choose Click here to record from webcam.
4. If you see an ! icon, you will need to review compatibility requirements for your browser.
5. Select the camera and microphone that you want to use for the recording if prompted.
6. You can adjust the screen recording dimension to use full screen.

7. When you are ready to begin the recording, click the Start button.
8. When you are ready to stop the recording, click the **Stop** button.

**Note**
The pause function is currently unavailable.

9. The Choose a folder to upload to dialog box displays. Navigate to the preferred folder where you want to save the recording and then click **Select Folder**. If you don’t want to save the recording and post it to the group, click **Cancel**.

10. After you’ve entered the text to introduce the webcam recording you want to share in your group, click **Share**.

11. The shared recording immediately appears in a single item view. Here, you can change the video title to something more meaningful. The feed update where you shared the recording will update instantly with the new name.
4.1.8.3 Upload supported audio and video files

Videos can be used by learning practitioners as a time-saving, learning tool to support users in their learning environment. Audio files (e.g., for podcasts) are another content alternative for facilitating information delivery or learning. Like videos, audio files can be added to a playlist and have a looped playback.

Accepted Audio File Formats

You can upload the following audio file formats to SAP Jam:

- *.wav
- *.mp2
- *.mp3
- *.m4a
- *.wma
- *.aac
- *.flac
- *.ogg

Accepted Video File Formats for non WebRTC technology

You can upload the following video file formats to SAP Jam:

- ASF
- AVI: All supported formats
- Avid: QuickTime ABVB, QuickTime Meridien, AVI Meridien, OMF ABVB, OMF Meridien, OMF DV50, DS High Definition
- DirectShow: All supported formats
- FLV
- Grass Valley: GXF MPEG-2
- Leitch: MPEG-2, DV25
- Media 100: Square, 601
- MPEG-1: Elementary Stream, System Stream, Layer II Audio
- MPEG-2: SP@ML, MP@LL, MP@ML Elementary Stream SP@ML, MP@LL, MP@ML, HP@HL 4:2:0 Program Stream 4:2:2P@ML, HP@HL 4:2:2 Program Stream SP@ML, MP@LL, MP@ML, MP@HL, HP@HL 4:2:0 Transport Stream 4:2:2P@ML, HP@HL 4:2:2 Transport Stream Layer II Audio, AC3 Audio
• MPEG-4: ISMA, 3GPP, 3GPP2
• MXF
• Omneon: MPEG-2
• Pinnacle: MediaStream
• QuickTime: All supported formats
• Quantel: Clipnet MPEG-2
• SeaChange: MPEG-2, SAF, 4:2:0, 4:2:2, Layer II Audio
• Sony: IMX 4:2:2, MXF D-T10, VSR2000 High Definition MPEG-2 VOB WAV
• Windows Media 8 and 9

**i Note**

The original file that you upload will be automatically convert to the MP4 format before it’s stored in SAP Jam. Therefore, when you download the file, it will download as an MP4 and not the original source that you uploaded. While the SAP Jam video player uses HTML5 to playback the video, the downloaded file is not automatically rendered, and will require a local video player to play offline.

**Accepted Video File Formats for WebRTC technology**

VP8 video file format is supported for Google Chrome and Mozilla Firefox browsers on WebRTC.

**Video and audio Codec support**

HEVC(H265), VP9, and OPUS codecs are supported for audio and video file uploads.

**Recommended Video Encoding**

<table>
<thead>
<tr>
<th>Video Quality</th>
<th>Resolution</th>
<th>Video Encoding</th>
<th>Video Bitrate</th>
<th>Audio Encoding</th>
<th>Audio Bitrate</th>
<th>Screen Ratio</th>
</tr>
</thead>
<tbody>
<tr>
<td>Low</td>
<td>480p</td>
<td>MPEG-4, H.264</td>
<td>2.5 Mbps</td>
<td>AAC-LC</td>
<td>384 Kbps</td>
<td>16:9</td>
</tr>
<tr>
<td>Medium</td>
<td>720p</td>
<td>MPEG-4, H.264</td>
<td>5 Mbps</td>
<td>AAC-LC</td>
<td>384 Kbps</td>
<td>16:9</td>
</tr>
<tr>
<td>High</td>
<td>1080p</td>
<td>MPEG-4, H.264</td>
<td>8 Mbps</td>
<td>AAC-LC</td>
<td>384 Kbps</td>
<td>16:9</td>
</tr>
</tbody>
</table>
4.1.8.4 Thumbnail images

When you create or upload a video, you can customize the thumbnail image that appears when the video displays in widgets, playlists, single item view, feed posts, and in the SAP Jam mobile app.

Video thumbnails

To select a video thumbnail image

1. Go to the single item view of your video file.
2. Choose Video Manager > Thumbnails.
3. Five thumbnail images will be automatically chosen from frames within your video. You can also upload a new image and then crop, zoom, or pan the image if necessary. Click one of the images and then click Save.

When the new thumbnail image is used, it is immediately reflected in the video’s single item view, multimedia widget, and feed update.

As the video thumbnail is bundled with the video, together they are subject as a single item to content approval, if configured. For example, if the thumbnail is changed, the video and thumbnail together are subject again to content approval.

4.1.8.5 Play files

When you play an audio or video file, on its own or in a playlist, you have the option to use a replay feature to play it again. You can also control how slow or fast the video plays.

Replay an audio or video file

To replay

1. At anytime while the video or audio file plays, click the playback icon at the bottom of the video. When the file is finished playing, it will replay automatically.

To stop the replay, click the playback icon so that it’s no longer highlighted.

Adjust playing speed

To manage how fast the video or audio file is playing

1. Play the video and then click through the slow and fast speed arrows at the bottom of the video to choose one of the following: 0.5, 0.75, 1.25, 1.5, 1.75, and 2.0 times the normal speed.
4.1.8.6 Annotations

Annotations allow you to point out areas of interest in a video, or insert special reminders and messages. You can annotate time frames within a video to provide extra information to the audience at a specific point in the video, or throughout its entire duration. The Video Manager annotation editor allows you to enter the text, specify the font size, font color, background color, and left or right text alignment.

Annotate a video

To annotate a video

1. Go to the video file in single item view.
2. Choose Video Manager > Annotations.
3. Click + Annotation.
4. Enter the annotation message in the text editor. From the text editor toolbar, you can select a font size, text color, background color, and display of text from left to right or right to left. On the video, a text box displays with the annotation. You can click and drag this text box and place it in the desired location.
5. Enter the start time and end time for the annotation to display.
6. If you want the annotation to be hyperlinked to a URL, click the Link checkbox.
7. Click Save when you’re finished. A list of saved annotations appears below the video.

Edit or delete an annotation

To edit or delete a single annotation

1. Go to the Annotations list for the video and select Edit or Delete.

To delete multiple annotations

1. Select the checkbox beside the annotations you want to delete and then click Delete selected items.
2. Or, if you want to delete all annotations, click the checkbox beside the Annotation column label. This will select all the annotations. Then click Delete selected items.

4.1.8.7 Closed captions

Closed captioning for videos supports 508 accessibility requirements. You can upload a track file to SAP Jam and specify the language for the video. The captions will display near the bottom of the video.

Upload and apply closed captions

To upload and apply closed captions to your video
1. Go to your video in single item view and choose Video Manager > Closed Captioning.
2. Click Upload Closed Captioning to drag and drop or upload a video text track file (*.vtt).
3. Select the language from the drop-down list and then click OK.

As the video plays, from the bottom right toolbar, the captions can be turned on or off, and the language can be selected. When you select a particular language, SAP Jam will remember your selection as you play other videos.

When you download the video, the .vtt file also downloads.

4.1.8.8 Playlists

When you want to create a sequence of videos or audio files that play one after the other, or simply provide a selection of related videos and/or other multimedia, you can add the collection of files to a playlist. Audio and video files can be included in more than one playlist.

Create a playlist

To create a playlist of audio and video files
1. Go to the group content folder where you want to save the playlist.
2. Choose Create > Multimedia > Playlist.
3. In the Create Multimedia Playlist lightbox, enter a name for your playlist.
4. From the Select Multimedia tab, choose the videos and audio files that you want to include in the playlist.
5. If you want to include YouTube, Vimeo, or other SAP Jam videos that are outside of your group, click the Add Links to Multimedia tab and add the hyperlinks.
6. Click OK when done to save your playlist.
7. To make the playlist available to the group, click Publish.

To make the playlist more prominent, page designers can include playlists within Multimedia widgets.

Manage playlist

You can manage your playlist by featuring it, changing the permissions, moving and deleting it, or editing the content of the playlist.

To manage your playlist
1. Go to the group content folder where you saved your playlist.
2. Click the playlist to open it in single item view.
3. From the More drop-down menu, you can access the Feature, Edit Permissions, Move, and Delete options.
4. To edit the playlist, click Edit. On the Manage Playlist page, you can add more multimedia files to the playlist, rename, and delete multimedia files from the playlist. When you are finished with your changes, click Publish.
You can also re-order the files in your playlist by dragging and dropping the files into the order you want them to play.

**Autoplay and navigation**

You can set a playlist to play a single or all videos in sequential order by selecting the autoplay option below the playlist. If you want to go to the previous or next file in the playlist, click the arrows also below the playlist.

### 4.1.8.9  Download video

When downloading a video, you can choose to include any video captions. If you include captions, the video is downloaded in a zip file that includes the mp4 video file and the vtt caption file.

### 4.1.9  Blog posts

You can write a blog post to share ideas and thoughts that are longer than what status updates can accommodate. Typically shorter than a wiki page, a blog post can contain up to 65536 characters.

Blogs are a means for you to:

- Post your view or thoughts on a specific topic.
- Publish regular news and updates.
- Evaluate and summarize events or projects for your team.

Your followers or fellow group members can provide feedback by commenting on your post.

To see all the blog posts in a group, click **Content** in the left navigation menu and select **Filtered by: Blog Posts**.

**j Note**

- If you click to edit a blog while someone else is working on it, you will need to choose to continue or cancel. If you continue, a new draft of the blog is created.
- Blog posts can only be modified by the blog post’s creator or a group administrator.

The [rich text editor](page 104) contains a word processing format toolbar, various widgets that you can click on to insert within the blog, the ability to @mention someone, and hashtags. As you write your blog, you can choose to save draft versions before you publish it to the group. This allows you time to proofread or make edits. However, if you publish your blog and then notice something that you would like to change, you can always edit it after it’s been published and then re-publish it as a new version when you’re ready.
Designated authors

If you need to make content available for your blog post but cannot publish it (e.g., because you are unavailable, on vacation, short on time etc.) and have staff or colleagues that can compose messaging and other content for you as ghostwriters, then you can designate others to write blog posts on your behalf. Although the other person can edit and publish your blog post, your name is shown as the content creator.

**i Note**

Company administrators can enable or disable the ability for a ghostwriter to blog on behalf of another group member.

To designate someone else to blog on your behalf

1. Above the global menu bar in SAP Jam, click the cog icon and choose *Account Settings*.
2. Click *Designate Author*.
3. On the Designate Author page, enter the name, email address, or member list of the person or people you wish to designate as your blog editors and publishers.

When group administrators, content owners, or content approvers review a blog post or view the published blog post, they are able to see both the name of the ghost writer and the name of the person they are writing on behalf of. When non-group administrators and non-blog post approver group members view a published blog post, the name of the group member that the blog post is written on behalf always displays as the author; the name of the ghost writer never displays to group members once the blog post is published.

You can print blog posts by clicking *Print* from the toolbar above the blog post. The thumbnail image (if any), title, last updated by, and blog post content are including in the printed output.

4.1.10 Wiki pages

You can create wiki content and share it on a group feed or your own profile wall.

When others view your wiki, they can choose to follow it so that they see immediate feed activity whenever you update it or another user posts a comment on it.

Wikis can include different types of text, tables, pictures, or video content. In addition, you can attach any type of file to a wiki page or insert a dynamic widget. Users can assign existing tags to a wiki page or create their own ones.

Wiki pages can be edited in a draft mode to be published and made available to others later. In draft mode, a wiki page is only available to its creator. A version history of each document is available and older versions can be restored at any time.

Permissions

The following table lists all the actions that can be performed on wikis, and which group members can perform them based on collaboration level.
**Wiki permissions**

<table>
<thead>
<tr>
<th>Actions</th>
<th>Read-only</th>
<th>Limited</th>
<th>Full</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Tags</td>
<td>Everyone</td>
<td>Everyone</td>
<td>Everyone</td>
</tr>
<tr>
<td>Add Task</td>
<td>Everyone</td>
<td>Everyone</td>
<td>Everyone</td>
</tr>
<tr>
<td>Bookmark</td>
<td>Everyone</td>
<td>Everyone</td>
<td>Everyone</td>
</tr>
<tr>
<td>Comment</td>
<td>Everyone</td>
<td>Everyone</td>
<td>Everyone</td>
</tr>
<tr>
<td>Copy</td>
<td>Group administrator and owner</td>
<td>Everyone</td>
<td>Everyone</td>
</tr>
<tr>
<td>Delete</td>
<td>Group administrator and owner</td>
<td>Group administrator and owner</td>
<td>Everyone</td>
</tr>
<tr>
<td>Edit</td>
<td>Group administrator and owner</td>
<td>Group administrator and owner</td>
<td>Everyone</td>
</tr>
<tr>
<td>Edit permissions</td>
<td>Group administrator and owner</td>
<td>Group administrator and owner</td>
<td>Group administrator and owner</td>
</tr>
<tr>
<td>Edit publish settings</td>
<td>Group administrator and owner</td>
<td>Group administrator and owner</td>
<td>Group administrator and owner</td>
</tr>
<tr>
<td>Feature</td>
<td>Group administrator</td>
<td>Group administrator</td>
<td>Group administrator</td>
</tr>
<tr>
<td>Like</td>
<td>Everyone</td>
<td>Everyone</td>
<td>Everyone</td>
</tr>
<tr>
<td>Mark as inappropriate</td>
<td>Everyone</td>
<td>Everyone</td>
<td>Everyone</td>
</tr>
<tr>
<td>Mirror</td>
<td>Group administrator and owner*</td>
<td>Group administrator and owner*</td>
<td>Group administrator and owner*</td>
</tr>
<tr>
<td>Move</td>
<td>Group administrator and owner</td>
<td>Group administrator and owner</td>
<td>Everyone</td>
</tr>
<tr>
<td>Mute</td>
<td>No one</td>
<td>No one</td>
<td>No one</td>
</tr>
<tr>
<td>Rename</td>
<td>Group administrator and owner</td>
<td>Group administrator and owner</td>
<td>Everyone</td>
</tr>
<tr>
<td>View</td>
<td>Group administrator and owner</td>
<td>Everyone</td>
<td>Everyone</td>
</tr>
</tbody>
</table>
4.1.10.1 Create a wiki page

You can use the wiki editor to create a repository of information to be shared with a group or for your own use.

To use the wiki editor

1. Navigate to the group where you want to create a wiki page and click Content from the navigation menu. You will be directed to an overview of all content items that have been created in the group.
2. Click the Create dropdown menu and choose Wiki Page. The Add a Wiki Page page appears.
3. Enter a title in the Title box.
4. Enter your content in the content editor. As you begin to type, a draft of your wiki is automatically saved.
5. Select one of the following options:
   - Save Draft: This action saves a draft of your wiki, but does not publish it. The message, "This wiki is a draft and has not been published yet" displays in a light box. You can choose to Publish, Edit, or Delete Draft from this view. The draft is saved in the Drafts section of Content until it is published and is only visible to the group author.
   - Publish: This action saves your wiki and publishes it. You can choose to allow it to display in a feed update, or turn off the Show in Feed Updates option if you do not need to share this update.
6. Set the permissions for your wiki (i.e., full, limited, or visible only to you and group administrators).
7. Click Publish to confirm your choice and to publish the wiki page.

Once the wiki page is created, the wiki content appears in a light box. You can click Edit on this page if you want to return to your wiki and make changes.

i Note

If you click to edit a wiki while someone else is working on it, you will need to choose to continue or cancel. If you continue, a new draft of the wiki is created.

4.1.10.2 Exclusive edits to a wiki page

When a wiki page is being edited by another user, as you are viewing that same wiki you will see a banner notification in real-time that states the name of the user who is editing the wiki and how long the wiki page has been in edit mode. You can click Request to Edit if you need to make edits.

The request can be sent to the content owner or group administrators. They can either discard the check out or check in the wiki page; both actions free the wiki page for your opportunity to edit. A real time notification displays in a banner about the discarded check out or check in while viewing the wiki page.
Surfrider Initiative - day of volunteer action

Ursula Chan started editing this wiki page (about 6 months ago). If you want to overwrite, click Request to Edit.

Click Request to Edit for wiki page

Request to Edit Wiki Page

Send to: Ursula Chan

Ursula Chan is already editing this wiki page and may have made changes. Do you want to send a request to publish?

Enter reason for requesting to edit (required). Ursula Chan will be notified.

Click the dropdown to select wiki page author or group administrator(s)

Send to: Ursula Chan

Group Admins

Select the request recipient and enter a reason for requesting the edit

When you edit a wiki page, it is implicitly check out for your edits. A banner notification at the top of the page will indicate how long you have been working on it in edit mode. When you publish a wiki page, it is then implicitly checked in.
4.1.11 Images for blog posts, knowledge base articles, and wiki pages

For ease of creating content in wikis and blogs, you can copy and paste images into the published or saved draft versions of wiki and blogs from sources such as email, Microsoft Word, and clipboard applications.

When you copy and paste or upload images from your computer to a wiki page, knowledge base article, or blog post, the image itself is not added as a separate file under the Content section. It is “bundled” as part of the wiki page or blog post. The image cannot be searched or browsed for independently of the wiki page or blog post, and it does not generate a separate feed item.

You can copy and paste to upload images into question, idea, and discussion comments at a first or second reply level for a forum post. You can also copy and paste to upload images when creating or editing a knowledge base article.

When you mirror a wiki page that contains images, the image is also mirrored.

The maximum resolution for embedded images is 1200 x 1200 pixels.

Internet browser requirements

Image pasting from the following browsers are supported:

- Microsoft Internet Explorer 11 and higher
  - Under Trusted Sites Zone security settings for Internet Explorer, ensure that "Allow Programmatic clipboard access" is enabled or set to ‘Prompt’.
- Google Chrome

4.1.12 Rich text editor

When creating knowledge base articles, wiki pages, and blog posts, you can use many enhanced functions on the toolbar of the rich text editor. You can hover your cursor over each toolbar action to reveal the button name. A subset of these functions are also available for the text widget.

As of the February 2018 release, please note the following updates when using a rich text editor in wiki pages, blog posts, and forum topic full screens:

- **Edit** menu includes Undo, Redo, Cut, Copy, Paste, Paste as text, Select all, and Find and replace actions, most with shortcut keys.
- **View** menu includes Source code, Visual aids, Show invisible characters, and Show blocks actions.
- **Insert** menu includes Table, Special character, Horizontal line, and Date/time actions.
- **Format** menu includes Bold, Italic, Underline, Strikethrough, Superscript, Subscript, Code, Blocks, Align, and Clear formatting actions.
- **Table** menu includes Table, Table properties, Delete table, Row, Column, and Cell actions.

With the addition of these new menus, the quick access toolbar buttons for Superscript, Subscript, Horizontal line, Block quote, Clear formatting, Insert date/time, Special character, Find and replace, Show blocks, and Show invisible characters have been removed.
<table>
<thead>
<tr>
<th>Toolbar button or Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Paragraph button" /></td>
<td>Apply preset headings to text</td>
</tr>
<tr>
<td><img src="image2.png" alt="Font Family" /></td>
<td>Default text is set to Arial; choose from 32 font styles in the drop down list</td>
</tr>
<tr>
<td><img src="image3.png" alt="Font Sizes" /></td>
<td>Choose a preset font size or enter a custom size</td>
</tr>
<tr>
<td>Bold</td>
<td>Use for emphasis</td>
</tr>
<tr>
<td>Italic</td>
<td>Use for emphasis</td>
</tr>
<tr>
<td>Underline</td>
<td>Use for emphasis</td>
</tr>
<tr>
<td>Strikethrough</td>
<td>Text displays, crossed out</td>
</tr>
<tr>
<td>Toolbar button or Menu Item</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td></td>
<td>Choose a text color from the palette or create your custom palette</td>
</tr>
<tr>
<td></td>
<td>Choose a background color from the palette or create your own palette</td>
</tr>
<tr>
<td></td>
<td>Apply bullets to an unordered list</td>
</tr>
<tr>
<td></td>
<td>Apply numbered lists styles which include Lower Alpha, Lower Greek, Lower Roman, Upper Alpha, and Upper Roman</td>
</tr>
</tbody>
</table>

**Note**

When you copy and paste one bulleted or numbered list to another list, the lists will merge into one rather than forming a nested list.
<table>
<thead>
<tr>
<th>Toolbar button or Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Justify</td>
<td>Text alignment</td>
</tr>
<tr>
<td>Decrease indent</td>
<td>Use as a forward tab to move text start position</td>
</tr>
<tr>
<td>Increase indent</td>
<td>Use as a backward tab to move text start position</td>
</tr>
<tr>
<td>Check spelling</td>
<td>Indicates possible spelling errors by inserting red underline. Right-click on the mispelled word to see a suggested spelling.</td>
</tr>
<tr>
<td>Undo</td>
<td>Undo the last action</td>
</tr>
<tr>
<td>Redo</td>
<td>Redo the action prior to the undo</td>
</tr>
<tr>
<td>Table</td>
<td>Various functions; see next table section</td>
</tr>
<tr>
<td>Superscript</td>
<td>Insert small text above the line</td>
</tr>
<tr>
<td>Subscript</td>
<td>Insert small text below the line</td>
</tr>
<tr>
<td>Horizontal line</td>
<td>Insert a horizontal line that spans the width of the blog page</td>
</tr>
<tr>
<td>Blockquote</td>
<td>Quoted section</td>
</tr>
<tr>
<td>Clear formatting</td>
<td>Remove applied formatting and reset to default</td>
</tr>
</tbody>
</table>

Inserts date and time

Choose from a palette of special characters

Find a word or phrase and replace one instance or all instances.
<table>
<thead>
<tr>
<th>Toolbar button or Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show blocks</td>
<td>Show block level elements in an outline</td>
</tr>
<tr>
<td>Show invisible characters</td>
<td>Reveals hidden characters (e.g., hard returns)</td>
</tr>
<tr>
<td></td>
<td>Show HTML source code</td>
</tr>
<tr>
<td>Left-to-right</td>
<td>Text defaults to start cursor from the left side of the screen</td>
</tr>
<tr>
<td>Right-to-left</td>
<td>Move text to start from the right side of the screen; appropriate for Right-to-Left languages such as Arabic and Hebrew</td>
</tr>
<tr>
<td>Link</td>
<td>Insert a link to other wikis, blogs and documents, a new document from your local drive, forum topics, groups, external URLs, and people</td>
</tr>
<tr>
<td>Image</td>
<td>Upload from computer, choose existing content, or insert photo from URL</td>
</tr>
<tr>
<td>Video or Audio</td>
<td>Insert video by pasting a URL or embedding code</td>
</tr>
<tr>
<td>Table of Contents</td>
<td>At cursor position, insert a hyperlinked table of contents that is formatted from up to six existing heading levels. As you add more information to your wiki pages, knowledge base articles, and blog posts with more headings, you can update your Table of Contents by clicking the Update button that appears below the inserted table of contents in Edit mode.</td>
</tr>
</tbody>
</table>

When working with tables, you can use a floating toolbar that allows you to work with table properties, insert rows and columns, and delete rows and columns more conveniently. Click and drag to resize individual rows and columns.

Right-click anywhere inside the text editor to access the internet browser's default right-click context menu.
### Table menu item

<table>
<thead>
<tr>
<th>Table menu item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Insert Table" /></td>
<td>Create a table by moving cursor across for columns and then down for number of rows</td>
</tr>
<tr>
<td><strong>Cell &gt; Cell properties</strong></td>
<td>Set width, height, cell type, scope, horizontal and vertical alignment, style, border color, and background color</td>
</tr>
<tr>
<td><strong>Cell &gt; Merge cells</strong></td>
<td>Select which column and row cells to merge</td>
</tr>
<tr>
<td><strong>Cell &gt; Split cell</strong></td>
<td>Splits current cell</td>
</tr>
<tr>
<td><strong>Row &gt; Insert row before</strong></td>
<td>Place new row above current row</td>
</tr>
<tr>
<td><strong>Row &gt; Insert row after</strong></td>
<td>Place new row below current row</td>
</tr>
<tr>
<td><strong>Row &gt; Delete row</strong></td>
<td>Delete current row</td>
</tr>
<tr>
<td><strong>Row &gt; Row properties</strong></td>
<td>Set row type, alignment, height, style, border color, and background color</td>
</tr>
<tr>
<td><strong>Row &gt; Cut row</strong></td>
<td>Cut current row</td>
</tr>
<tr>
<td><strong>Row &gt; Copy row</strong></td>
<td>Copy current row</td>
</tr>
<tr>
<td><strong>Row &gt; Paste row before</strong></td>
<td>Paste row above current row</td>
</tr>
<tr>
<td><strong>Row &gt; Paste row after</strong></td>
<td>Paste row below current row</td>
</tr>
<tr>
<td><strong>Column &gt; Insert column before</strong></td>
<td>Insert column before current column</td>
</tr>
<tr>
<td><strong>Column &gt; Insert column after</strong></td>
<td>Insert column after current column</td>
</tr>
<tr>
<td><strong>Column &gt; Delete column</strong></td>
<td>Delete entire current column</td>
</tr>
<tr>
<td><strong>Delete table</strong></td>
<td>Delete entire table</td>
</tr>
</tbody>
</table>

### 4.1.13 Thumbnail images for wikis and blogs

Thumbnail images appear in the content and multimedia widgets for group overview and custom home pages, the recommendations widget on the custom home page, in feed posts and replies, single item view,
recommendations page, recommendations tile on the regular non-custom home page, video playlists, and in the mobile app. When you create a wiki page or blog post, a default thumbnail is automatically created for it. Anyone with edit permissions for wiki pages and blog posts can customize the thumbnail.

If the wiki page or blog post is submitted through a content approval process, the approver can review the content and the thumbnail image together.

**i Note**

If the thumbnail image is sourced from existing group content, and changes are made to the image, the thumbnail image will not be updated. Thumbnail images that are uploaded from your computer are not saved to the group content folder.

SAP Jam accepts thumbnail images of any dimensions and resolutions for wiki pages and blog posts. Thumbnails optimally display in a 16x9 (widescreen format) on the home page, overview page, and feeds. If the image you supply is not already in a 16x9 format, SAP Jam will crop the bottom of the image to make it fit. For example, if your image is a 4x3 format, you will lose a small portion at the bottom of the thumbnail. If your image is portrait or tall in nature, you will lose a majority of the bottom portion in the thumbnail. SAP Jam always preserves the image aspect ratio, so your image is never stretched or compressed.

The thumbnail image can be rotated left or right, and zoomed in or out before applying it to the wiki page or a blog post.

When saving a draft version of the wiki page or blog post, the thumbnail is also saved.

If the wiki page, blog post, or thumbnail image is changed after it's been published, the content item and image are both submitted together to the content approval queue.

**Add a wiki page or blog post thumbnail image prior to publishing**

**To add a wiki page or blog post thumbnail image**

1. As you write the blog post or wiki page, go to the empty thumbnail and click **Choose a Thumbnail**.
2. Select an image from the group content folder or upload a new image and then click **OK**.
3. Click **Save** to save the new thumbnail.

**Edit a wiki page or blog post thumbnail image**

**To edit a wiki page or blog post thumbnail image**

1. Go to the single item view of the blog post or wiki page.
2. Choose **More > Edit Thumbnail**.
3. In the Edit Thumbnail lightbox, click **Choose a Thumbnail**.
4. Select an image from the group content folder or upload a new image and then click **OK**.
5. Click **Save** to save the new thumbnail.

If you want to delete the thumbnail and revert to the default image, at step 3 above, click the **Trash** icon and then save the thumbnail.
4.1.14 Edit wiki pages and blog posts

In SAP Jam, you can modify the content, formatting, and layout of a wiki page or blog post (including those which use pre-designed content templates) using the provided rich text editor.

**Note**

The wiki editor for group overview pages has been deprecated. For those who previously used the wiki editor to design group overview pages, a new message now invites users to start working with page designer.

The following options are available to you on the rich text editor:

- Format
- Font Family
- Font Size
- Bold, Italic, Underline, and strike-through formatting
- Text color
- Background color
- Alignment
- Bulleted and numbered lists
- Indentation
- Check spelling
- Insert and edit tables
- Superscript and subscript
- Horizontal line
- Blockquote
- Clear formatting
- Insert date and time
- Special character
- Find and replace
- Show blocks and show invisible characters
- Display text left to right and right to left
- Insert links to content, new documents, forums, groups, URLs, and people
- Insert images: Embed an image, upload a new photo, or insert an existing photo from your SAP Jam network.

**Wiki Editing**

When editing a wiki, there are two different options for saving your edits: Save Draft and Publish. If published as a major change, it will post an update to the group feed or your profile wall, depending on the wiki location, with an option to include a description about the edits. Drafts and minor versions of your published wiki are not posted to the group feed or profile wall.

While you edit your wiki, your changes are automatically saved as a draft.
4.1.15 Knowledge base articles

Knowledge base authors can now create knowledge base articles as part of Employee Support for their groups. This allows group members to receive immediate answers, save time and improve productivity. It can help to reduce service tickets sent to support staff and provides service agents with easy access to a knowledge base that improves resolution rates.

Create a knowledge base article

If the Knowledge Base feature has been enabled for your company, you’ll see Knowledge Base in the navigation menu for your group. Here, you can view a list of knowledge base articles or create a new one. You can @mention others and comment on knowledge base articles.

To create a knowledge base article

1. Click Knowledge Base from the navigation menu for your group.
2. Click + Knowledge Base Article at the top of the Knowledge Base articles listing.
3. On the Create Knowledge Base Article dialog, choose from one of the following templates:
   - Topic Page: Enter a title, a brief overview of the topic, the details, any additional information, and attachments to this type of article.
   - How-to: Enter a title, brief description, step-by-step instructions, and additional information, and attachments to this type of article.
   - FAQ: Enter a title and up to 10 questions with answers.
   - Problem Resolution: Enter symptoms, the environment, causes, resolution, and select an impact level; intended to support service delivery scenarios.
4. Click **Create**.
5. Enter a title in the Title text box.
6. Fill in the remaining text boxes for the chosen template as needed.

**i Note**

Templates cannot be edited or deleted.

7. To add an attachment, click **Add Attachment** at the bottom of the article. You can attach existing content from the group or upload a new file. While you cannot attach a mirrored item to your article, you can insert a link to it.

8. To the left of your article, you can choose up to 50 applicable categories, making it easier for others to find it when they do a search. Categories can be selected before or after you create the article. Once published, the list of categories that the article belongs to displays on the right side of the article in single item view. Your company administrator is responsible for creating the categories, up to a maximum of 150 per hierarchy level.
From the group level list view of the Knowledge Base section, you can filter the display of published knowledge base articles by category from the Showing drop-down list.

9. Once your article is complete, click Publish. You can choose the publishing and expiration dates for your article to help ensure timeliness and relevance of the article. And you can also set group member permissions for knowledge base article access: Full, Limited, or Hidden access to control view and edit capabilities.

Depending on the configuration by the group administrator, the article may be subject to a content approval process. You’ll receive a notification when your article is approved or rejected.

10. If you want the article to generate a feed item once published, choose Major change and enter a comment about the article or version.

Save a draft

You can save a draft of the article you are writing, after you have at least provided a title for the article. The draft version is accessible in a Drafts section above the published articles. When you are ready to continue, you can edit the draft version of the article. When a draft exists, you can also publish or delete the draft if no longer relevant.

Copy a knowledge base article

You can copy a knowledge base article within the same group or another group you are a member of to create new articles similar to the existing ones.

When an article, based on a custom template, is copied over to another group, the knowledge base template is also copied over. By default, the template is disabled. Group administrators can enable the knowledge base template if its use is applicable for their group.

To copy an article

1. From the list of knowledge base articles on your group’s Knowledge Base page, click the drop-down on the far right of the article you want to copy and choose Copy.
2. Click OK on the confirmation dialog to proceed with the copy action.

Thumbnails

You can include a thumbnail image with your articles to help users visually identify content. They are included when knowledge base articles are copied, moved, or mirrored. If your group’s content approval is set up for
knowledge base articles, any changes to the thumbnail image will also be subject to the content approval workflow.

### Edit or delete a knowledge base article

Group administrators or knowledge base article authors can edit and delete any already published knowledge base articles. After articles are edited and are ready for re-publishing, they are submitted through the content approval process for approval, if configured. The article that is already published will remain available to group members and will display the version with the updates once changes are approved.

If a group’s collaboration level is set to Full and the knowledge base article permission is also set to Full, you as a non group administrator member of a group can delete an already published knowledge base article.

When a knowledge base template has been updated, those updates will be applied to existing articles only when the article is edited and saved. When you edit an article that is based on a template that has been revised, you will see a message shown at the top of the article that says "The template for this article has been modified and may cause the article to display differently".

**To edit a knowledge base article**

1. Click Knowledge Base from the navigation menu for your group, or click Knowledge Base on the global menu bar to view a list of all available knowledge base articles for groups that you are a member of.
2. Choose Edit from the drop-down menu beside the article.
3. Or, click on the article to open it in single item view and then click Edit.
4. Make your changes and then click Publish.

**To delete a knowledge base article**

1. Click Knowledge Base from the navigation menu for your group, or click Knowledge Base on the global menu bar to view a list of all available knowledge base articles for groups that you are a member of.
2. Choose Delete from the drop-down menu beside the article. Or, click on the article to open it in single item view and then click More Delete.

### Multiple language support

As a knowledge base author, group administrator, or translator, you can provide pre-translated content for an existing knowledge base article. You can add the translations to a bundle using the Languages [page 151] feature. Users will then automatically see the translated knowledge base article for their preferred language, if available.
A user can still see a default or "fallback" translation, even if their preferred translation is unavailable. For example, if a bundle contains English, French, and Spanish translations, and English is set to the default, a user with any other language preference will see the English version.

**Print**

To support offline requests for content, you can view a print preview and print a knowledge base article. You can also print to PDF to export the article to other third-party applications.

**Version history**

When you publish your article, the article receives a version number. Anytime the article is republished, the version number will increment by 1. The latest version of the article always displays in the knowledge base widget.

You can view the version history and individual versions for any knowledge base article.

![Version history for a knowledge base article](image)

**Revert to previous version**

When you view a previous version of your knowledge base article using the version history, you can also revert to a previous version by clicking *Revert to this version*.
Search for knowledge base articles

As a logged in employee, you can search knowledge base articles in private and public groups that you have access to using keywords. External users can also search for knowledge base articles in groups they have access to.

Knowledge base article search

When searching for knowledge base articles using the "All" or "Knowledge Base" filters on the global search bar, the search results may return articles from public groups that you may or may not have joined. The search results can include a readable list of articles.

When visiting the knowledge base landing page for a company, you will see a Search bar with advanced search capabilities and lists of recommended and recently updated articles to help you quickly access relevant information. Each tile includes the name of the article, the group the article was authored in, the name of the knowledge base author or who last updated it, when it was last updated, number of likes and views, a content rating, and any categories it may be assigned to. As you enter search criteria in the Search bar, auto complete suggestions will appear in a dropdown list.

You can expand the Advanced search area to search for knowledge base articles by author name, group name, hashtag, selected category, or time frame. When you click Select Category, you can choose up to 50 categories to help refine your search. Selected categories will display below the Filter button.

**Note**

When filtering by categories in a group’s Knowledge Base page, only the categories applied to the group’s articles will display in the filter.

There is a View All articles link at the bottom of the Recommended section so you can browse through all articles.
Recommended knowledge base articles

Recommended knowledge base articles display with configured thumbnail images and metadata such as the author name, the name of the group where the article originated, when it was last updated or published, number of likes, number of views, content rating, the names of categories it can be searched by, and a snippet of the knowledge base article. Recommendations are based on content you have recently viewed.

Submit feedback

You can provide quantitative feedback on a knowledge base article by selecting a one to five star rating to answer the question “How helpful was this knowledge base article?”

*Note*

If your company administrator disables the “Enable Content Rating” option in the SAP Jam Admin console, the ability to provide feedback will not be available.

The number of people who found an article useful also displays.

4.1.16 Manage content

When working with content, you can perform a variety of actions that help you maintain content items them and keep organized as their volume increases.

- Create all group members (public) or selected group members (private) accessible folders.
- Copy, manage mirror copies, move, tag, upload, download, rate, feature, and delete content.
- Apply different levels of permissions to content.
- Lock documents to indicate you are working on a version.
- Publish major and minor versions of documents such as wikis and blogs, or maintain them in a draft state until ready to publish.
- Add a task to accompany the content item.
- Like, comment, annotate, bookmark, and recommend content.
- Create filters or search alerts to help you find specific content.

4.1.16.1 Group folders

SAP Jam groups may work with a variety of information and file types. When you create folders, you can organize content items into collections to make it easier for group members to discover relevant information.
For example, you could create a folder for summaries of weekly meetings about an activity to make this information easier to find.

You can also create private folders for sharing with selected individuals, or to facilitate private collaboration. For example, a manager can create a private folder for each of her employees to do one-on-one mentoring and content sharing.

**i Note**

Private folders can only be created at the top level of the content section.

**To create a group folder**

1. Go to the Content section for the group.
2. On the **Create** drop-down menu, choose **New Folder**.
3. In the Add Folder dialog, enter a name for the folder.
4. Select where you want to add the folder (e.g., top level, within another existing folder).
5. Click **Create**. The new folder is added to the location you specified in the previous step.

**To create an access-restricted private folder**

1. On the **Create** drop-down menu, choose **Private Folder**.
2. In the Add Private Folder dialog, enter a name for the folder.
3. In the **Share access with** text box field, enter the names of the select members. You can share access with pending members; they will receive a new notification with an invitation to join the group with the private folder.
4. Click **Create**. The new folder is added to the top level of the Content section.

**i Note**

If you want to remove access from a selected member, or provide another member with folder access, go to the private folder and click **Edit Privacy**.

![Place cursor over author name to access Edit Privacy option](image)
Folder Privacy

Who has access (3)

- Perry Johnson (Group Admin)
- Julianne Beyer
- Marcus Hoff (Invited)

Share access with

Type a group member's name

Share access with group members, including those who are pending members due to a recent invitation

Note
When content is moved (e.g., from a private folder to a public folder, from a public folder to a private folder, from one public folder to another) within a group, the meta data remains unaffected.

4.1.16.2 Copy content

If you have content that needs to be copied to another folder or group, you can copy individual or several files and documents at once.

To copy content to a folder or other group

1. From the Content section, select the content you want to copy. Or open the content item in single item view.
2. On the top menu bar, choose More > Copy selected items to.
3. In the Copy To light box, select the appropriate group from the drop-down list.
4. Click the folder where you want to copy the content to. You can use the Filter by Title search field to search for the name of the folder. If you select the wrong folder, you can return to the top level and search again by clicking the breadcrumb link that appears above the list of folders.

5. Click Select Folder. An “Operation completed successfully message” will display at the top of the page.

**Note**
If you copy several content items simultaneously to another folder, the system will process those files in the background, allowing you to continue navigation through the SAP Jam web application.

### 4.1.16.3 Manage mirrored copies

When posting the same document to two or more places within a single group or many groups, as a content creator, you can choose to “mirror”, or make an identical copy of a single source content item (e.g., the original spreadsheet, presentation, image, video, wiki page, blog post, etc.). This saves you time especially when you need to make an update to the source content. Previously, you would need to update the source content (i.e., post a new version) and then re-post it to all the places and groups where the copies reside. Now, once a
content item is mirrored to other groups and folders, whenever you make an update to the source content, the updates are automatically applied to the mirrored copies.

**i Note**
- A content owner/creator is the original author of a document, wiki, or blog, or a member of the group who uploads the initial version of a document on behalf of the author. Starting with the February 2016 release, regardless of group participation level, only content owners could add a new mirror. This helped restrict ownership of source material and easily identify the original owner of a content item. Now with the August 2016 release, group administrators and content owners can modify mirror permissions by designating all or specific group members to be able to mirror content.
- Any documents that were mirrored prior to the February 2016 release, regardless of whether it was mirrored by a content owner or non content owner, are unaffected by the changes which restrict mirroring to content owners starting in this current release. Those mirrored documents will not be deleted.
- Mirroring is not supported for content stored in external repositories (e.g., Microsoft SharePoint, Alfresco One, SAP Document Center, etc.).

**Permissions**

The following table lists all the actions that can be performed on mirrored content items, and which group members can perform them based on collaboration level.

**i Note**
"Creator" refers to the document creator or member who mirrored the document. "No one" means that the action is not supported for mirrored documents.

### Mirrored document permissions

<table>
<thead>
<tr>
<th>Actions</th>
<th>Read-only</th>
<th>Limited</th>
<th>Full</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Tags</td>
<td>Everyone</td>
<td>Everyone</td>
<td>Everyone</td>
</tr>
<tr>
<td>Add Task</td>
<td>Everyone</td>
<td>Everyone</td>
<td>Everyone</td>
</tr>
<tr>
<td>Bookmark</td>
<td>Everyone</td>
<td>Everyone</td>
<td>Everyone</td>
</tr>
<tr>
<td>Check out</td>
<td>No one</td>
<td>No one</td>
<td>No one</td>
</tr>
<tr>
<td>Comment</td>
<td>Everyone</td>
<td>Everyone</td>
<td>Everyone</td>
</tr>
<tr>
<td>Copy</td>
<td>No one</td>
<td>No one</td>
<td>No one</td>
</tr>
<tr>
<td>Delete</td>
<td>Group administrator and creator</td>
<td>Group administrator and creator</td>
<td>Everyone</td>
</tr>
<tr>
<td>Download</td>
<td>Group administrator and creator</td>
<td>Everyone</td>
<td>Everyone</td>
</tr>
</tbody>
</table>
When a content owner or author mirrors a content item, the permission setting is also inherited by the mirrored copies. For example, if an author publishes their wiki page with limited permissions and then mirrors copies to two other groups, those mirrored copies will also be set to limited permissions.

---

**Note**

* denotes the following: Mirror content is always published when its sources is published. Mirror content is automatically removed when its source expires. Group administrators and the content creator can schedule a mirror entry to be completely deleted under content listings in a target group, either before or after the source expiration.

---

### Publishing and expiration

When a source content item is published with a publish date and expiration date, the mirrored copies of that item also assume the same publish and expiration dates. Mirrored content is always published at the same time as its source, and is always removed from a target group when its source expires. However, the mirrored copy under the Content listing for the target group, along with its feed conversations, can be manually removed or scheduled for removal either earlier or later than its source.
Create a mirrored content item

To ensure that all groups have access to the same copy of a given content item (e.g., PDFs, Microsoft Word documents and PowerPoint slides, video files, jpg and png images, knowledge base article, wiki pages, and blog posts, etc.) rather than a copy that may be out of date, a single source content item can be maintained in a public or private group folder, and then mirrored to other groups as a read-only copy. Edits can only be made to this source. Once the new version of the source is published, it automatically updates all mirrored copies in the other groups.

**i Note**

You can mirror a content item, one group at a time only.

**i Note**

When a blog or wiki containing embedded images is mirrored, the images are not mirrored. The content owner is responsible for making sure that members of a group where the blog/wiki is mirrored have permission to the embedded images. For best results, it is recommended that you embed images so that they are publicly available, such as those from a public group, a public SAP Jam profile, company portal, or the internet.

To create a mirrored document

1. Go to the Content section for your group. Or if mirroring a knowledge base article, from the Knowledge Base section, go to the single item view of the article you want to mirror.
2. Click the content item to open it in single item view.
3. From the More menu located below the content item name and breadcrumb navigation, choose Mirror.
4. On the Manage Mirrors light box, click + Mirror.
5. From the Mirror to Group light box, click the Select Group drop-down menu.
6. A list of groups that you have access to displays. Choose a group.

**i Note**

When mirroring a knowledge base article, the next steps are not applicable as there are no folder structures for the knowledge base.
Mirror to Group

A list of top level folders for the group content displays.

Click to select a folder. If you have clicked an incorrect folder, you can navigate back to all top level folders by clicking on the breadcrumb link that appears above the folder titles.

Click Select Folder. The Manage Mirrors light box displays with the confirmation message, "Mirror created successfully."

If you want to mirror the document to other groups or other folders within the same group, repeats steps 1 through 9.

Once the source is mirrored to other groups, their group members will have read-only access to the mirror copy. The More drop-down menu for the mirrored copy will not have the option to mirror another copy of itself; however, you will be able to make a non-mirrored copy.
In the feed updates for the destination group, when the source content has been updated, a feed item will appear to notify members that their fellow group member has posted an updated version of the mirrored document. The person who has mirrored the content item must be a member of both groups; their name will appear in the feed item as the person who has updated the content item.

**Update a source content item**

Content owners or those with permission to update content will see the following message when uploading a new file to replace the source content item:
Updates and comments will be mirrored to multiple groups

They will also see the following when updating blog posts:

Publish Settings

Updates and comments will be mirrored to multiple groups

Delete a mirrored content item from the target group

If a content item no longer needs to be shared to a certain target group, as content owner and target group member, you can delete the mirrored copy of the item. The deletion will also remove any feed updates and metadata associated with the mirrored copy. Deleting a mirror copy does not affect the source.

To delete a mirrored content item
1. Go to the Content section for the target group where the mirror exists.
2. Click on the mirrored content item so that it opens in single item view.
3. Click More > Delete.
4. Click Confirm on the delete confirmation message. The item will be moved to the group trash.

Delete a mirrored content item from the source group

If you are not a member of a target group that contains the mirror you wish to delete, you can delete the mirror via the source group.

**i Note**
Deleting a mirrored content item from the source group will only remove the content of the mirror but leave behind existing feed updates and metadata that are already captured for the mirror. When someone visits the document viewer for a deleted mirrored item, they will see a message stating that the mirrored content is no longer available, but they can still see associated feed updates, views, likes, downloads, tags, and content rating.

**To delete the mirrored content item**
1. From the source group, go to the single item view of the source content item and choose Manage from the Mirrored to groups section.
2. Click the x for the target group with the mirrored copy you want to delete.
3. Click OK on the confirmation message to delete the mirror copy.

Delete the source content item from the source group

When source content and its related feed updates are no longer relevant, you can remove the source, its feed updates, and all mirrored content from all target groups.

**i Note**
This will remove the content of the mirrors but leave behind existing feed updates and metadata that are already captured for the mirrors; it is up to the group administrator of the target groups to delete such feed updates and metadata. When someone visits the document viewer for a deleted mirrored item, they will see a message indicating that the mirrored content is no longer available, but they can still see associated feed updates, views, likes, downloads, tags, and content rating.

**To delete the source content**
1. From the source group, go to the source content item and choose More > Delete.
2. On the Delete Confirmation message, click OK to delete the source and all its mirrored copies.

Edit the source content item

To edit the source content, you must have access to the source group and folder where the file is located, along with permissions to edit that source file.
Mirrored content and view source details

On the single item view page for the source content item, the right side panel lists the number of mirrored copies that exist.

When you click Manage, it opens the Manage Mirrors light box where you can add new or delete existing mirrored copies.

The mirrored content item contains a clickable link to View Mirror Source, which opens only if you have access.

4.1.16.4 Move content

When you add content, by default it may be added to a Top Level folder. As that might not be the best location, you may need to create folders to organize content uploads and find information faster. You can also move existing content such as documents, wikis, images, videos, and blogs from one group content folder to another group, provided that you have access to the destination group and the folder.

To move your content to another folder
1. From the Content section, select the item(s) you want to move.
2. From the actions above the Content section choose More > Move selected items to. Or, located below the content item name, choose More > Move.
3. In the Move to pop-up, choose the destination group where you wish to move the content to.
4. Choose a folder.
5. Click Select Folder.
6. A confirmation dialog appears. Click Move.

**Note**

If you are moving a content item such as a wiki or blog where the item contains an unpublished draft, that draft will be discarded upon the move. If you move a video or image that is linked to the overview page or wiki, a warning message will appear before you commit to moving the item.

**Note**

When you move content items from private folders to public folders all group members will be able to view the content. After you have moved a content item to another group folder and then return to the folder where it was previously saved, a message displays to indicate that the item was moved to another group.

**Note**

You cannot move documents within or outside of a group specified by your group administrator as having limited permissions.

**Meta data and reports**

When you move a content item to a folder within another group, the meta data (e.g., number of views, likes, content rating, tags, feed comments) is also moved with that item. For example, if the number of views for an item in Group A is 100, and then the same item is moved to Group B where it has 50 views, the total number of views for that item will be 150 when you see the details for the single item view.

Some company and group level reports may be impacted with the moved meta data. For example, in the group level report called "Content Ranking", prior to a move from Group A, the number of likes for a specific non-
deleted document is 100. After the document is moved to Group B, when the report is generated for the current time period, the document meta data will no longer appear for Group A. Instead, the report for Group B will show 100 likes plus any new likes garnered during the current period.

**i Note**
The number of views that actually occurred for an item per specific group are shown where applicable in other reports.

If Group A has a wiki with 100 feed items and that wiki is moved to Group B, the company level report will show that the company has two wikis (one in Group A and one in Group B) with 100 feed items each. For the group level reports, Group A will show one wiki with 100 feed items, and Group B will also show that it has one wiki with 100 feed items.

When you move content items to or from private folders, all meta data will also be moved to the destination folders.

### 4.1.16.5 Feature content

If you need to draw attention to a specific content item, you can specify it as a “featured item”. The item will then be highlighted within the Content widget on the group overview pages when the type of content to display is set to “Featured”.

**To feature a content item**

1. Go to the group page.
2. Click **Content** from the navigation menu.
3. Locate the item you want to feature and hover your cursor over the title area.
4. From the **More** drop-down menu below the item, click **Feature**. A checkmark will appear under the Feature column to indicate that the content item is now featured.

**Feature menu item**

If you no longer want to feature an item, you can follow the steps above, this time clicking **Unfeature**.

**i Note**
You can also feature folders in addition to content items like documents, links, videos, and blogs.
4.1.16.6 Rename content title

As you create and manage your content, you may find that a title may need correction or change. You can rename the title for a content folder or item within the Contents section.

To rename your content title
1. Go to the group page.
2. Click Content from the navigation menu.
3. Locate the item you want to rename and hover your cursor over the title area.
4. From the More drop-down menu below the item, click Rename. Enter the text for the title and then click Save.

4.1.16.7 Tag content

Tagging content in SAP Jam works the same as with other web pages and blogs outside of it. When you tag content, you make it easier for other users to create alerts and search for the exact or similar content based on the tag that you use. Tags used throughout your group are visually represented in a tag cloud.

To tag content or a knowledge base article on a single item view page
1. Click the content item you want to tag.
2. On the single item view page, choose More > Add Tags or click Add beside the Tags level on the right side panel.
3. In the Add Tags light box, type the first few letters of the tag you want to use. If your company administrator has set a list of pre-defined tags, you will see a list of related tags appear in the Tag text box.
4. Select an existing tag (or enter a new one). For multiple tags, separate each tag with a comma.
5. Click Add. The tag can appear in a tag cloud widget or in a list of tags associated with the document. When a user creates a search alert for that tag, the content item will be listed in the search results.

To tag one or multiple content items simultaneously in the same folder from the Content section
1. Click the content items you want to tag.
2. Choose More > Tag selected items.
3. Follow steps 3 to 5 above.

Note
Tagging is only permitted when your group’s collaboration level is set to “full” by your group administrator.

4.1.16.8 Delete content

When you delete content from the Content section, the content is removed from the Content section and placed in Trash. To permanently delete the content, you can click on Trash, select the item, and purge it completely.

To delete content from the Content section
1. Select the item(s) from the Content section
2. Choose More > Delete selected items.
3. Click Delete on the Confirmation message.
   If you select an item that you do not have permission to delete, you will not be able to delete that item.

![Delete Confirmation]

4.1.16.9 Publish settings

Content may be time-sensitive and subject to announcement at the right time, requiring an automatic publishing mechanism. It may also become out-dated and a source of confusion if a member comes across it and uses the information when it’s no longer applicable; this would warrant a “best-before-date”. When you upload new content or work with previously published content items in the group Content folder, you have the option to set a new publish date and time as well as an expiration date and time. For example, if you posted a legal policy document two years ago, but the policy has changed and is now valid for another two years, you could delete or archive that policy version in a private folder, and then post a modified version with an immediate publishing date and time and set expiration date and time. Or, if you’ll be away on vacation while a major announcement is due to be posted, you could write the announcement in advance, and set the publishing options before you leave.

If you choose not to set these options, the content will publish immediately and without an expiration date and time. However, you can choose to change or set an expiration date and publish date for the content item in single item view at a later time.

To configure publish settings for a new content item that you upload

1. On the Upload Files dialog, below Publish Settings, click Options.
2. If you want to set a publish date, select Automatically publish and then choose the date and time from the drop-down menus.

   **Note**

   If a blog or wiki includes attachments, once it is published, the attachments are also published. If you change the publish settings at a later time, only the blog and wiki will adhere to those settings. The attachments are unaffected by the change in publish settings and will remain available in the group content folder unless you manually delete them.
3. If you want to set an expiration date, select *Automatically expire* and then choose the date and time from the drop-down menus.

**Note**

On the far right side of the single item view page, expiration date information will appear below the content owner’s name. On the expiration date, the content item will be automatically deleted and moved to the group trash. Content items created via your profile page will be moved to your personal trash.

To configure publish settings for a new blog post, wiki page, or knowledge base article

1. Below the rich text editor, click *Publish*.
2. Follow steps 2-3 in the previous section.

**Edit the publish settings at a later time**

Prior to the publish date and time, if you want to make a change, you can choose *More > Edit Publish Settings* to remove or edit the publish date and time for the content in single item view. Prior to the expiration date and time, you can also choose *More > Edit Publish Settings* to make changes.

**Scheduled and published content items**

Content items with a scheduled publish date and time are listed in the “To be published” part of the Content section. On the single item view, the scheduled for publishing and/or expiration dates appears beside the content creator’s avatar.

**4.1.16.10 Permissions**

As a content owner who has uploaded a document to the Content section for a group, you can set permissions on individual documents in a group. You can also set permissions when you create a wiki, right before you publish or save it.

**To edit the permissions on content**

1. From the Content section, select the content for which you will edit the permissions.
2. Choose *More > Edit permissions*.
3. Move the circle to the desired permission setting and then click *Save*. 

SAP Jam Collaboration User Guide 1902

Content

PUBLIC 135
You can choose one of the following permissions for documents:

1. **Full Access (default)**: Other group members can view, edit, delete, rename, re-upload, restore, and download.
2. **Limited**: Other group members can view and download, but not edit, delete, rename, or otherwise change the document.
3. **Read-only**: Other group members can view only; downloads are not permitted.

You can choose one of the following permissions for wikis:

1. **Full Access (default)**: Other group members can view, edit, delete, rename, restore.
2. **Read-only**: Other group members can view only (previously known as “Locked Page”).
3. **Hidden**: Invisible to other group members.
   - Content owners have full access to the content that they upload. Group administrators have full access to all the content for their group.

**Document Permissions**

The following table lists all the actions that can be performed on documents, and which group members can perform them based on collaboration level set by the group administrator.

---

*Note*  
"Creator" refers to the document creator or member who uploaded the document, or the latest version of the document.
### Document permissions

<table>
<thead>
<tr>
<th>Actions</th>
<th>Read-only</th>
<th>Limited</th>
<th>Full</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Tags</td>
<td>Everyone</td>
<td>Everyone</td>
<td>Everyone</td>
</tr>
<tr>
<td>Add Task</td>
<td>Everyone</td>
<td>Everyone</td>
<td>Everyone</td>
</tr>
<tr>
<td>Bookmark</td>
<td>Everyone</td>
<td>Everyone</td>
<td>Everyone</td>
</tr>
<tr>
<td>Comment</td>
<td>Everyone</td>
<td>Everyone</td>
<td>Everyone</td>
</tr>
<tr>
<td>Copy</td>
<td>Group administrator and creator</td>
<td>Everyone</td>
<td>Everyone</td>
</tr>
<tr>
<td>Delete</td>
<td>Group administrator and creator</td>
<td>Group administrator and creator</td>
<td>Everyone</td>
</tr>
<tr>
<td>Download</td>
<td>Group administrator and creator</td>
<td>Everyone</td>
<td>Everyone</td>
</tr>
<tr>
<td>Edit</td>
<td>Group administrator and creator</td>
<td>Group administrator and creator</td>
<td>Everyone</td>
</tr>
<tr>
<td>Edit permissions</td>
<td>Group administrator and creator</td>
<td>Group administrator and creator</td>
<td>Group administrator and creator</td>
</tr>
<tr>
<td>Edit publish settings</td>
<td>Group administrator and creator</td>
<td>Group administrator and creator</td>
<td>Group administrator and creator</td>
</tr>
<tr>
<td>Feature</td>
<td>Group administrator</td>
<td>Group administrator</td>
<td>Group administrator</td>
</tr>
<tr>
<td>Like</td>
<td>Everyone</td>
<td>Everyone</td>
<td>Everyone</td>
</tr>
<tr>
<td>Mark as inappropriate</td>
<td>Everyone</td>
<td>Everyone</td>
<td>Everyone</td>
</tr>
<tr>
<td>Mirror</td>
<td>Group administrator and creator*</td>
<td>Everyone*</td>
<td>Everyone*</td>
</tr>
<tr>
<td>Move</td>
<td>Group administrator and creator</td>
<td>Group administrator and creator</td>
<td>Everyone</td>
</tr>
<tr>
<td>Mute</td>
<td>Everyone</td>
<td>Everyone</td>
<td>Everyone</td>
</tr>
<tr>
<td>Rename</td>
<td>Group administrator and creator</td>
<td>Group administrator and creator</td>
<td>Everyone</td>
</tr>
<tr>
<td>Upload new version</td>
<td>Group administrator and creator</td>
<td>Group administrator and creator</td>
<td>Everyone</td>
</tr>
<tr>
<td>View</td>
<td>Everyone</td>
<td>Everyone</td>
<td>Everyone</td>
</tr>
</tbody>
</table>

*This is the default which can be overridden so that specific members or everyone can mirror. It must be set at the content item level by the content creator or group administrator.
4.1.16.11 Upload files

You can upload one or multiple files at the same time in the Content section of your group. Note that the files that you upload for your group are not maintained from the Content section of your own profile; the content stored there is independent of group content.

**To upload files to the Content section**

1. Click Upload File from the Content section.
2. Browse your local drive for the file(s) you want to upload.
3. Select the file(s) and then click Open.
4. From the Upload To drop-down menu, select the folder that you want to upload the files to.
5. The group will see your latest file uploads in the group feed update unless you turn off the Show in Feed Updates option.
6. Click Upload.

**i Note**

Three Microsoft Office document types are supported: Excel, Word, and PowerPoint.

4.1.16.12 Download files

You can select multiple individual files and/or content folders to download in a single zip file.

From the Content section, group members can now choose **Download selected items** to download content (i.e., documents and folders) from their groups.

**Download Files**

The total file size estimate is 21.7 MB. Note: documents, images, and videos, will be downloaded in a single zip file.

Download files confirmation

4.1.16.13 Download counts

Content owners and group administrators can track the number of times a particular content item has been downloaded, who downloaded the item, and the latest version they downloaded.

The number of times that a content item (for example, document, compressed file, image) has been downloaded, either manually or via the API, now appears below the number of views detail in single item view.
When the content owner and group administrator clicks the number beside Downloads, a dialog displays with the names of members who downloaded the item and the latest version number of what they downloaded.

4.1.16.14 Check out and check in content

Check in and check out actions on documents allow you as a content author to maintain some process control over your document when other group members have editing access to it. It also allows you as a group member to follow a process when interested in making edits to a document owned by another content author. When a document is checked out, checked in, or a check out is discarded, a real time notification displays in a banner while viewing the document.

Prior to the November 2017 release, you could access the lock or unlock menu items when needing to work exclusively with a document. For the November 2017 release, lock has been replaced and renamed to "check out" and unlock has been replaced and renamed to "check in".

Check outs

When you check out a document:

● any other user viewing the document will see a real-time banner notification indicating that the document is now checked out by you, and for the duration that it has been checked out.
● any other user viewing the document will be unable to perform actions on the document such as edit, upload new version, delete, edit permissions, and edit publish settings.
● any other user viewing the document can send a request to edit the document. The request can be sent to the content owner or group administrators. They can either discard the check out or check in the document; both actions free the document for your opportunity to edit.
● if another user needs to check out the same document you already have checked out and can’t wait for your check in (for example, emergency issue, you are unavailable and unable to check in the document, etc.), they will be able to click a Discard Check Out option and must enter a reason for this action. You will be able to see the explanation once your checkout is discarded. A Discard Check Out action by another user will override your check out (and thereby cause you to lose your changes).

<table>
<thead>
<tr>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>Recommended best practices include that:</td>
</tr>
<tr>
<td>○ You check in your changes as soon as you’ve completed your work so that you don’t lose your changes, and so others can freely check out the same document if needed.</td>
</tr>
</tbody>
</table>
Before uploading a new version of a document, you can check out the document first to prevent overwrites.

- you will see a real-time banner notification reminding you of how long you’ve had the document checked out, and to check it in when you’re done.

Check ins

When you check in a document:

- the real-time banner notification indicating your check out status no longer displays.
- any other user can check out, edit, upload a new version, delete, edit permissions, or edit publishing settings for the document.

Inline edits

As a content author or editor, when you edit a document inline (for example, with Microsoft Office integration), the document is automatically checked out.

4.1.16.15 Upload new document versions

You can replace existing documents with new or other versions of that document.

To upload a new version of a document

1. Click the document to go to the single item page and click **Upload New Version** or go to the Content section, click the **More** menu below the image title and choose **Upload New Version**.
2. Click **Browse** to find the file on your computer or device.
3. (Optional) Enter a comment to describe the revision or give a reason for the new upload. The uploaded version will show in the feed updates unless you turn off the **Show in Feed Updates** option.
4. Click **Upload**. The version number on the right will increment by one number.

Manage versions

When you upload a document, a version history is maintained. In single item view, you can view the version history by clicking the number beside **Versions** to the right of the document. The two most recent versions are listed, along with the time elapsed since it was uploaded and an avatar of the user who uploaded it.

If there are more than two versions available, click **Show More** below the Version History to see a list of the other versions.

In the Version History section, you can click the drop-down arrow beside the version number and choose:
• View to display the document version in the current browser window tab.
• Revert to roll back the document to a previous version. Once reverted, the older version becomes the latest version.
• Download to obtain a local copy of the document.
• Delete to move the version to Trash.

<table>
<thead>
<tr>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>Image uploads that are greater than 10MB will be uploaded as documents rather than images.</td>
</tr>
</tbody>
</table>

### 4.1.16.16 Add task with attached content

If you have a task to assign, and need to include one or more attachments from the group content, you can create a task directly from the content item view to save you a few steps.

**To create a task with attached content**

1. Go to the Content item view.
2. From the More drop-down menu, choose Add Task.
3. Complete the Task details and attach more content if required.
4. Click **Add Task**.

### 4.16.17 Annotations and comments

If you want to comment inline on a document, you can do so from the content item page via the Comments menu. You can make a comment that applies to the entire document, or you can insert an annotation that applies to a specific part of the document. Comments for multiple page items can be viewed for the entire document or a selected page.

---

**i Note**

Annotation (comment on item) for the PDF is unavailable when viewing the inline version of a PDF.
Insert comments

To insert a comment for a specific part of the document

1. Go to the Content item page for the document.
2. From the Comment dropdown menu, choose Comment on highlighted area.
3. A rectangle displays over the document; click and drag it to frame the area you want to comment on.
4. Enter your comments and then click Post.

When inserting more than one annotation on a content item such as a document, the dotted lines used to indicate the annotated areas can now be repositioned, resized, and commented on. When you view an annotated region, you can also view the corresponding comment that also displays in the content item’s feed events section. Clicking reply on the annotation section will automatically move the focus to the corresponding location within the feed in single item view.

View comments

For content items that consist of multiple pages (e.g., Microsoft Word, PDF, etc.) you have the option to view a list of comments specific to a single page, or all comments for all pages.
Comments for a particular version only display when that version is selected. For example, if you choose “Show all comments only”, then all comments for that selected version will display. If you choose “Show Current Page Comments Only”, then only the comments for that page for that selected version will display.

4.1.16.18 Bookmark content

When you bookmark individual content items, you are allowing SAP Jam to maintain a single access point for your favourite or most frequently accessed documents, blog posts, wiki pages, knowledge base articles, and other content types.

To bookmark a content item
1. Open the Content item.
2. Choose the More drop-down menu and select Bookmark.
3. To view the bookmarked item, click Bookmarks from the upper menu below the notification and message icons.

If you want to unbookmark the item, return to the More menu for the item and choose Unbookmark.

Note

You can also bookmark and unbookmark feed items from the More drop-down menu in the group feed.
4.1.16.19 Recommendations

Within a group, if recommendations are made available by your company administrator, you can click the Recommendations tab to see the recommended content, most viewed, featured, or liked content in that group. Recommendations can be filtered based on timelines (for example, This Month, This Week, Today, All).

Recommended content is based on items you liked, commented on, followed, bookmarked, or where you were at-mentioned on. The list of recommended content will be different depending on which group you are viewing, or if you are browsing at the company level.

On your home feed, a Recommended Content tile appears with suggested content based on number of views, likes, highest ratings, or whether it’s featured. You can click x when you hover your cursor over the item to view the item or remove the recommendation. If you want to see more recommended content, click Show More. You can then browse recommended content by timeline and recommendation qualifier (for example, most viewed, highest rated, etc.). On this page, you can also browse for suggested people and groups.
4.16.20  Search and filter group content

In SAP Jam, you can search for people or information that you are looking for by typing a keyword in the Search box. If you are searching from within a group, you can limit your search to that specific group, by selecting the option This Group.

It is also possible to filter an entire Group’s content by content type by selecting one of the options in the Showing menu. In the "Filter by Title" text box, you can enter part or all of the title you want to search on. If you enter a partial title, the content list will immediately filter based on your entry.
The “featured” column shows which content is most important. Featuring content also displays it in the group home page tiles, making it more discoverable.
You can also further refine your search by using the content ratings filter.

4.1.16.21 Draft content

Content items that are still "in progress" and not available for group viewing are categorized as Drafts. Draft versions of blogs are listed above published and stored content in the Contents section of your group pages.
Draft versions of profile wikis and blogs are stored and listed in their respective Drafts section above published content.

**Note**

Drafts are automatically saved every ten seconds as you edit wikis, blogs, group overview pages, questions, ideas, and discussions. If you accidentally close the browser or navigate to another URL, the next time you return to the edit session, you will be prompted to recover any auto-saved changes from your session. If another user is also making edits to the same draft and saves their work before you, when you choose to recover changes from your session, it will overwrite that user’s changes.

**To work with drafts**

1. Go to the Drafts area of the Content section.
2. Place your cursor over the title area of the content item and click **View**.
3. You can choose to publish, edit, or delete the draft. Once a draft is published to a non-private folder, it becomes a version that is available to all group members.

When you save a draft of an overview page, wiki, blog, question, idea, or discussion, the title is also saved. You can then change the title for every subsequent version, including the published version.

**To change the title of your draft**

- Click the Title field of the draft and enter your changes.

**Note**

Drafts with attachments are included in your company storage quota. When an attachment is uploaded via external URL, a draft is automatically created as soon as the attachment uploads.

**4.1.16.22 Extract zip to content**

Your group may have a large volume of documents or content required for archiving purposes. If you are a group administrator, you can upload a zipped file containing such items into your group’s content folder.

**Note**

The following conditions should be observed:

- File items in a single zipped file cannot exceed a maximum of 2000.
- The size of the zip file cannot be larger than 2.14 GB.
- The maximum number of nested folders is 9.
- To ensure that the extracted files, once uploaded, are not mangled, it is recommended that you use an up-to-date zip tool (for example, 7zip) to create the correct zip file.
- In the Parameters field for 7zip zipped files, you must enter "cu" to force UTF-8 filenames.

**To extract zipped content to a group folder**

1. Go to the group Admin menu and choose **Extract Zip to Content**.
2. Browse your local machine for the zip file you want to upload and extract. Click **Open**.
3. Choose the folder that you want to upload the content to, set the permissions on the file, and then click **Import**.
4. A confirmation message appears; an email notification will be sent once the files are successfully uploaded. Click OK to dismiss the dialog.

4.1.16.23 Rate content

Documents, images, links, videos, wikis, and blogs can be assigned a starred rating to indicate its overall value or perceived usefulness. As all group members can assign a rating, the content will display with the average
rating, and a distribution list of total number of members to total number of stars given. Ratings are anonymous; names will never appear beside a given rating.

**i Note**
Content ratings are only available if enabled by company or group administrators.

**To view and submit a content rating for a particular content item**

1. Go to the Content section for your group and select the content item you want to view. In the Content section, a ratings column will indicate the item’s average rating, if applicable.
2. When the content item appears in single item view, a Content Rating area appears to the right (if not, click Details to expand your view). If it has been previously rated, the average rating and distribution of stars by total number of group members is shown.
3. To enter a rating or change your previous rating for the content item, click Rate this on the bottom right corner of the content rating section.
4. With the first star on the left representing a one star rating and the last star on the right representing a five star rating, choose the appropriate rating. As a guide:
   - 5 stars = Excellent
   - 4 stars = Good
   - 3 stars = Fair
   - 2 stars = Poor
   - 1 star = Not recommended
5. Click Submit to apply your rating. If you have rated the content before, your previous rating will be replaced with your new selection. This ensures that while members can change their rating selection, their input will only be counted once in order to provide a fair and accurate rating average.

**i Note**
If the content item is moved to another group, all rating information is removed.

**4.1.16.24 Languages**

As a content author, group administrator, or translator, you can upload a new or select an existing translated content - documents such as Microsoft Powerpoint, Word, PDF; wiki pages; blog posts; and videos - and add it to a “language bundle” using the Languages feature. Users will then automatically see the translated content for their preferred language, if available.

**i Note**
For blog posts, only content authors and designated authors are allowed to bundle them with translated content.

**About translation bundles**

By bundling translated content together:
• an author or translator can ensure translations are up-to-date with respect to the original content.
• a user can quickly find all available translations for the content item.
• a user can still see a default or “fallback” translation, even if their preferred translation is unavailable. For example, if a bundle contains English, French, and Spanish translations, and English is set to the default, a user with any other language preference will see the English version.

\[
\text{Note}
\]
• You can include translated content in a single bundle but not multiple bundles.
• Each content item in a bundle must have a language set, and the languages must be unique in a bundle.
• A bundle can contain only content from the same group but they can be from different folders.

Set language

As a content author, group administrator, or translator, you can set a language on a new or existing translated content item. By setting languages on content, your users will automatically see translations filtered to their preferred language in a group and on the home page. If a language is not set, it always displays regardless of a user’s language preference.

To set the language on content if the language locale has not already been specified
1. Open the content in single item view, click the Information icon, and look for the social metrics panel to the right of the content.
2. Click Set Language.
3. From the Set Language dialog box, choose a language from the dropdown list.
4. Click Save. On the right side panel, the language you selected for the content will display. Here, you can change the language by clicking the current one or add other languages for the same content by clicking All Languages.

Manage translations for content

To add translations to a bundle
1. When viewing content that has a set language, you can click Languages from the right side panel.
2. On the Languages dialog box, click + Add to add translated content to the bundle. You can choose to upload new content or select existing content from the group.
3. On the Set Language dialog box, choose a language for the content you are adding to the bundle. The languages that have already been translated for the bundle appear with the text “already selected”. Select the language and then click Add.
4. Repeat steps 2 and 3 for other content you wish to add to the bundle. When you are done, click Close.

To remove a translation from a bundle
1. On the Languages dialog box, click the v drop-down beside the selected language for the content and choose Remove from the list. The content item will automatically remove from the bundle.
2. Click Close.

To view translated content from a bundle
1. On the Languages dialog box, click the \textit{v} drop-down beside the selected language and choose \textit{View}. The content will automatically open in a new browser tab.
2. Return to the previous browser tab and click \textit{Close}.

To set a translated content item in a bundle as the default
1. On the Languages dialog box, click the \textit{v} dropdown beside the selected language for the content and choose \textit{Set as default}. This is now the default content item that displays when a preferred language is unavailable or not selected.
2. Click \textit{Close}.

Content items list and language filters

In the Content section list view, you can click a language dropdown to filter content items by language. You can also choose to view a list of content in all offered languages.

![Filter content items by language](image)

In the content listing, a translation icon displays next to a content item that has been translated into one or more other languages. To view the other translations, select \textit{Languages} from the dropdown on the right.

![Translated document with icon indicator](image)

4.1.17 Content approval and workflow

A content approval workflow allows for content to be reviewed by one or more selected group members before it is published and available to the entire group. Your group administrator can configure a variety of workflows based on content type (e.g., blog posts, documents, photos, videos, wiki pages) and for forum and feed posts. Content approval is a means of ensuring that your group is viewing content that is suitable as vetted by a group member who is also a subject matter expert.
Content approver selection by the group administrator

Group administrators can apply the same approval policy to all blog posts, wikis, documents, photos, videos, feed posts, and forum posts before they become visible. Or, they can apply a specific approval policy to each item. For each content approval workflow, your group administrator must choose one of the following and then select which members can approve:

- **Any group administrator can approve content/comments**: A group may have one or more group administrators but only one is required to approve.
- **One of a selected set of members must approve content/comments**: One or more group members can be selected but only one is required to approve.
- **All selected members must approve content/comments**: One or more group members can be selected; all are required to approve.

Review, approve or reject content

Content reviewers are sent bell notifications anytime their attention is required for a content approval. They can also click **Pending Approval** from the navigation menu to view a list of outstanding items which require their approval.

To review and then approve or reject content for which you are one of a selected set of members who can approve content/comments

1. Check your bell notifications for a content review request and then click **Review Content**.
2. Or, click **Pending Approval** to view a listing of items pending your approval.
Entries with approval status

3. Click the item to open it in single item view (for content, feed items, and forum topics).

4. Review the item and click Approve or Reject. As a group administrator, you also have two extra options: Delete the content, and override to approve or reject content.

5. If you approve the item, the content owner and other approvers who are a part of the "any selected group member can approve" policy all receive a bell and email notification to let them know that it's been approved.

6. If you reject the item, provide a reason for why the content has not been accepted, and tips if any on corrective action (e.g., editing the rejected post to make the necessary corrections before publishing it again; this would start a new approval workflow) that can be taken by the author. The content author will then receive a bell notification to let them know that the item was not approved. They can click View to read your rejection comment on why it was not approved for publication.

Feed item with rejection message

When reviewing content where all selected members must approve it before it can be published, a bell notification displays when one member has rejected the item. For example, if three group members are selected to approve a wiki page, and one member out of the three rejects the item, then the other two content approver members are notified with a bell notification that it has been rejected.
Regardless if a group administrator is also a selected member for a content approval workflow, they will have options to override and accept or reject an item. This covers situations where a selected non group administrator member is unable to accept or reject a content item because they are unavailable.

**Editing a wiki page while in a content approval workflow**

If the content owner tries to edit the wiki while it is in the approval workflow (for example, multiple approvers are required and one has approved so far), they will see a message indicating that the workflow will be canceled if they proceed with their changes.

**List of content pending other’s approvals**

As a content owner, when you click *Pending Approval* from the navigation menu, you will see a list of your items that require approval from another member before they can be published.

Note
Content that is owned by a group administrator or approver will bypass content approval.

### ADM Systems Learning

<table>
<thead>
<tr>
<th>Title</th>
<th>Contributor</th>
<th>Type</th>
<th>Submitted</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reverse engineering for systems analysis</td>
<td>Medina Avenue</td>
<td>Wiki Page</td>
<td>about 1 hour ago</td>
</tr>
<tr>
<td>Stakeholder engagement in business analysis</td>
<td>Medina Avenue</td>
<td>Wiki Page</td>
<td>about 1 hour ago</td>
</tr>
</tbody>
</table>

Pending other’s approval list

Note
All group content awaiting approval by other approvers displays as "Pending other’s approval"; for these items, the group administrator can override and then approve or reject.
4.1.18 Embedded fonts support

When you upload Microsoft Office documents or PDFs generated from Office applications, they may contain embedded fonts. These fonts display as expected when uploaded in SAP Jam after you follow a few steps in this topic.

Embedded fonts in Microsoft Office documents

For the embedded fonts in your document to display as expected in SAP Jam, an option must be set in Microsoft Office.

1. Open your document in the Microsoft Office Application and select File > Options > Save.
2. Go to the “Preserve fidelity when sharing this document” section and select the Embed fonts in the file option.
3. Save the document.
4. Upload the document in SAP Jam. When you preview or download the document, you’ll see that the embedded fonts are retained, along with the original document format.

Embedded fonts in PDFs generated from Microsoft Office documents

For the embedded fonts in your PDF to display as expected in SAP Jam, an option must be set in Microsoft Office.

1. Open your document in the Microsoft Office Application and select File > Export > Create PDF.
2. Click Create PDF.
3. Click Options to open the Options dialog box.
4. Under the PDF Options section, select the PDF/A compliant checkbox.
5. Click OK then save or publish the PDF.
6. Upload the PDF in SAP Jam. When you preview or download the PDF, you’ll see that the embedded fonts are retained.
5 Tasks, Events, and Calendars

5.1 About calendars

Calendars display three types of date-driven activities: Tasks, events, and away alerts.

Tasks are action items that you can create and assign to yourself or others. You can delegate and track important tasks that are related to feed updates. You can also submit due dates for Tasks and upon completion, the person responsible can change the status of their task, from open to completed.

Events are used to schedule activities, invite other group members to activities, and manage attendance. Group events can be displayed on a calendar (month/week/day) or as a list. As a user, you can also review all group events that you are participating in under a single aggregated view. Creating an event will create a feed notification in the group’s feed.

Away alerts allow you to inform your colleagues of when you are away. Those who need to collaborate with you will see this information beside your name whenever they enter your name or search for you in SAP Jam. They can then make plans to defer or delegate work in your absence.

Time zone and calendar settings

To the right of your Calendar view is a settings control that enables you to set your preferred time zone and time format.

Although a default time zone is set by your system administrator, you can change it to suit your scheduled meetings, trips, maintain accuracy of time stamps on feed activities, and any other time-sensitive items.

For the time format, you can choose between the 12 hour clock or 24 hour clock. Times shown in events, calendars, agendas, feeds, away alerts, tasks, dashboards, pro/con tables, and OpenSocial gadgets.

You can also set the first day of the week in your calendar. For example, if travelling from the United States to Sweden, you may wish to set the first day of the week to Monday to follow the order of the Swedish calendar. Upon returning to the United States, you can reset your calendar to Sunday.
5.2 Tasks

You can access your personal task lists from the Tasks action on the top of the page, and group tasks from the Tasks section of the overview pages. You can also add, edit, and delete tasks.

After you click the Tasks icon, from the side navigation, you can choose one of the following task categories:

- **My Tasks**: All tasks that are assigned to you.
- **Assigned to Others**: Tasks that you have assigned to others.
- **Unassigned**: Tasks that you have not assigned to anyone.
- **Following**: Tasks where you have been invited to follow.
- **Overdue Tasks**: Tasks assigned to or by you that are overdue.
- **Group Tasks**: A list of groups and assigned tasks.

**Note**

On the group task page, the status filter label has been updated from "Showing" to "Group Status" to indicate the overall status for a listed task. For example, if "In Progress" is selected, then at least one task assignee has their task status set to "In Progress."

**Filter and search for tasks**

**To sort your tasks by their status**

1. Go to the Showing drop down menu and choose one of the following:
To search for a specific task, enter the task name in the Filter by name text box beside the task status drop-down menu.

### Manage your tasks

The following table lists all the actions you can perform with tasks that you create or tasks that are assigned to you and how to use them:

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
<th>How-to</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add: Assignees to task</td>
<td>Add multiple assignees from a group to a task</td>
<td>Click the Add Assignee icon to open the Add Asignees dialog box, select from a list of group members and then click OK.</td>
</tr>
<tr>
<td>Action</td>
<td>Description</td>
<td>How-to</td>
</tr>
<tr>
<td>---------------------</td>
<td>------------------------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Add: Attachment</td>
<td>Add an attachment to a task you created</td>
<td>To add an attachment to a task that you create, go to the Add attachment drop-down menu and choose to upload a new file (e.g., document, image, etc.) or select content that has already been uploaded to a group content folder in SAP Jam.</td>
</tr>
<tr>
<td>Add: Deadline and Reminder</td>
<td>Add a due date with a reminder notification to a task you created</td>
<td>To add a deadline for the task you created, click the Due Date action and then specify the date from the calendar pop-up. You can also choose to send a reminder on a daily, weekly, or monthly basis until the task reaches the due date or the task is completed. Tasks with deadlines also appear in personal calendars.</td>
</tr>
<tr>
<td>Add: Description</td>
<td>Add a description to the task you created</td>
<td>When you want to explain what the task is about or what is required of the task, you can enter a description in the Add Description text box.</td>
</tr>
<tr>
<td>Add: Follower</td>
<td>Invite a group member to follow the task</td>
<td>To invite a group member to follow the task, under More Task Options, go to the + Add Followers text box. Click the text box and enter the names of the group member(s). Followers will display in a “Pending” state until they accept the task.</td>
</tr>
<tr>
<td>Action</td>
<td>Description</td>
<td>How-to</td>
</tr>
<tr>
<td>----------</td>
<td>-----------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Add: Priority</td>
<td>Add a priority to the task you created</td>
<td>To add a priority to the task, click Low, Medium, or High.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><img src="image" alt="Priority action" /></td>
</tr>
<tr>
<td>Add: Tags</td>
<td>Add a tag to a task assigned to you, or to a task you created</td>
<td>You can reuse existing tags (e.g., expertise, content, and forum post tags) and imported tags (e.g., via CSV upload or integration with the SuccessFactors Skills database) when adding tags to tasks. For example, when you start typing a tag for a task, a suggested list of existing tags will display in the Tag drop-down list.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><img src="image" alt="Tag a task" /></td>
</tr>
<tr>
<td>Action</td>
<td>Description</td>
<td>How-to</td>
</tr>
<tr>
<td>---------------------</td>
<td>--------------------------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Status: Change</td>
<td>Change status of a task assigned to you</td>
<td>To change the status of your tasks, first go to My Tasks or the actual task. You can select a status of In Progress, Completed, or leave it as the default (Open). When you change your status, this does not affect the status of work for other group members.</td>
</tr>
</tbody>
</table>

When a user is assigned a task, they are notified through a SAP Jam task notification.

All tasks need to be assigned to a specific group so they have clear business context.

**Creating unassigned tasks**

You can create tasks without assigning them to anyone. The task is still visible to anyone in the group, but no notifications or reminders are sent about the task. The task also appears in your personal Tasks section, under Unassigned. You can assign members to or unassign members from tasks at any time.

This capability is in part designed to allow the creation of custom group templates that contain unassigned placeholder tasks. Every time a group is created using such templates, and members participate in the group, the tasks can then be assigned to specific group members to be carried out.

**Assigning tasks to pending members**

You can assign tasks to co-workers who have not yet accepted invites to your group. Once they accept the invite, one of the first pages they see when they join your group is the Tasks page.
5.3 Events

You can access your upcoming and most recent list of events from the Calendar menu item on the top of each page on the banner menu bar in SAP Jam. However, for creation of group events, you must first be on the group pages.

You can create events in a SAP Jam group to schedule activities, invite other users, and manage attendance. Group events can be displayed on a calendar by month, week, or day, or as a list. You can also review all group events that you are participating in under a single aggregated view. When you create an event, a feed notification displays in the group feed.

To create an event
1. Browse to the group.
2. Click Events from the navigation.
3. Click +Create on the top left corner of the calendar.
4. Enter a name for the event.
5. Enter a start date and time, end date and time, and select the time zone. You can also mark an event as “All Day”, thereby removing the need to enter the start and end time.
6. Use the rich text editor to enter an event description. It allows you to convey a more prominent visual message (for example, formatting, copy and paste text and images). In feeds, email notifications, and exports to Microsoft Outlook reminders, the event description displays in plain text. Single item view of the event will display the event description with formatted rich text.
7. Specify the location, attach agenda items, choose a category from a custom or preset list (for example, meeting, social, training, webinar), choose a priority (for example, Normal, High/Low), add tags, and attach any item from existing group content or your local drive to the event.

Note
Agenda attachments are also available for existing events prior to the November 2016 release. The inline agenda feature is still available for existing events prior to the November 2016 release, but not new ones.

8. If the event occurs with some frequency, you can also set its recurrence, up to 100 occurrences. You can select a daily, weekly, monthly, or yearly recurrence, or choose not to repeat the event. For monthly occurrences that use a month end date, end dates for all months are recognized (for example, August 31st, February 28/29). For weekly frequencies, you can choose the interval (for example, every week, every 2 weeks), day(s) of the week, and when the recurrence ends (for example, on a specified date, after a certain number of occurrences). The entire series can be exported in .ics format to your email calendar. Single occurrences can be edited or deleted without impacting other recurrences in the series.

Note
For multiple day events, a single email notification reminder is sent for the event on the first day, and not for each day of the event. For example, under the Upcoming Events section for daily and weekly group digests, the multiple day event notification is only mentioned in the first email notification.

Once an event is created, a group feed event is generated, and the event is visible to all group members. Anyone in the group can respond, comment, like, create tasks, add tags, and search for your events.
Create a new event dialog

**View and manage group events**

To see all events in a group, open the group and click *Events* on the navigation. You can display the events in a calendar (monthly, weekly, or daily view) or as a list. Click the <> and “Today” buttons to navigate the calendar. Click the date itself to go into the daily view for that date. When you hover over an event on the calendar, you see a pop-up view of the event with some basic information. Clicking on an empty space on the calendar allows you to quickly create new events.
Calendar with custom event categories

View and manage all events for me

To see all events that you are participating in among your groups, click the Calendar action on the top menu bar, then click the All Events and Time Away for Me tab on the left panel. This is an aggregated view of all events for which you have responded Join or Maybe, and events that you have been invited to but have not yet responded, as well as any of your planned absences. You can review and filter this list the same as you would with the group events. If you would like to review your event invitations that you have not yet responded to, click the “Event Invitations” tab on the left navigation.

Filter and search

You can filter events by category (color-coded), priority, tags, and combinations thereof, using the filter panel on the right. The event title, description, location, and tags are indexed and therefore keyword-searchable as part of SAP Jam Search functionality.
You can show or hide the display of events in the calendar using the filter panel on the right. Tasks and polls are also visually integrated into the Calendar:

- Tasks and polls that have due dates are listed along with events on the group calendar.

![Event categories]

Tasks and poll due dates

- Tasks that have due dates and are assigned to you are displayed under ‘All Events and Time Away For Me’

Invite and manage members

As a host, you can optionally identify attendees for an event by explicitly inviting them to a single occurrence or the entire recurring series. Invitees receive notifications and other group members do not. To invite attendees, click ‘Create and Invite’ or ‘Invite Members’, then simply choose from the list of group members, or search for them by name or email.

As an invitee, you can choose to attend, tentatively attend, or decline one recurrence of the event or the entire series, and optionally include a comment along with your response. You can change your response at any time.
Invite members to event

SAP Jam keeps track of the total number of invitees who have indicated Joined, Maybe, Declined, and Awaiting Response. You can drill down into each category by bringing up the member list viewer and performing a keyword search on the member’s name and email.

Notifications are not sent to the host when someone responds. SAP Jam only generates a feed event when someone responds, and the response is accompanied by a comment. The feed event is displayed on the event page, not the group feed page.

Update and cancel events

To update an event, simply click Edit, make changes, and save. SAP Jam generates the appropriate updates in the group feed, as well as sends notifications to guests who have previously responded with a Join or Maybe, and guests who have been invited but not yet responded. To cancel an event, choose More > Delete. The event is removed and placed in the group trash.

Change your invitation response

To change your invitation response, go to the Invitation response dropdown menu. You can change it to Join, Maybe, or Decline.

Privacy and permissions

The group collaboration level determines various access privileges to events:

- **Full**: all users can create, edit, delete, restore, view, like, comment, export, add tags, add tasks, and mute conversation threads related to the event.
• **Limited:** group administrators can create, like, edit, delete, restore, comment, and any action contained under the More menu; others can view, like, comment, export, add tags, and mute conversation threads related to the event.

• **Read-only:** group administrators can create, like, edit, delete, restore, comment, and any action contained under the More menu; others can view, export event, add tags, and mute conversation threads related to the event.

An event’s details, its current invitee list, the member responses and any accompanying comments are visible to everyone in the group, regardless of whether they are directly participating in the event or not. There are no “private events” that are only visible to specific group members; to do this, create an event inside a Subgroup instead. Only the event host can invite others, edit, delete, and restore their own events. Group admins can always invite, edit, delete, and restore any event.

**Save events to your desktop email/calendar application**

You can export and download the iCalendar (.ics) of an event, and open it using any email or calendar application that supports the .ics format. A common example is Microsoft Outlook. The calendar object includes the event title, start/end date/time, location, and a link back to the event in SAP Jam. The calendar object is typically used as a personal event reminder. Whenever an event is updated in SAP Jam, you can download the iCalendar .ics and it replaces the old calendar object in your groupware. SAP Jam currently does not support the import and processing of iCalendar .ics files, only downloads.

**Design an agenda**

The Agenda planning tool has been integrated into Events. All existing agendas prior to the introduction of events continues to function independently of events, but no new “standalone” agendas can be created in SAP Jam. Now, you create an event, and you design an agenda within the context of the event. The functionality of the Agenda tool has not changed. You can continue to add or arrange agenda topics and specify topic presenters.

**Export events**

Information particular to events can now be exported outside of SAP Jam so that users can work with the data in other applications or record a subset of the data for future reference. The event creator and group administrator can now export details of an event to a CSV file in case they wish to use the information outside of SAP Jam (for example, creating an attendee list with names and email addresses for future reference, sending email).

### 5.4 Away alerts

From your SAP Jam personal calendar, you can enter a new time off event with the start and end dates and times for your time off (e.g., approved absences or time away from office due to meetings, conferences, etc.), and optionally inform others of your planned absences by enabling an away alert with start and end dates. These alerts will display immediately after you enter them, until the end date passes, when they’ll also be automatically removed from your profile and group calendars. You can also access and manage settings for alerts by clicking the cog icon for settings on the global menu bar and choosing **Account > Away Alerts**.

You cannot specify the date for which you want the alerts to display. For example, if your planned absence occurs one month from today, when the away alert is enabled, it will display today.
**i Note**

SAP Jam away alerts do not synchronize with the Microsoft Outlook out-of-office feature.

Personal calendar view of away alerts

### Manage Away Alerts

| Away Alert | 07/21/2015 to 07/22/2015 | All Day | | 08/3/2015 to 08/8/2015 | All Day |
|------------|--------------------------|--------||------------------------|--------|
| Save       | Reset                    |        ||                        |        |

Manage away alerts via account settings or on your profile page

**i Note**

If your company administrator has enabled integration with SuccessFactors Employee Central, then your away alerts will already be shared to your SAP Jam profile. To inform other colleagues of your absences, on your SAP Jam profile, click the option beside your away alert to enable a notifications that displays to colleagues when they search for or enter your name. You cannot delete or change the details of your time.
off request in SAP Jam. Changes to your planned absence must be completed in SuccessFactors Employee Central. New time offs, updates, and cancellation requests which are not yet approved or have been declined by managers in Employee Central are not recognized in SAP Jam. If the integration is enabled with the option to manage your alerts, you can go to your profile page and select the away alerts that you wish to display in SAP Jam. From your profile, you can also enable or disable your alerts at any time. You will see a label that indicates Employee Central Time Off integration.

To enter a new away alert

1. On the left side navigation, click Away Alerts.
2. Click + Away alert to add a new alert.
3. In the start date field, click the calendar icon to choose the first day you will be away.

**Note**
You cannot set an away alert for absences that occurred in the past.

4. In the end date field, click the calendar icon to choose the last day you will be away.
5. By default, "All Day" is enabled. However, if you wish to enter your time off with more precision, you can clear this option and specify the hours and minutes from a drop-down list.
6. Click **Save** when done. A confirmation message appears to confirm your new away alert.

When you go to your profile page, your away alert will be listed under the Away Alerts section.

When a colleague now searches by your name, they will see the notification for your absence.
Your planned absence information displays to other SAP Jam users when they:

- view your profile.
- view your information in a hover card.
- @mention your name.
- assign a task to you.
- invite you to a group.
- invite you to an event.

Your planned absence information also displays to other SAP Jam users when an event occurs or if there is any time off scheduled leading up to the task due date.

**To delete an away alert**

1. Go to your profile page.
2. Under the Away Alerts section, click Manage Away Alerts.
3. Click the x beside the alert.
Who sees my alerts?

For each group you belong to (with the exception of auto groups), your fellow group members can view your enabled alerts in the group calendar by clicking the Away Alert category. External users and restricted access users cannot enter away alerts nor can they view your alerts.
6 Business records

6.1 About business records

View Business Records directly in SAP Jam

You can browse, search, sort, and filter for specific, real-time business record data in SAP Jam independently of feeds and groups when SAP Jam has been integrated with external business systems (e.g., CRM, SAP Cloud for Customer). As you open and inspect each record that you have access to, you can begin collaboration or join the conversations in an existing group regarding these business records. Supported SAP Cloud for Customer (C4C) business record types include Account, Opportunity, and Service Request (Tickets). To view these records, you must have access rights to the business records in that integrated system.

To access the business record browser, click Business Records on the global navigation menu bar. Select a specific external application, and then select a business record type. The displayed list is sorted by last modification date in descending order by default.

- To search by record ID, enter the ID into the search box.

  i Note
  If you use the Search field above the global menu bar to search for business records, the results will display on the search page. You can further refine your search by selecting the Business Records category from the left side navigation of the Search page. If enabled by your company administrator, you can also search for any public comments or feed conversations on business records for the whole company, even if you do not have permission to view the business record’s data.

- To filter the records, select one of the available filters from the “Showing: All” drop-down.
- To view a business record, place your cursor over the business record name to see the quick view hover card. You can create a new group from the record, feature it in an existing group, or open an existing group where the record is currently featured.

You can also access business records from the navigation menu. It groups primary, featured, and related business records (where applicable) so that you can quickly find all the business records in one specific area of the menu.
Business Records for learning groups

For a group that is focused around a SAP SuccessFactors Learning record (for example, an Item, Scheduled offering, or Curriculum), the labels on the navigation menu have been renamed "Related Learning" and "Featured Learning". The "Business Records" link in the global navigation bar is also renamed "Learning".

Follow Business Records

By following a business record, a user receives updates in their personal SAP Jam home feed on the comments posted to the object as well as any field-level changes made to the record.

Follow and unfollow

To manually follow or unfollow a business record, open it in its native business application and select ‘Follow’ / ‘Unfollow’. This feature is already supported for a number of SAP CRM business records including account, opportunity and service request. The addition in this release is support for the SAP ECC sales order and invoice records.

To manually follow or unfollow a sales order business record, open it in its native business application and click on the ‘GOS/Services for Object’ button. Then select the menu option ‘SAP Jam Follow/Unfollow’ and follow or unfollow the record.
Business record application
Automatically Follow

To automatically follow a business record, simply create a new group from the business record, or feature it in an existing group. You will start receiving updates on the record in your personal Home Feed. Note that other members in the group do not automatically follow the record. There is no automatic unfollow. To unfollow an record, open it in its native business application and select ‘Unfollow’.

External users access

When you invite external users via email, or when the company administrator provisions external user accounts, these external users can also view, comment on, feature, @mention, and access deep-links to business records from within an external group.

6.1.1 Working with Business Records from External Integrated Systems in SAP Jam

View Business Records in SAP Jam

As a user, you can browse, sort, filter, and search a list of business records in SAP Jam to begin your collaboration. You can only access the business records that you are authorized to access in the integrated external system (SAP Jam honors the native access controls in the integrated system). To do this, click Business Records from the top menu bar, and then select the external application and business record type (e.g., Account) to view that data.

Search business records

When you search for external business records in the list view for a specific record type within a group, the filter criteria accepts case insensitive entries and finds matches based on whether the entry text is contained within accounts and opportunities.
Create a group from a business record

To create a SAP Jam group to collaborate around a single business record, complete the following:

- Place your cursor over that record in the business record browser, in a group, or in a feed.
- Click Create Group in the pop-up window that appears.
- Fill in the information in the Create Group dialog.
Create a group dialog

The new group is automatically populated with up-to-date information about the business record, as well as any data related to that record.

For example, one can create a group from an account and select the Account Management template. The group is populated with details about that account, plus all related opportunities in the sales pipeline and related service tickets in the support queue.
When viewing a related or featured business record in a parent group, one can also click the Create Group or Create Subgroup buttons to create a new group or subgroup for that record.

For example, one can view a related opportunity within the parent ‘account’ group, and then decide to create a new, dedicated ‘Deal Room’ group or subgroup to collaborate on that particular opportunity.

Feature a business record in a group

By featuring a business record in a SAP Jam group, you can bring additional contextual business information that supports the collaboration needs of that group. You may feature multiple business records, possibly of different types, into a single group.

To feature a business record:

- Hover over any business record in the browser, in a group, or in a feed.
  - @mentioned business record in feed update with hover card
  - Click Feature in in the pop-up hover card that appears.
  - Start entering the name of the group in which you wish to feature the record. SAP Jam will search and auto-complete your entry. You can only see groups that you currently have access to.
Once featured, the object appears in the **Featured** section of the selected group. The feed activity for the group will also include an item about the featured business record.

### Socialize a business record

You can socialize the business data that appear in an **SAP Jam** group, similar to how you socialize content items (documents, photos, wikis, blogs) in a group. You can post/reply to comments on a business record, like or tag it, and create tasks attached to it.

Comments posted to a business record within a group are contained to that group. Only users who are authorized to access that group (e.g. group members of a private group) and the business can see the comments.

If **Feed History** is enabled, you will see the full account of past conversations posted about that object, including those prior to you becoming authorized for accessing the record or the group.
If enabled, external users can view, comment on, feature, @mention, and access deep-links to business records from within an external group.
External user access to business records
7 Forum topics

7.1 About forum topics

Forums are used to group general discussions, questions and answers, and ideas to focus upon. With full collaboration permissions, group members can post new questions, add ideas and start discussions in a forum topic. Forum topic creators can change the forum topic’s name and type, monitor the activity, choose a best answer for questions, and move an idea through an approval workflow. Group administrators can create, move, edit and delete specific forums or idea forums.

As you enter a new post for a question, idea, or discussion (through a forum topic, feed widget, or feed updates section), any possible matching existing entries will be suggested before you proceed. This helps to reduce redundancy on questions, ideas, and discussions. You can click on the matching entry for a full view of the question, idea, or discussion. In the matching entries list, questions that have been marked as best answer will display with a green checkmark icon.

You can copy and paste to upload images into question, idea, and discussion comments at a first or second reply level for a forum post.

**Note**
If your group participation permissions are set to limited or read only by your group administrator, you will not be able to add, move, tag, or delete forum topics. Or, your group may only have certain forum types enabled (e.g., discussions only).

Your group administrator can create forum topics with any of four distinct forum types.

- **Questions only**: Group members are provided with a forum to ask questions. Questions are submitted to a group, group members provide answers, and the question creator or group admin can determine when the question has been answered.
- **Ideas only**: Group members can share their ideas where they can receive feedback, have their ideas voted upon and moved through an approval workflow with statuses (e.g., Submitted, In progress, Accepted, etc.).
- **Discussions only**: Group members are provided with a forum to start new discussions.
- **Questions, ideas, and discussions**: An unrestricted forum type that allows group members to ask a question, add and idea, or start a discussion in this general category.

**Note**
Group members cannot create topics that do not belong within their restricted forum type. For example, you cannot ask a question within a forum type for ideas only or discussions only.
You can also attach files to questions, ideas, and discussions to add more context and content to your original posts, answers to questions, and comments on ideas. When you respond to a topic, you can @mention other users and use the hashtag feature.

**Forum filters**

On the Forum Topics list page, you can now sort forum topics by criteria (e.g., recent activity, oldest activity, title) provided in a drop-down menu on the right-side.

On the list page for questions, ideas, and discussions, you can sort topics by recent activity, oldest activity, number of likes and votes, replies, title, and number of views.
Forum topics help organize questions, ideas, and discussions into categories to help members find the information they are searching for. You can create a forum topic and then specify the type of forum that best describes or qualifies the topic.

To add a forum topic

1. In the Forums section, go to the Add drop-down menu and choose New Forum Topic.
2. In the Add Forum Topic light box, enter a name for the topic and select the forum type from the dropdown list.
3. Click **Create**.

**"General" forum topic deletion**

Group administrators can delete the default forum topic "General". If you delete all forum folders including the General folder, when you add a new forum topic, you will be prompted to enter a new forum topic name and choose the type of forum.

**Edit a forum topic**

Group administrators can edit the name and the forum topic type (for example, change from an idea to a discussion). Existing data for the forum topic type will remain after the type is edited.
7.1.1 Discussions

Discussions can be created within groups and consist of different threads created by users and may contain an undefined number of interlaced answers.

Discussions use a generic forum format for enabling any protracted discussion on a specific topic. Users who create a new thread can assign existing tags to that thread or create their own ones. Users can watch all threads in a group by email notification. Use discussions to do the following:

- Discuss strategies for new initiatives.
- Exchange opinions and discuss with many people.
- Obtain feedback.

Create a discussion on the group feed

If you would like to discuss a topic that has just come to mind and you want to begin the conversation immediately, you can post your discussion using the group feed.

To begin a discussion using the post box for status updates

1. Select your group and then click Feed Updates.
2. On the post box below the group name, click the Discussion icon.
3. Where it says “What would you like to discuss?” enter your discussion text. Use the area below the text formatting toolbar to provide more details, examples, etc. if necessary.

4. Use the text formatting toolbar to format the font size, alignment, indentation, etc. of your text if necessary.
5. Use the rich text editor’s image and video tools to place images and videos within discussions for demonstration or clarification, as well as attach files to the responses for those forum topics.
6. You can @mention, include a hashtag, or attach a file to the discussion using the icons below the text box on the left side.

7. Below the text box, if available, select which forum topic you want to add the discussion to.

8. Click Submit. Your discussion is now visible in the group feed, your own wall, and in the Forums section.

Begin a discussion within the Forums section

If you need a bit more time to compose your thoughts, proofread, or edit before you start your discussion, you can use the draft and publish action when adding a discussion in the Forums section.

To add a discussion within a forum

1. Go to the navigation menu for your group pages and click Forums.
2. Click + Forum Topic.
3. Enter a topic name and select the appropriate forum type (e.g., “Discussions, Ideas, and Questions” or “Discussions only”) and then click Submit.
4. Click the topic name and then click + Add Discussion (for Discussion only forum types) or click Add and then select Discussion from the drop-down menu.
5. Where it says “What would you like to discuss?” enter your discussion text. Use the area below the formatting toolbar to provide more details, examples, etc. if necessary.
6. Click Publish if you are ready to show your discussion. It is now visible in the group feed and on your own wall.
7. If you are not ready to show your discussion but want to save what you’ve written so far, click Save Draft.
   You can return to your saved draft via the Forums section when you are ready to continue.

When you view an individual discussion, details such as number of views, when the last activity occurred, and any hashtags are listed on the right side. If you are viewing a list of discussions within the Forums section, the number of replies, views, and likes are shown below the discussion title, first line of the discussion detail, discussion creator, and when the discussion was first posted.

Search discussions in a forum

To search a forum topic by specific keywords that appear in the discussion title, the body of the discussion or within the replies, enter your search text in the Search field that appears above the list of discussions. If you want to search discussions across multiple forum topics, use the global search bar at the top of the page and make sure the filter is set to "This Group".

7.1.2 Questions

You can create a question and submit it to your group when you want to use it as a means to obtain information or input. If there is an answer that stands out among the rest of the responses, you can mark it as the best answer to help other members readily find that answer. Group administrators and members can also view a list of questions under a forum topic at a glance to see which ones have been viewed, answered, liked or remain unanswered.

Ask a question on the group feed

If you would like to immediately ask a question that has just come to mind, you can post your question on the group feed.
To ask a question using the post box for status updates

1. Select your group and then click Feed Updates.
2. On the post box below the group name, click the Question icon.
3. Where it says “What would you like to know?” enter your question. Use the area below the text formatting toolbar to provide more details, examples, etc. if necessary.
4. Use the text formatting toolbar to format the font size, alignment, indentation, etc. of your text if necessary.
5. Use the rich text editor’s image and video tools to place images and videos within questions for demonstration or clarification, as well as attach files to the responses for those forum topics.
6. You can @mention, include a hashtag, or attach a file to the question using the icons below the text box on the left side.
7. Below the text box, if available, select which forum topic you want to add the question to.
8. Click Submit. Your question is now visible in the group feed, your own wall, and in the Forums section.

Ask a question within the Forum section

If you need a bit more time to compose your thoughts, proofread, or edit before you ask your question, you can use the draft and publish action when asking a question in the Forums section.

To ask a question within the Forums section

1. Go to the group page and click Forums from the menu navigation.
2. Click + Forum Topic.
3. Enter a topic name and select the appropriate forum type (e.g., "Discussions, Ideas, and Questions" or "Questions only") and then click Submit.
4. Click the topic name and then click + Ask Question (for Question only forum types) or go to the Add drop-down menu and click Question to display the Add Question light box.
5. Where it says “What would you like to know?” enter your question. Use the area below the formatting toolbar to provide more details, instructions, examples, etc. if necessary.
6. By default, the question will be stored in the General folder unless you specify a new forum topic. Click the drop-down menu beside the Publish action if you want to change which topic the question will belong to.
7. Click Publish if you are ready to ask your question. Your question is now visible in the group feed and on your own wall.
If a forum item is subject to group administrator approval, then when you click **Publish**, you will see a message notifying you of that requirement. The group administrator will receive a notification, stating that there is content pending approval.

8. If you are not ready to ask your question but want to save what you’ve written so far, click **Save Draft**. You can return to your saved draft via the Forums section when you are ready to continue.

9. If you have a saved draft of a question but no longer what to ask it, you can open the draft and click **Delete Draft**.

**Drafts of questions**

Saving a draft of a question is useful when you have a long composition to enter, need time to obtain information, want to begin a question or record your thoughts and refine the question before submitting it to the group. It can also be a placeholder in case you want to ask a question, but not immediately. When you have saved a draft of a question, that draft is saved in the Drafts area of your Questions forum topics section.

You can access the draft by clicking on its title. This will open the draft in a dialog where you can choose, to publish, edit, or delete your draft.

If you want to see a list of specific questions that have been answered or unanswered in a given forum topic, you can go to the forum topic and click the filter drop-down menu that appears above the list of questions. Aside from the default selection of “All Questions”, you can choose one of the following:

- Open Questions
- Answered Questions

To search a forum topic by specific keywords that appear in the question title, the body of the question or within the replies, enter your search text in the Search field that appears above the list of questions. If you want to search questions across multiple forum topics, use the global search bar at the top of the page and make sure the filter is set to “This Group”.

### 7.1.2.1 Answers

When you answer a question posed by a group member through a forum or group feed, you can respond to it as you would with a comment, and optionally include an attachment to support your answer. The question may also include @mentions to notify specific members and hashtags to help make the question searchable. Other group members and the person who asked the question may like or reply to your answer.

**To answer a question**

1. Go to the question you want to answer and click **Answer**.
2. Enter your response in the text box below the question.
3. (Optional) Click Attach a File to include a file from the content repository for the group or from your local drive.
Are the planning sessions going to cover these topics?

I was hoping we could discuss these at the December planning session:
- Re-quantifying targets
- Position statement
- Launch and support programs
- Training
- Any objections or other thoughts?

4. When you are finished, click Answer to post your response to the question.

**i Note**

When you respond to a question from your email notification, your reply is posted as an answer within SAP Jam.

**Mark best answer**

When you ask a question and receive one or more responses, where applicable you can choose one of those replies, or a second level reply to a first level reply, as the best answer. This allows other users to quickly identify correct or most up-to-date information when they search the forum. Below the answer, group administrators and question creators can click *Mark Best Answer* to indicate to everyone that the question has been resolved.
Mark a reply as the best answer

Reply highlighted as best answer

The best answer will reappear towards the top of the response list and have a special "Best Answer" flag in the top right corner, making it easier for other group members to find. If responses continue to be posted, and you find a better answer than the one you marked as best answer, you can unmark it and then select a newer response as the best answer.
7.1.3 Ideas

If you have an idea and would like to share it with group members for feedback or to initiate discussion, you can create an idea and post it on the group feed.

Idea management can be an effective way to get feedback and advice from employees, partners or customers that you invite to the group. Group administrators can create forum topics to collect ideas for feedback, resolving problems, to solve workplace challenges or which products to develop. Ideas use a format geared towards posting ideas and having other group members vote on these ideas and provide additional feedback on them. After group members provide feedback by voting an idea ‘up’ or ‘down’ or providing comments on an idea, you can look at the total amount of votes to gauge the overall sentiment of your audience towards the ideas submitted. ‘Up’ votes and ‘Down’ votes are tracked independently of one another, rather than ‘down’ votes detracting from ‘up’ vote counts.

Group administrators can set the following ‘states’ of an idea to indicate where it stands in the ideation life cycle:

- **Submitted**: The idea has been entered by the idea owner, but not yet formally reviewed
- **In Progress**: The idea is under formal review, with the review outcome pending
- **Accepted**: The idea has been accepted after formal review
- **Declined**: The idea has been declined after formal review
- **Under Consideration**: The idea is under consideration after formal review, but not yet accepted or committed to
- **Completed**: The idea’s implementation has been completed

Create an idea on the group feed

If you have an idea that has just come to mind and you want to present it right away, you can post your idea using the group feed.

To create an idea using the post box for status updates

1. Select your group and then click Feed Updates.
2. On the post box below the group name, click the Idea light bulb icon.
3. Where it says “What idea would you like to share?” enter your idea. Use the area below the formatting toolbar to provide more details, examples, etc. if necessary.

4. Use the rich text editor’s image and video tools to place images and videos within ideas for demonstration or clarification, as well as attach files to the responses for those forum topics.

5. Click Submit. Your idea is now visible in the group feed and on your own wall.

Create an idea within the Forums section

If you need a bit more time to compose your thoughts, proofread, or edit before you submit your idea, you can use the draft and publish action when creating an idea in the Forums section.

To create an idea within a forum

1. Go to the navigation menu for your group pages and click Forums.
2. Click + Forum Topic.
3. Enter a topic name and select the appropriate forum type (e.g., “Discussions, Ideas, and Questions” or “Ideas only”) and then click Submit
4. Click the topic name and then click + Add Idea (for Ideas only forum types) or from the Add drop-down menu, click Idea.
5. Where it says “What idea would you like to share?” enter your idea. Use the area below the formatting toolbar to provide more details, examples, etc. if necessary.
6. Click Publish if you are ready to present your idea. It is now visible in the group feed and on your own wall.

7. If you are not ready to show your idea but want to save what you’ve written so far, click Save Draft. You can return to your saved draft via the Forums section when you are ready to continue.

Voting on an idea

To respond to an idea via a profile wall or group feed

1. Go to the group feed or your profile wall.
2. In the Idea box, click Vote Up if you agree with the idea or Vote Down if you do not agree.

Filter and search ideas in a forum

If you want to see a list of specific ideas that are at a specific point in the ideation lifecycle for a given forum topic, you can go to the forum topic and click the filter drop-down menu that appears above the list of ideas. Aside from the default selection of “All Ideas”, you can choose one of the following:

- Ideas Submitted
- Ideas Under Consideration
- Ideas In Progress
- Ideas Accepted
- Ideas Declined
- Ideas Completed

To search a forum topic by specific keywords that appear in the idea title, the body of the idea or within the replies, enter your search text in the Search field that appears above the list of ideas. If you want to search ideas across multiple forum topics, use the global search bar at the top of the page and make sure the filter is set to “This Group”.
7.1.4 Search forum topics

In the Forums section, you can search all forum topics by entering keywords to display topics with a matching topic description or topic title.

**i Note**
The forum filter results do not display topic replies or topics that would contain replies that match your keyword entry.

To search forum topics

1. Go to the Forums section.
2. In the Search field above the forum types list, enter the full or partial topic title or keywords that could be in the topic description. As you type, the filter will start to display results.

7.1.5 Delete a QID

There are a number of reasons why questions, ideas, and discussions (QID) should be periodically deleted. For example, the subject matter is no longer relevant, it is the cause of confusion for newer employees or colleagues, it contains dated information, and so on. As the requirement for the existence of a given topic becomes unnecessary, you can easily remove the particular question, idea, or discussion from the Forum section.

**i Note**
You can delete a question, idea, or discussion only if your group has been assigned full collaboration permissions by your group administrator. If your permissions are limited or read only, you will not be able to add, move, tag, or delete forum topics.

To delete a question, idea, or discussion from the Forum section

1. In the Forums section, go to the question, idea, or discussion and select the checkbox that appears beside it.
2. Above the list of forum topics, choose More > Delete selected items.
3. Click Delete on the Delete Confirmation message. The question, idea, or discussion is removed from the Forum but is still accessible on the feed update page. When you click on the question, idea, or discussion from the feed, the "This item was deleted. It can be found in the group trash" message displays. You can click the group trash hyperlink in that message or click Trash from the navigation menu to go to the item you just deleted.
4. If you wish to permanently delete the question, idea, or discussion, in the Trash section, select it and click Purge Items. If you’ve changed your mind and want to return the question, idea, or discussion back to the forum, click Restore Items.
7.1.6 Move a QID

When group members initiate questions, ideas, and discussions via the group feed or forum, if there is more than one forum topic to save it to, they might choose the wrong one. Or, the forum topic may change over time and for better re-organization, you decide that the question, idea, or discussion is more appropriate elsewhere, such as with another group of which you are a member. You can move them to other forum topics to help make information easier to find.

**Note**

If your group participation permissions are set to limited or read only by your group administrator, you will not be able to add, move, tag, or delete forum topics. Or, your group may only have certain forum types enabled (e.g., discussions only).

To move a question, idea, or discussion to another forum topic

1. From the Forums section, go to the forum topic containing the question, idea, or discussion you want to move.
2. Select the checkbox beside the question, idea, or discussion and choose More > Move selected items to.
3. On the Move to dialog, choose the group that you want to move the topic to. You can also accept the default, which is the current group. One or more forum posts can be moved at the same time.
4. Select the appropriate forum topic from the drop-down list and then click Move. To verify the move, return to the list of forum topics, and click the forum topic that you moved the question, idea, or discussion to.
5. Click OK.

7.1.7 Tag a QID

When you add tags to questions, ideas, or discussions, you are helping group members find the information they may be searching for with fewer clicks. For example, if there’s a tag cloud on a group page, and you tag the content of a discussion using a popular hashtag, when the member clicks that hashtag from the tag cloud, they will be able to see the discussion in the list of results, rather than having to search for it on their own via the Forums section.

**Note**

You can delete a question, idea, or discussion only if your group has been assigned full collaboration permissions by your group administrator. If your permissions are limited or read only, you will not be able to add, move, tag, or delete forum topics.

To tag a question, idea, or discussion from the Forum section

1. In the Forums section, go to the question, idea, or discussion and select the checkbox that appears beside it. You can select more than one checkbox.
2. Above the list of forum topics, choose More > Tag selected items.
3. In the Add Tags dialog, enter the tag. For multiple entries, separate the tags with a comma. When you view the item that you tagged, it will now appear with the hashtag entry.
7.1.8 Read-only forum posts

Group administrators or content moderators can set forum posts within a selected forum to Read-only so that members can no longer contribute to them. This can be done in cases where a topic no longer requires participation (for example, a question has been sufficiently answered, votes for an idea have already been tallied and accepted, a discussion is no longer relevant).

The forum post will be closed to further comments or edits by setting it to Read-only.

When you set the forum post to Read-only, you can provide an optional reason to help members understand why they can no longer comment or edit that post. Previous comments to the post will remain available for viewing. You also have the option to re-open the post so that members can comment and edit again.

7.1.9 Subscribe to forum topics

Forum moderators can now subscribe to specific forum topics and receive bell notifications whenever those topics have activity, rather than receive notifications for all forum topics, or none at all.

When subscribed directly to the forum topic, a group member will receive notifications when:

- a question is asked.
- an idea is added.
- a discussion is added.
Questions

Upon subscribing, a group member will receive notifications when:

- a reply is marked as best answer.
- a question is answered.
- there’s a reply to an answer on a question.

Ideas

Upon subscribing, a group member will receive notifications when:

- the status of the idea has changed.
- a comment is posted.
- there’s a reply to a comment.

Discussions

Upon subscription, a group member will receive notifications when:

- there’s a reply.

7.1.10 Subscribe to forum posts

As an SAP Jam user, when you are interested in a forum post, you can click Subscribe to receive notifications for all important updates on that post. When you no longer require updates from a forum post, you can also click Unsubscribe.

i Note

You can unsubscribe from a question, idea, or discussion forum but still remain subscribed to a specific topic within those forums and receive notifications for it.
Subscribe to individual forum post

When a forum post is moved to another group, you’ll receive a notification that the post has been moved. You’ll need to resubscribe to the post in the new group if you want to continue to receive notifications.

7.1.11 Create a task

You can create actionable items with context by associating tasks with questions, ideas, or discussions.

On the single item view of the forum topic, choose More > Add Task to create a new task.

Assign a task to a forum topic in single item view

When viewing a task associated with a question, idea, or discussion, you can also view that forum topic. The forum topic lists all tasks associated with it.

Feed items for the task also include a link to the associated question, idea, or discussion.
8 Reports

8.1 About reports

SAP Jam reports display adoption metrics including user contribution and consumption activity. On the SAP Jam Admin console > Reports tab, on the list of requested reports, click the Microsoft Excel (which provides better support for double-byte languages) or csv icon to download the report. You can then upload the csv file to an analytics software and work with the data there. Most reports are available to Group Administrators for group-specific data.

In the list of requested reports, you can also move your cursor beside the report title and click the 'X' to remove the report from that list.

To run a report:

1. In SAP Jam, as a company administrator, click on your name at the top of the page and select Admin from the context menu. The SAP Jam Admin console is displayed.
2. Select Reports from the sidebar menu. The Admin Reports page is displayed.

   i Note
   This horizontal bar indicator show the percentage of the available disk space used, as well as numeric values for the disk usage of stored reports. A script is regularly run that will delete company administrator reports that are older than seven days. In addition, notifications are sent to company administrators when they are at 80% and 100% of their storage allocation. These notifications occur daily, are not configurable, and cannot be turned off.

3. Select the options for the report that you want to run:
   1. Users: Select either This Company or Guest Users.
   2. Select Report: Select the type of report that you want to run. The reports that are available differ if you are a Company Administrator or a Group Administrator. The reports available to each type of administrator are listed in their respective guides, available on the SAP Jam Help Portal.
   3. Time Frame: Click on the Start Date and End Date fields or calendar icons to select the beginning and ending dates, respectively, for the period to be covered by your report from the pop-up calendar selector widgets.
   4. Group: Select either All Company or any of the groups that have been created in your company.

4. Once you have set the parameters for the report that you want to run, click Request report. The report is queued to be run. Your report will be run almost immediately if the end date is in the past. Your report will remain in the queue to be run after the end date if the end date is currently in the future. Queued and completed reports will be listed in the table below the report options section of the page.
5. To download your report, click the name of your report in the table below the report options section of the page, which will open your browser’s download options dialog box.

**Note**

It may be necessary to reload the page in your browser to see a recently run report.

**SAP Jam Group Administrator reports**

Please refer to the [Run group reports](#) topic in the [SAP Jam Group Administrator guide](#) for a complete list of reports and their descriptions.

**SAP Jam Company Administrator reports**

Please refer to the [SAP Jam Administrator Guide](#) for a complete list of reports and their descriptions.
9 Language

9.1 About language

To setup the language, you can click the Cog icon and choose Account to locate your Language settings. Select your preferred language from the list, and click Save changes.

You can also change the language in SuccessFactors. To change the language, select Options Change Language. The setting will be applied immediately.

Under Account Settings, all integrated SAP Jam users can override the default language and set their language preferences via the Language selector. Language settings are inherited by default from SuccessFactors, if applicable.

SAP Jam supports the following languages:

<table>
<thead>
<tr>
<th>Row number</th>
<th>Language</th>
<th>SuccessFactors</th>
<th>SAP Jam</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Arabic</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>2</td>
<td>English (US)</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>3</td>
<td>Bulgarian</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>4</td>
<td>Catalan</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>5</td>
<td>Chinese (Hong Kong)</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>6</td>
<td>Chinese (Simplified)</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>7</td>
<td>Chinese (Traditional)</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>8</td>
<td>Croatian</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>9</td>
<td>Czech</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Row number</td>
<td>Language</td>
<td>SuccessFactors</td>
<td>SAP Jam</td>
</tr>
<tr>
<td>------------</td>
<td>---------------------------</td>
<td>----------------</td>
<td>---------</td>
</tr>
<tr>
<td>10</td>
<td>Danish</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>11</td>
<td>Dutch (Belgium)</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>12</td>
<td>Dutch (Netherlands)</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>13</td>
<td>English (Canada)</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>14</td>
<td>English (India)</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>15</td>
<td>English (Philippines)</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>16</td>
<td>English (UK)</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>17</td>
<td>Finnish</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>18</td>
<td>French (Belgium)</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>19</td>
<td>French (Canadian)</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>20</td>
<td>French (France)</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>21</td>
<td>German (Austria)</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>22</td>
<td>German (Germany)</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>23</td>
<td>German (Swiss)</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>24</td>
<td>Greek (Cyprus)</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>25</td>
<td>Greek (Greece)</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>26</td>
<td>Hebrew</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>27</td>
<td>Hindi</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>28</td>
<td>Hungarian</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>29</td>
<td>Indonesian</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>30</td>
<td>Italian</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>31</td>
<td>Japanese</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>32</td>
<td>Korean</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>33</td>
<td>Malaysian</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>34</td>
<td>Norwegian (Bokmål)</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>35</td>
<td>Polish</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>36</td>
<td>Portuguese (Brazil)</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>37</td>
<td>Portuguese (Portugal)</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>38</td>
<td>Romanian</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>39</td>
<td>Russian</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>40</td>
<td>Serbian (Bosnia and Herzegovina)</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>41</td>
<td>Serbian (Montenegro)</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>42</td>
<td>Serbian (Serbia)</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>43</td>
<td>Slovak</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Row number</td>
<td>Language</td>
<td>SuccessFactors</td>
<td>SAP Jam</td>
</tr>
<tr>
<td>------------</td>
<td>---------------------------------</td>
<td>----------------</td>
<td>---------</td>
</tr>
<tr>
<td>44</td>
<td>Slovenian</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>45</td>
<td>Spanish (Argentina)</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>46</td>
<td>Spanish (Chile)</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>47</td>
<td>Spanish (Columbia)</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>48</td>
<td>Spanish (Mexico)</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>49</td>
<td>Spanish (Spain)</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>50</td>
<td>Spanish (Venezuela)</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>51</td>
<td>Swedish</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>52</td>
<td>Thai</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>53</td>
<td>Turkish</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>54</td>
<td>Ukrainian</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>55</td>
<td>Vietnamese</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>56</td>
<td>Welsh</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Number of Languages</td>
<td>42</td>
<td>42</td>
</tr>
</tbody>
</table>

### 9.2 Right-to-left languages

SAP Jam now supports Arabic and Hebrew languages where the alphabetic characters are read from right-to-left.

When a user working with a supported right-to-left language creates a wiki, blog, or content for their home page, SAP Jam will display all page elements from right-to-left and text as right-aligned. For a wiki or blog, the user must select the right-to-left mode in the rich text editor for paragraph display if writing in Arabic or Hebrew. If they do not select this paragraph mode, the wiki or blog will display the paragraph from left-to-right and the text will default to left-aligned.

When entering text with a right-to-left language, and then switching to a latin-based left-to-right language, the latter will appear as expected in left-to-right concurrently with text in right-to-left. For example, when typing a feed comment in Hebrew and then switching to US English to @mention a US colleague, the @mention will appear left-to-right while the text in Hebrew still displays right to left.

If feed items are detected to be in Arabic or Hebrew, then the feed item will display from right-to-left with text right-aligned.
10 Integrations

10.1 About integrations

SAP Jam can conveniently integrate with the third party applications listed here, along with other cloud solutions from SAP, such as SAP Cloud for Customer.

10.1.1 Alfresco One integration

Alfresco One is a CMIS-compatible document repository. If enabled by your group administrator, you can browse Alfresco One-linked document repositories within your SAP Jam group.

<table>
<thead>
<tr>
<th>i Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>You can enter partial filenames to filter content from the document repositories.</td>
</tr>
</tbody>
</table>

10.1.2 Gamification vendors

Gamification vendor integration helps motivate and reward new hires and existing employees in their employee development. It ensures that they ramp up quickly in new roles and remain effective and productive with the most current knowledge and training available. When the company administrator enables gamification in the SAP Jam Admin console, they can also choose to enable any of the following types: Badges and Missions, In-context Gamification Notifications, and Leaderboard. Gamification activity will display in the profile wall feed activity.

Badges and Missions

As a new hires or existing employee, you can be rewarded with 'badges' that cumulatively go towards completing 'missions' that exemplify behavior required for employees to be most effective in their jobs. A variety of activity in SAP Jam can be identified as criteria for earning badges and completing missions, for example:

- Adding ideas
- Answering forum questions correctly
- Blogging
- Creating or annotating documents
• Updating service requests or sales orders in integrated CRM applications

**In-context Gamification Notifications**

As you earn badges, the badge displays from the bottom of the screen whenever you satisfy a new challenge. Your Achievements page displays all of your earned badges at the top of the page.

**Leaderboard**

Also on the Achievements section of your profile page is a Leaderboard area that lists ranking relative to your peers.

**10.1.3 Microsoft® Office integration**

You can easily work with Microsoft Office documents in SAP Jam without specific client requirements. Please refer to the [SAP Jam for Microsoft® Office® integration Reference Guide](https://example.com) for more information on the Microsoft® Office® integration.

For standard web browsers such as Google Chrome, Mozilla Firefox, and Microsoft Explorer and Edge, Microsoft Office documents integrate client-free in SAP Jam. In SAP Jam, you can click Open to view or Edit to work with an already uploaded Office document, and then save your changes in your local Microsoft Office application. The document will automatically update within SAP Jam. When you click Open, you can view the document in read-only mode.

---

**i Note**

If the applicable Microsoft Office application is not installed on the local machine, Microsoft Internet Explorer, Mozilla Firefox, and Safari browsers will display a pop-up error message while Google Chrome will not display an error. When you try to open or edit in Google Chrome, a tool tip message displays, depending on the action: "Open in external application" or "Edit in external application".

---

**i Note**

The SAP Jam Application Launcher is no longer required to open these documents.

---

**i Note**

When you edit a document in iOS using Microsoft Office apps launched from mobile browsers, after moving back and forth between multiple apps, the document may switch to read-only; in this case, save the document locally and upload it later.
10.1.4 Microsoft® Skype for Business® integration

Microsoft® Skype for Business® can now be enabled on SAP Jam so that you can chat within Skype for Business and check to see if other users are online. If your company administrator has enabled the Skype for Business integration, you will be able to see the online status of a user when you place your cursor over the other user’s profile card in a feed item.

**Note**
The Skype for Business integration with SAP Jam is only supported with the Microsoft Internet Explorer 11 browser.

Microsoft® Skype for Business® hover card

10.1.5 Microsoft® SharePoint® integration

If enabled by your group administrator, you can browse Microsoft SharePoint-linked document repositories within your SAP Jam group. Documents stored within SharePoint are view-only in SAP Jam. As with other SAP Jam documents, you can comment, annotate like, download, mark as a featured item, and bookmark SharePoint documents. For your convenience, you can also copy SharePoint repository documents or folders to a local folder within SAP Jam.

**Note**
- Microsoft SharePoint 2010 and 2013 are currently supported in your advanced plus and enterprise editions.
- Your company VPN is not required to access your SharePoint documents.
- This topic also applies to document repositories using Microsoft Office 365 (SharePoint Online).
- You cannot upload or update SharePoint documents within SAP Jam. You must upload and update content in SharePoint first before it can be viewed in SAP Jam.

Browse SharePoint documents in SAP Jam

You can view all linked SharePoint repositories when you go to your group within SAP Jam.

To browse SharePoint documents within SAP Jam

1. Go to your Group pages and click SharePoint 2010/2013/Online from the group menu. If you do not see this menu item, then please contact your group administrator.
2. A list of file folders belonging to the SharePoint repository displays. You can click on them to browse the files.
When you click View to browse individual documents, it will appear in a dialog box where you can like, comment, annotate, download, resize, feature, bookmark, and copy it to a local SAP Jam folder.
**i Note**

For SharePoint 2013, you must enter the full filename with file extension in the search box to filter content from the document repositories. For SharePoint 2010, the search filter is unavailable.

_Copy documents from SharePoint repository to SAP Jam_

Although you can access SharePoint repository content via the SharePoint menu, it won't appear in any search results, and you will not be able to see it as a featured content item on your group pages unless that content item has been copied to a folder within SAP Jam. After the document is copied, it will be indexed for purposes of searching and available for inclusion with content widgets on your group overview pages. You can also upload new versions of the document within SAP Jam; however the new version will not replace the document that exists in the SharePoint repository or in the SharePoint external folder within SAP Jam.

_To copy documents and folders from the SharePoint repository to SAP Jam_

1. Go to your Group pages and click *SharePoint* from the group menu.
2. Browse to the document or folder you want to copy. You can select multiple documents and folders by clicking the checkbox beside each item you want copied.
3. Click *Copy To* above the list of external folders.
4. Choose the SAP Jam Content folder where you want to copy the files to and then click *Copy*.
10.1.6 OpenText Content Server integration

SAP Jam company administrators can now provide access to files and documents contained within SAP Extended ECM and OpenText Content Server content repositories.

Once enabled, SAP Jam group administrators can choose which content repositories or folders and sub-folders within these repositories are made available within their groups as read-only. However, if you revise the content in the original repository, those updates will be reflected in real-time in SAP Jam, including the version history.

**i Note**

You must enter the full filename with file extension in the search box to filter content from the document repositories.

10.1.7 SAP Cloud for Customer

Integration of SAP Jam with your SAP Cloud for Customer (C4C) solution enables cross-application collaboration using the SAP Jam feed. Business records for accounts, opportunities, and service requests from SAP Cloud for Customer can be viewed directly in SAP Jam, regardless of whether the records are part of a group. You can click on the business record name to return directly to SAP Cloud for Customer to view the entire business record there.

When displaying a list of accounts, opportunities, and service tickets, the total count for all items that can be listed in the external business record list widget displays so that SAP Jam users can immediately know the size of the list. If there are more items to display than the maximum configured for the widget, you can click on the View All link to see the rest of the list.

**Search capability**

When global search is enabled by the company administrator, all business record titles and their public wall comments are searchable in SAP Jam. When a user drills into a search result, they see the full historical feed conversations for that record. If a user is not granted access in Cloud for Customer to view the record details, they will not see such details in SAP Jam either (other than the title).

When disabled, business record titles and public feed comments and conversations are not searchable. If a user is not granted access to view the record in Cloud for Customer, they will see “Access Denied” in SAP Jam.

**i Note**

The checkbox does not impact the ability search or access business records and comments that are within the scope of a group.
Tasks

SAP Cloud for Customer tasks data displays in SAP Jam. Specifically, it can appear in the hover cards, business record browser, business record viewer, business record lists, related business record lists, and business record widgets for the group overview and home pages.

Tasks can be filtered by all, high priority, open, and completed statuses. They can be sorted by status, processor, due date and time, priority, account, owner, changed on, and summary data.

Related tasks can also display for accounts and opportunities.

Feed Updates

If you opt out of receiving updates on a specific business record based on a trigger action (e.g., updates to address), then any updates made by you or by other users will not display in the SAP Cloud for Customer home feed.

i Note

Comments that are manually posted on the business record or content items like documents, photos, etc. are excluded from this feed update restriction.

Other followers will continue to receive a feed update in their home feed as long as their feed settings indicate that they wish to receive that event update for that business record type. If anyone, including yourself, replies to the event (e.g., to ask a question, raise a concern), then you’ll receive an update in your home feed that contains the entire conversation thread on that event. These feed updates will continue to display on the feed activity section for the business record itself.

10.1.8 SAP S/4HANA Professional Services Cloud

SAP S/4HANA Professional Services Cloud delivers advanced end-to-end, project-based commercial services in the cloud as a professional service automation (PSA) solution. With SAP Jam integration, you can create groups via SAP S/4HANA using a specific group template, and view group feed updates in the right side panel.

Groups and group templates

To create a group in SAP S/4HANA

1. Click **Show Discussion Panel**.
2. Click the action icon on the bottom right, and then choose **Create Group in SAP Jam**.
Create SAP Jam group via SAP S/4HANA

3. The Create Group dialog displays. Set the following parameters:

1. In the Group Name text box, ensure your group name is unique. By default, the group name is the same as the project name in SAP S/4HANA, but can be replaced.

2. In the Description text box, describe the purpose of the group.

3. From the Group Permissions drop-down menu, choose from Private, Public, or External.

4. From the Group Template drop-down menu, make sure you choose “Professional Services Project Room Template”. By default, it includes five page tabs (i.e., What’s Up, Meetings and Decisions, Risks and Issues, Project Details, Our Team).
5. Select "Invite Project team" if you want to invite all team members who are currently staffed for this project to the group.
6. In the Invite Others text box, you can optionally add or remove users who you want to invite to the group.

Feed updates display

To display and work with feed updates in SAP S/4HANA

1. Click Show Discussion Panel, then use the selector at the top of the panel to select an attached SAP Jam group. The feed for that group displays.
When working with feeds:

○ Click + to post a new update to the group, or click Reply to reply to existing updates.

○ When you post or reply, click on the @ symbol to find someone in SAP Jam that you wish to mention.

○ Click More to navigate to a specific feed entry or a group in SAP Jam.

**Project data**

You can view, sort, filter, and search for SAP S/4HANA project data for these record types:

- **Project**: Sort by ID or Name, Search by ID or Name
- **Work Package**: Sort by ID or Name, Search by ID or Name
10.1.9 SAP SuccessFactors Learning integration

By integrating SAP Jam with a social learning management systems such as SuccessFactors Learning, a SAP Jam group can be created from a curriculum, learning item or scheduled offering. This allows course
administrators (as group administrators) to create social learning groups using a specific learning template (e.g., Education Center, Training Room templates), provide a community in SAP Jam for instructors to moderate collaboration and forums, and enable students to collaborate with instructors and peers.

### Note

As of the February 2017 release, if your company has deployed only the SAP SuccessFactors Learning integration, you will see a change to the names, widgets, and other page labels adapted to reflect the learning context, such as:

- The "Business Records" link in the global navigation bar is renamed to "Learning".
- For group administrators, the "Business Record" widget is renamed to "Learning".
- All instances of "business records" are replaced with learning-specific terminologies where applicable.

When you browse for curricula and items in the item browser, you can sort the results by various attributes.

#### Learning / Items (Courses)

<table>
<thead>
<tr>
<th>Title</th>
<th>Item ID</th>
<th>Sku</th>
</tr>
</thead>
<tbody>
<tr>
<td>Test Prep Final Exam: HRCP/PHR Certification Program</td>
<td>HR-900</td>
<td></td>
</tr>
<tr>
<td>Decontamination (HAZWOPER)</td>
<td>SS-EHS-416</td>
<td></td>
</tr>
<tr>
<td>Interpersonal Communication Skills for Teams</td>
<td>HR-122</td>
<td>SKU-462</td>
</tr>
</tbody>
</table>

### Note

For a curriculum, if the item browser displays a hover card or attribute showing a "Value not found error" then you must notify your SAP Jam company administrator so they can take steps to correct the issue via the Admin Center in the SuccessFactors HCM Suite.

#### Learning items

You can filter the learning item results by any of the following options: Instructor-Led, Online, Other Learning, or All.
Filter learning items

When you hover over the item's name, a hover card will appear with information such as the Item ID, Item Type, Revision Date, Description, Classification, Credit Hours, and Chargeback Method. You can also create a group or feature the record for the learning item in a specific group.

Hover card

When a group is created from a learning item using the Education Center or Training Room group templates, the learning item information displays on the group overview page with the same information that appears on the hover card when you hover over the name of the item in the item browser. On the group navigation menu, when you click the learning item's details, you can also the Scheduled Offering Details such as the location, start date and time per location timezone, end date and time per location timezone, status (e.g., availability for enrollment), and an enrollment status that shows whether you are enrolled in that course offering or not.
Scheduled offerings

Under the Scheduled Offerings tab for an Item, the ID and Description can display along with the start and end date times, location, available seats, and enrollment status for a scheduled offering.

When you view the hover card for a scheduled offering in the item viewer, the hover card can display the Title, Scheduled Offering ID, Description, Available Seats, Enrollment Status, Contact information, Email Address, and which groups that the offering has been featured in. You can also create a group (using the Training Room or Education Center templates) based on the scheduled offering, or featured the scheduled offering in a group.

You can use the global search to search for scheduled offerings and curriculum by title. In the item viewer, you can search by Title or ID. When viewing an item via the item viewer, you can click and navigate into each related scheduled offering.

Curriculum and curricula assignments

You can click Curriculum Details left side menu navigation to access a curriculum. When you click on the learning type "Curriculum" in the item browser, you will see a list of curricula that has been assigned to you.
When you hover over each assigned curriculum to view the hover card, you will be able to see the Curriculum ID, Description, Status (i.e., Complete or Incomplete), and which groups it has already been featured in. The curriculum status is a reflection of whether all assignments have been completed or not. If all assignments are completed, then the overall status will display "Complete". If any of the assignments are not completed, then the overall status will display "Incomplete".

You can also create a group (using the Training Room and Education Center templates) based on the curriculum, or feature the curriculum in a group. If you click on curriculum that has not been assigned to you, then no information will appear in the hover card when you hover over it.

When you click Related Learning from the navigation menu, the item viewer can display a list of curriculum assignments.

When viewing a curriculum using the item viewer, users can click and navigate into each curriculum assignment.

Quick link from SAP Jam to SuccessFactors Learning

Via SAP Jam, you can return to specific areas within the SuccessFactors LMS system without clicking several times to navigate. SAP Jam offers a "deep link" back to LMS to connect you to an exact page or action that reflects the next step in your process (e.g., enrolment in a course, viewing a curriculum). Deep links display on hover cards and on the page for the selected item.

Scheduled offering deep link from SAP Jam back to SuccessFactors Learning
Restricted access users

Restricted access users can do the following with SAP SuccessFactors Learning records:

- Access the Learning tab in the global navigation to browse, search, and filter for authorized learning records.
- If within a group, view an authorized learning item, and view and reply to other users’ comments on an item using the item viewer.
- If not part of a group, view an authorized learning record using the item viewer.
- @mention any authorized learning items within a group.
- Use the catalog search widget on the home page to search for authorized learning content in the SAP SuccessFactors Learning catalog.
- View learning content on the learning widget on group overview, company and area home pages.

**Note**

Restricted access users are not permitted to create groups, so this function will not be accessible from a learning record’s hover card.

10.1.10  SAP SuccessFactors Platform integration

If enabled by an administrator, SAP Jam away alerts can display as notifications in SuccessFactors. When you create an away alert on your profile in SAP Jam, a notification appears in SuccessFactors’ notifications panel, indicating that your profile has been updated with an away alert for the specified away dates.
10.1.11 SAP Document Center

SAP Document Center (formerly known SAP Mobile Documents) is SAP’s standard extension for unified file access to SAP applications such as S/4HANA, as well as third-party solutions. You can benefit from easy access to all business documents, including collaboration and sharing capabilities across all devices.

To access the SAP Document Center in SAP Jam, if configured, click SAP Document Center from the navigation menu. In the content repository that appears on the right-side, you can add, rename and delete folders and documents.
11  How Tos

11.1  How to steps for common features

Now that you have your account set up and are receiving invitations to groups, it’s time to start working with SAP Jam. This section of the guide provides steps on how to use the most commonly used features of Jam.

11.1.1  How to: Update your status

When you post a status update, you are sharing information with everyone in your company’s network, or with a specific group. Your status update can relate to something you are working on or thinking about. While posts can consist of a short, text entry, you can also record a video, upload a file, enter a question, or introduce a discussion or idea as your update.

To update your status
1. Click Feed Updates from your Home page if you want to enter a status update that will be shared with everyone in the company. Or, click Groups, select your group, and click Feed Updates to enter a status update that displays on your personal and group walls.
2. Enter some text for your status update, with any of the following if required:
   ○ Click the person icon to notify someone. One click will insert one "@" symbol; enter the name of the person after that symbol. Clicking the icon twice inserts two "@" symbols; enter the word "notify" if you want to alert everyone in a group.
   ○ Click the hashtag icon to insert a "#" symbol; enter a tag.
   ○ Click the camera icon to upload or drag and drop an image.
   ○ Click the video recorder icon to upload or record a video. You can also type the URL or copy and paste a hyperlink to a video.
   ○ Click the document icon to upload or drag and drop a document.
   ○ (Group feed only) Click the question icon to post a question to the group forum.
   ○ (Group feed only) Click the lightbulb icon to post an idea.
   ○ (Group feed only) Click the Conversation icon to post a discussion topic.
3. Click Submit. Your post will display on your feed update, the group feed update (if you chose to share it with the group), and your followers’ feeds.

11.1.2  How to: Manage my feed filters

Over time, the wall feeds on your Home and Group pages may accumulate and display a variety of updates to the point where you do not have time to scroll through them all. To manage this, you can choose a filtered view or create a custom wall feed. Filtered views restrict the feed to the most common search criteria (e.g., posts that mention you) while a custom feed is another filter that you get to define.
To select the feed that displays on your Home page

1. On the Feed Updates section, below the text box where you post your updates, a feed command bar displays with the following:
   - **All**: See all posts including your own, public group updates, posts within groups that you are a member of.
   - **Unread**: See all posts that you have not viewed yet. Unread posts display with a blue bar to the left of the author’s profile photo.
   - **@Your name**: See all posts that specifically mention your name.
   - **Replies**: See all posts where you have replied or received a reply.
   - **Show More**: A drop-down menu that allows you to manage and create custom feed filters by member or group, and then select a saved filter.

2. Choose your preferred feed by clicking on one of the above. You can switch back and forth as often as you need to.

   ![Show More menu with custom feed filters example](image)

   **i Note**

   You cannot modify the feed that appears on the custom company/area home pages or profile page. However, for each feed item, you have the option to delete it from your feed so that it is no longer visible to you.

To create and apply a custom feed

1. From the Feed Filters section above the feed activity, choose **Show More > Manage Filters**. The Manage Filters pop-up displays.
2. Click *Create a New Filter*.
3. In the Filter Name text box, provide a name for your feed filter.
4. On the Filter Type drop-down menu, select Member Filter to create a filter of one or more colleague updates, or Group Filter to choose from one or more groups.
5. Click to select from a list of members if you chose the Member filter. If the list is long, you can enter the name you are looking for in the Search bar at the top of the pop-up. If you chose the Group filter, enter the first few letters of the group to produce a list of matching results. Note that this applies only to groups that you are following.
6. Click *Submit*.
7. You are returned to the Manager Filters pop-up. Click *Save* to save your changes.
8. From the Feed Filters section, select the *Show More* drop-down menu and select the feed that you just created.

**To edit or delete a filter**

1. In the Manage Filters pop-up, click the pencil icon beside the name of the filter you wish to edit or
d2. To delete a filter, click x beside the pencil icon.
11.1.3 How to: Use popular tags

Tags are succinct, descriptive keywords that primarily enable other users to find information. When you tag content, the system ensures that the content contains a single hashtag symbol so that searches and filters produce complete results.

When tagging an item, enter the term without a hashtag symbol (#). For example, if you want to use the keyword “policy” to describe your content, you would type ‘policy’. SAP Jam automatically inserts the hashtag for you.

About tags

When you tag an item in SAP Jam, it becomes part of a group of similarly tagged items. You are helping other users who may be searching for similar content to find this item. In many cases, by tagging your item, you are creating a new, searchable keyword.

When you have popular tags visible on your page view, you can see a list with the more frequently used terms displayed in larger font size. This list can help you when you want to create a tag, but are not sure if there is a similar one already in use, or are looking for a term that provides a better description.

1. When searching for content based on tags, first look at the list of popular tags on your group page.
2. When you place your cursor over a tag, the number of times it has been used will display.
3. Click the tag term that you would like to search.
4. The Search Results list opens within the same browser window. You can use the following options to refine the search results:
   ○ Filter by: Choose from All Time, Last 30 days, Last 7 days, and Last 24 hours to narrow or broaden the timeline for tagged items.
   ○ Click the + icon beside Author to refine the list by author name.
○ Click the + icon beside Group to refine the list by group name. Click x to remove the group from the search results.
○ Click the + icon beside Tag to refine the tag you are searching on. Click x to remove the tag from the search results.
○ You can click on a specific category to restrict search results to a specific item type.

5. To save your search results for later use, you can click Save Search above the list of results.

11.1.4 How to: Invite people to a group

After a group has been activated, and you have the appropriate invite policy set for your account, you can send invitations to other users to join the group.

To send an invitation
1. Select your group from the Groups drop-down menu.
2. Click + Invite below the group avatar on the left side.
3. In the Add People to the Group Invitation List, enter the names of the people you would like to invite. Click + Add more to enter more names.
4. If you want to add several people, you can click + Import CSV on the top right corner to import a list of names in a comma-separated file.
5. In the Personal Message text box, you can optionally enter a personal message for the invitation.
6. Click Send to send the invitation. A message displays how many invitations were sent on your behalf.

11.1.5 How to: Find out who is your group administrator

For larger organizations where you may not know everyone by name, it can be helpful to learn who is in your group by observing a group membership list. The number of members always displays below your group’s avatar.

To view a list of other members and the administrator(s) for your group
1. On the group overview page, click the number of members link below the group avatar or from the group header. The group members list displays.
2. To find the group administrator, look for the “Group Admin” label indicated below the group member’s name. There may be more than one group administrator for your group.

An "Added By" column on the group members list indicates which group member accepted a request to join a group or invited a particular person to a group.

11.1.6 How to: Assign a task to a group

If you are a task owner or group administrator, you can assign a task to a group and all or some selected group members using a picklist.

To assign a task to a group
1. Select the group that will be assigned with a task.
2. Click the Tasks section.
3. Click + Add Task.
4. Enter the name of the task. As you type, the task will expand to display group, assignee, description, and other task attributes.
5. Click the Add Group text box and enter a group name, if required.
6. Click in the Add Assignee text box to display a picklist of assignees. You can click Select All at the bottom of the Add Assignee picklist window to select all members, or click to select only the specific members you want to assign the task to. The names of pending group members will also display in this list.
7. Click OK to close the Add Assignee picklist.
8. In the Add Description text box, enter details to describe what needs to be done for the task.
9. Click Due Date to select an end date for the task from the pop-up calendar.
10. Click Priority to set the priority as Low, Medium, or High.
11. Click Attachment if you want to upload a new file or attach an existing one to accompany the task.
12. Click the More Options drop-down menu if you want to include tags or followers to the task.
13. Click Add Task to assign the task.

The task now displays on the Group Tasks page. You can click on the name of the task to expand it and edit the details if necessary. You can also delete a task.

i Note
Any user can add comments, add or remove tags, and invite or remove followers for a task.

11.1.7 How to: Ask and answer a question

As a member of a group, you can ask and answer questions within a designated area on your group page, or on the Feed Update of your group wall. A question can also be answered via your Home page feed.

To ask a question using the post box for status updates
1. Select your group and then click Feed Updates.
2. On the post box below the group name, click the Question icon.
3. Where it says “What would you like to know?” enter your question. Use the area below the formatting toolbar to provide more details, instructions, examples, etc. if necessary.
4. Click Submit. Your question is now visible in the group feed and on your own wall.
To ask a question within a forum

1. Go to the navigation menu for your group pages and click **Forums**.
2. From the **Add** drop-down menu, click **Question**.
3. Where it says "What would you like to know?" enter your question. Use the area below the formatting toolbar to provide more details, instructions, examples, etc. if necessary.

4. Click **Publish** if you are ready to ask your question. Your question is now visible in the group feed and on your own wall.
5. If you are not ready to ask your question but want to save what you’ve written so far, click **Save Draft**. You can return to your saved draft via the Forums section when you are ready to continue.

To answer a question via a profile wall or group feed

1. Go to the group feed or your profile wall.
2. In the question box, click **Answer** to provide an answer to the question.
3. You can attach a file to support your answer by clicking **Attach a File**.
4. Click Answer to submit your answer. In the profile wall or group feed, your answer displays below the question.

5. If you need to change or remove your reply, you can click Edit or Delete respectively, below your response.

**To answer a question within a forum**

1. Select your group and then click Forums.
2. If you know what the question is, enter it in the search box to help you find it within the forum. Otherwise, you can click the General or Questions sections to search for the question.
3. When you find the question, click View.
4. In the text box, provide your answer and then click Answer to submit it. The answer now displays on the profile wall and group feed.

### 11.1.8 How to: Work with the Groups home page

The Groups home page lists all the private and public groups that you are a member of, and enables you to sort, filter, and search public groups.

To help you organize how the list of groups are displayed on the My Groups or Groups I Administer pages, you can click the:
- **Sort by** drop-down menu: Choose from Last Activity, Name, Following, and Email Frequency.
- Tile icon (beside the Filter by Name text box): to show the list of groups in a tiled display.
- Detailed list icon (beside the tile icon): to show the list of groups within rows and columns.

You can also enter the name of the group you are searching for in the Search Groups search box beside the icons.

From the left side panel, you can choose to view a list of groups based on:
- **My Groups**: The default tiled display of the list of groups you belong to.
- **Favorite Groups**: Up to ten groups that are pinned as your favorites.
- **Groups I Administer**: Groups that you belong to and serve as group administrator.
- **Group Notifications**: Invitations to join other groups.
- **Recent Group Activity**: A list of activities for all groups that you are following.
- **Browse Groups**: View a list of groups that you can join or have already joined.
- **Pending Groups**: You have sent a "request to join group" and are awaiting an invitation from the group administrator.

For each group that you belong to, you can access a drop-down menu. It contains options for:
- Frequency of when you receive email updates from the group.
- Leaving the group.
11.1.9 How to: Contact your colleague

There may be times when you need to collaborate with colleagues one-on-one before you share your work with an entire group, your colleague does not belong to the same groups as you do, or you would like to communicate with someone without broadcasting to others.

SAP Jam provides a few options for you to obtain your colleague’s contact information so that you can contact them privately:

- If your colleague’s update appears on your home or group feed, you can place your cursor over their name to view a pop-up containing their contact information (e.g., email address, phone number, and IM). If they are using Microsoft® Skype for Business® as their IM tool, you will be able to see if they are online.
● On that same pop-up, you can click Message to send them a private message with a subject line. This message will appear in their Messages folder where they can like, reply to, and delete your message. All replies are saved within that message thread until you delete the entire message by clicking the Trash icon.

● You can click Company, choose Directory, and then search for the colleague you want to contact. When you click their profile, you can click Send Message on their profile page to send a private message.

**Note**

When you share an update with a colleague by posting a message to their wall, that information can also be read by your colleague’s followers.
Important Disclaimers and Legal Information

Hyperlinks

Some links are classified by an icon and/or a mouseover text. These links provide additional information.

About the icons:

- Links with the icon : You are entering a Web site that is not hosted by SAP. By using such links, you agree (unless expressly stated otherwise in your agreements with SAP) to this:
  - The content of the linked-to site is not SAP documentation. You may not infer any product claims against SAP based on this information.
  - SAP does not agree or disagree with the content on the linked-to site, nor does SAP warrant the availability and correctness. SAP shall not be liable for any damages caused by the use of such content unless damages have been caused by SAP's gross negligence or willful misconduct.

- Links with the icon: You are leaving the documentation for that particular SAP product or service and are entering a SAP-hosted Web site. By using such links, you agree that (unless expressly stated otherwise in your agreements with SAP) you may not infer any product claims against SAP based on this information.

Beta and Other Experimental Features

Experimental features are not part of the officially delivered scope that SAP guarantees for future releases. This means that experimental features may be changed by SAP at any time for any reason without notice. Experimental features are not for productive use. You may not demonstrate, test, examine, evaluate or otherwise use the experimental features in a live operating environment or with data that has not been sufficiently backed up.

The purpose of experimental features is to get feedback early on, allowing customers and partners to influence the future product accordingly. By providing your feedback (e.g., in the SAP Community), you accept that intellectual property rights of the contributions or derivative works shall remain the exclusive property of SAP.

Example Code

Any software coding and/or code snippets are examples. They are not for productive use. The example code is only intended to better explain and visualize the syntax and phrasing rules. SAP does not warrant the correctness and completeness of the example code. SAP shall not be liable for errors or damages caused by the use of example code unless damages have been caused by SAP's gross negligence or willful misconduct.

Gender-Related Language

We try not to use gender-specific word forms and formulations. As appropriate for context and readability, SAP may use masculine word forms to refer to all genders.